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Content of this Instruction Manual

DPP stands for Digital Photo Professional.

In this manual, the screens used in the basic
operation instructions are from Windows 8.1/10.

» indicates the selection procedure of the menu.

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

p.** indicates a reference page.

Click to move to the relevant page.

indicates the function for advanced

users who are experienced in handling image

processing software.

"2 : Marks helpful information when a problem
arises.

-
~

/T

: Marks tips for using the software skillfully.

: Marks information that should be read
before use.

: Marks additional information you may find
helpful.

AN/

=ING)

Switching Between Pages

Click on arrows on the bottom right of the screen.
@ : next page
() : previous page
: return to a page you had previously
displayed

Click on the chapter headings on the right side
of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.
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Introduction

Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

* indicates processing that can be performed with JPEG or
TIFF images as well as RAW images.

View and organize images
Play back movies and save still photos

Adjust an image
Various image adjustments while maintaining the original image

Freely apply a Picture Style
View your image before and after adjustment in the same window

Trim and adjust the angle of an image

(trimming)

Resize an image
Correction of lens aberration
Digital Lens Optimizer

Automatic/manual dust erasure processing

JPEG/TIFF

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print an image
Link with EOS Utility for remote shooting

JPEG/TIFF

Color management compatibility
CMYK simulation for commercial printing

@ In DPP Ver. 4.8.20 or later, clicking [Check for updates] in the [Help]

menu allows you to check for update files on the server and
download any update files that are available.

To use this function, an environment with Internet access
(subscription to a provider and an in-place line connection) is
required. Internet Service Provider (ISP) connection fees or access
point connection fees may apply.
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Downloading
Images
S ——
System Requirements Viewing
Images
i S
OS (operating | \\inqows 10 (Version 1607 or later)*, Windows 8.1%
Sl Sorting
Model PC with one of the above OS preinstalled Images
(Upgraded machines not supported) \ N
Images shot with EOS-1D X Mark Ill, EOS R5, A
EOS Ré: Fditing
Intel Core i series (recommended Intel Core i7 or N
CPU later)
Images shot with other cameras: Printin
Core 2 Duo 2.0 GHz or faster (recommended Core i |m'a 9
. ges
series or later)
::\r%a.ges shot with EOS-1D X Mark Ill, EOS R5, EOS ) Procﬁssirl;g
RAM 4.0 GB or more of RAM (8.0 GB or more o?ngxw?rr:agég
(memory) recommended) —
ry Images shot with other cameras:
2.0 GB or more of RAM (4.0 GB or more SI}\emgte
recommended) ooting
——
Hard disk Installation: Min. 300 MB of available space :
drive Operation: Min. 600 MB of available space Playing Back
Movies and Saving
Resolution: XGA (1024 x 720) or more (1600 x 1200 Still Photos
Display or more recommended) —
Colors: 16-bit color (65536 colors) or more 3
Handling
 Only supported on 64-bit OSs. Cannot be installed or used on 32-bit RAW Movies
version PCs.
* With Microsoft NET Framework 4.7.1 or later installed HDRPQ
Mode
—_—
Specifying
@ For information on system requirements for HDR PQ mode Preferences
—_—

(including supported images), see “System Requirements for

HDR PQ Mode” (p.166).
For details on system requirements for the RAW movie tool, see @ @

“Working with RAW Movies” (p.154).
For images supported by depth compositing, see “Using Depth @
Compositing” » “Supported Images” (p.117).



Supported Cameras

EOS-1D X Mark Ill, EOS-1D X Mark 1l, EOS-1D X, EOS-1D C, EOS-1D
Mark 1V, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS-1D Mark II N,
EOS-1Ds Mark Il, EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS 5DS/
EOS 5DS R, EOS 5D Mark IV, EOS 5D Mark Ill, EOS 5D Mark II,
EOS 5D, EOS 6D Mark I, EOS 6D, EOS 7D Mark Il, EOS 7D, EOS 90D,
EOS 80D, EOS 70D, EOS 60D/EOS 60Da, EOS 50D, EOS 40D,
EOS 30D, EOS 20D/EOS 20Da, EOS 10D, EOS D2000, EOS D30,
EOS D60, EOS 77D, EOS 760D, EOS 850D, EOS 800D, EOS 750D,
EOS 700D, EOS 250D, EOS 200D, EOS 100D, EOS 2000D,
EOS 1300D, EOS 1200D, EOS 650D, EOS 600D, EOS 550D,
EOS 500D, EOS 450D, EOS 1000D, EOS 1100D, EOS 400D,
EOS 350D, EOS 4000D, EOS 300D, EOS R5, EOS R6, EOS R,
EOS Ra, EOS RP, EOS M6 Mark Il, EOS M6, EOS M5, EOS M3,
EOS M2, EOS M, EOS M10, EOS M200, EOS M100, EOS M50 Mark I,
EOS M50, PowerShot G3 X ', PowerShot G1 X Mark II"", PowerShot
G7 X!, PowerShot G9 X!, PowerShot SX60 HS ', PowerShot G5 X ',
PowerShot G7 X Mark II'!, PowerShot G16 ', PowerShot $120™",
PowerShot G1 X*1, PowerShot G15*1, PowerShot S110*1, PowerShot
$100"", PowerShot G9 X Mark II'!, PowerShot G1 X Mark 111",
PowerShot G9''", PowerShot G102, PowerShot G11™""2, PowerShot
G122, PowerShot S90 "2, PowerShot S95 "2, PowerShot SX1
1IS"""2, PowerShot SX50 HS "2, PowerShot SX70 HS™ "2, PowerShot
G5 X Mark II'", and PowerShot G7 X Mark Il
*1 For RAW images, functions that are not in the camera (such as the
Auto Lighting Optimizer) and functions such as the Digital Lens
Optimizer cannot be used. However, Picture Styles, even if not in the
camera, can be used with the exception of some functionality.
*2 The following functions are unavailable.
- Basic Adjustment tool palette:
White balance [Fine-tune]
A portion of [Gamma adjustment]
Automatic gradation and luminance adjustment
Midpoint adjustment
Input white points range expansion
- Dust Delete/Copy Stamp tool palette
- Compositing tool
- HDR tool
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mages
Image data S
Image type Extension ISorting
CR3 mages
—_
RAW | Images in the Canon RAW format '%Ez —f
. * . 1ting
images | shot on supported cameras ‘CRW Images
.CIP
Still : : )
JPEG | Exif 2.2, 2.21 or 2.3-compatible JPEG
photos | mages | images P JPG/.JPEG Printing
Images
TIFF | Exif-compatible TIFF images TIFLTIFF -
images .
Processing
HEIF | Images shot on supported cameras, HIF/.HEIC Large Numbers
images | or HEIF images developed in DPP : ' of RAW Images
.MOV
Movies Movies shot with supported cameras | .MP4 Remote
.CRM Shooting
* Compatible with RAW images shot with EOS D2000 that have been ——
converted to RAW images using the CR2 Converter and have the Playing Back
“ CR2” extension. Movies and Saving
Still Photos
S ——
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1 Downloading Images

Starting Up DPP ...,
Downloading Images to Your Computer

Downloading Images Using the Software “EOS Utility".......
Downloading Images Using Your Card Reader..........
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Starting up DPP

Double-click the desktop icon.

A

This PC

%

Network

[alic]
Dig Photo
Professional 4

Double-click

DPP starts up and the main window (thumbnail layout) appears.

v

Main window (thumbnail layout)

@ If you drop a DPP-supported image file onto the icon on the
desktop, you can start up DPP and display the folder where the
image file is saved.
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Downloading Images to Your Computer Doyvquging

D load the i d on the memory card inserted in the . .
oo e Mages saved.en y e | Downloading Images Using Your Card Reader

Viewing
You can also download images to the computer using a third-party card Images
reader. ——

Downloading Images Using the Software “EOS Utility”

Sorting

You can download images with “EOS Utility”, communication software Load the memory card into the card reader. Images

for the camera. Start up DPP beforehand.

For detailed instructions on downloading images, refer to the “EOS
Utility Instruction Manual” (PDF electronic manual). Open [My Computer] » [EOS_DIGITAL] and drag the

[DCIM] folder to the [Desktop].

Editing
Images

 EEEEEE——

Printing
Images
S ——

Processing
Large Numbers
of RAW Images

Remote
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Playing Back
TR Movies and Saving
The [DCIM] folder is copied to your computer. Still Photos

All images are saved in folder units inside the [DCIM] folder.

ing i i i Handling
.Copylng images to ygur computer will take some time when there RAW Movies
is a large number of images saved on the memory card.
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D Viewing Images

|

Viewing Images in the Main Window (Thumbnail Layout) .. 13

Changing the Thumbnail Display.........cccccceevieeiinannnes 14
Using the Thumbnails Control Panel ........ 15
Using the Thumbnail Display Filter/Sort
Function.............cc 16
Displaying the Histogram Palette.............. 17

Enlarging and Viewing an Image in the Preview Window............. 18

Enlarging and Viewing a Specific Area...........ccc......... 19

Displaying the Navigator Palette............... 19
Checking the Image in Detail ...................... 20

Displaying the Main Window (Multi-layout)................. 20

Checking an Image Using the Preview Control Panel......... 21
Changing the Magnification ..............cccccccvvvveeeeenn.... 21
Comparing with a Pinned (Fixed) Image ................ 21
Displaying Multiple Images at the Same Time ....... 22
Displaying Grid Lines............ccccciiiiiiiiiiieeeeeeeeee 22
Displaying AF Points ..........cccoociiiiiiiiiiiee e, 22

Displaying Areas Beyond the Set Range with
Warning Indicators (Highlight/Shadow Warning).... 23
Comparing Pre- and Post-Editing Images (Single-
Image Display).....cceeeeeeeeeiiieeee e 23
Comparing Pre- and Post-Editing Images (before/
after comparison) Arrange vertically/horizontally
(two-screen display) / Split vertically/horizontally

(split-image display).......cccceeeeiiiiiiiiiiieieeeeee e 24
Displaying Image Properties...........ccccceeeeeeeeeienennnn. 24
Checking an Image in Multi-Function Preview ........... 25
Checking an Image in Second Windows.................... 26

Opening and Closing Window Panels (Panes)........ 27
Changing the Display Method and Order of Palettes ....... 28
Changing the Display Method (Dock/Float) of Palettes....... 28
Rearranging Palettes............ccccoiiiiiiiie 28

2181 5] 22 =Y 29

Downloading
Images

Sorting
Images

Editing
Images

000

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences

\

Q0
©



Viewing Images in the Main Window (Thumbnail Layout)

Images downloaded to your computer are displayed as a thumbnails list
in the main window (thumbnail layout). You can double-click an image to
open the preview window (p.18) and display the image at large size.

Main window Toolbar

Check marks (p.33, p.34) Forward/Reverse
Ratings (p.33, p.34) Rotate image

For information on icons displayed on the frame of a thumbnail,
see “Image Frame Information in the Main Window and Edit
Image Window” (p.184).

For information on movie files, see “Playing Back Movies and
Saving Still Photos” (p.150).

When aspect ratio information is attached to an image shot with
any supported camera other than the EOS 5D Mark Il, the image
is displayed as a cropped image (p.71).

In the main window, in addition to this view (thumbnail layout),
you can select multi-layout. Multi-layout allows you to check the
image in detail (p.20).
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Changing the Thumbnail Display

You can change the size of the thumbnail images displayed in the main
window and select the information displayed for thumbnails.

Select the [Thumbnails] menu P desired item.

Open preview screen Ctrl+0

¥ | Thumbnail control panel  Ctrl+ Alt+ N

Pin Alt+0

Apply display filter
Sort 3
Group RAW and JPG versions

v Display split files as one thumbnail

Hide file name
+ | Default
With shooting info

List view

A
Size 1 (84=84) Ctrl+1
Size 2 (126:126) Ctrl+2
+ | Size 3 (168:x168) Ctrl+3
Size 4 (2522 252) Ctrl+4
Size 5 (384x384) Ctrl+5
Size 6 (512x512) Ctrl+6
AF points Ctrl+)

The display changes to the selected item.

Downloading
Images

Editing
Images

Printing
Images
e

Processing
Large Numbers
of RAW Images

S

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

|

Handling
RAW Movies

~

HDR PQ
Mode

Specifying
Preferences

N —

Q0
©



Using the Thumbnails Control Panel

The thumbnails control panel integrates various settings for viewing thumbnails.
By using this panel, you can view and specify the settings for thumbnails efficiently.

Thumbnails control panel functions

(1)
(2)
)
(4)
®)
(6)
(7)

(1) (2) (3) (4) (5)(6) (7) (8) (9) (10)

Olte Ol Change the size of thumbnails

u Display thumbnails without file names

E Display standard thumbnails

E Display thumbnails with information

IEJ Display thumbnails in list

H Specify properties display settings (p.179)

Display a RAW image and JPEG image as a single image
Display a RAW image and JPEG image that were shot together

as a single image. When this setting is specified, viewing and
editing of images are as follows.

* Image displayed: Only the RAW image is displayed in all
windows.

» Edited image: The content which has been edited with any of
DPP’s functions (the tool palette etc.) will be applied to the
RAW image only. However, if you have used the following

(8) Display or play back split movie files as single movies

When you play back split movie files in DPP, this setting plays
back all the movie files in a continuous sequence from the
beginning.

» This is set to ON by default.

* Only the thumbnail for the first movie file is displayed.

» This setting will be kept and applied the next time DPP is
started up.

* When the following functions are used, they apply to all the
remaining split movie files, not just the first movie file:
[Copy], [Cut], [Delete], [Add to collection], [Rename Tool]

* When the Filter/Sort function (p.16) is used with thumbnails,
the function is only applied to the first movie file.

©) [ select all thumbnails

Cancel all thumbnail selections

functions, the adjustments will be applied to both the RAW
image and the JPEG image.

Deleting an image (p.39)

Moving or copying an image (p.39)

Checkmarking (p.33 to p.34)

Rating (p.33 to p.34)

Rotating an image (p.13)

The thumbnails control panel is displayed in the main window by
default. If it is not displayed, such as when screen settings have
been changed, you can display it by selecting [Thumbnail control
panel] in the [Thumbnails] menu.

In multi-layout (vertical thumbnails, p.20), only the thumbnail view
setting (Default thumbnail display) is possible.
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Using the Thumbnail Display Filter/Sort

Function

This function allows you to display only thumbnails that match the
selected filtering option or to specify an option for sorting thumbnails.

Set the [Filter] button on the [Filter/Sort pane] in the
main window to [ON].

Filter y Sort by File name

Specify settings.
(1) (5) (3) (4)

Filter ON 3 Sart by File name
Shooting Date/Time ¥  Camera Model Mame ¥  lens
Al 3 Al
EF 100mm f.

Filter menu (2)

Drag to adjust display area of filter

Filter menu list menu lists upward or downward

You can drag the bottom edge of the [Filter/Sort pane] to adjust
the display area of the filter menu lists upward or downward.

(1) Thumbnail display filter ON/OFF
By setting to [ON], only thumbnails matching the filtering option set
with (2) the filtering options menu are displayed.

(2) Filtering options menu

Select a filtering option for the thumbnail display filter.

+ After selecting a filtering item in the list box that appears by clicking
[¥] at the right on the filter menu, options appear in the filter menu
list. Select an option.

* You can select multiple options in the filter menu list.

(Hold down the <Shift> key and left-click with the mouse for
consecutive selection. Hold down the <Ctrl> key and left-click with
the mouse to select individually.)

* The filter menus/filter menu lists are prioritized from left to right.
You can specify filtering options from left to right to narrow down
filtering.

(3) Sorting options
Select an option for sorting thumbnails. If files were added, a “*” is
temporarily displayed after the option name. [Custom] is displayed if
you sorted thumbnails in a chosen way.

ek

(4) Sort order selection
Select the order (ascending/descending) for sorting thumbnails.

(5) Filter lock button
When the filter lock button is clicked, filter settings will be kept and
applied when you switch to a different folder or the next time DPP is
started up. When the filter lock button is not clicked, filter settings
automatically change to [OFF] when you switch to a different folder
or the next time DPP is started up.

@ In addition to thumbnail display, this function can also be used in
multi-layout.
You can open/close the panel by clicking the [¥] button at the
upper right of the [Filter/Sort pane].
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Displaying the Histogram Palette

The histogram palette shows a histogram of the selected image. You
can quickly check a histogram without opening a tool palette.

Select the [View] menu » [Histogram palette].
The histogram palette appears.

Histograrm

You can select any of the following four histograms from the
menu that appears when you right-click with the mouse.
[Brightness only], [RGB separately], [YRGB separately], [RGB
together]

You can click the [] button at the bottom right of the main
window to show/hide the [Histogram] palette.
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Enlarging and Viewing an Image in the Preview Window

® 4 - [Folder: C

Double-click

The preview window appears.
Up to 36 windows can be displayed at the same time for the
preview window.

Preview window '

Tool palette

Click the [EJ] in the upper right of the preview window to close
the preview window.

@ By selecting the [Preview] menu P [AF points] in the preview
window, you can display the AF points selected in the camera at
the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.95), images for which you selected an
effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction or
chromatic aberration correction.
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Enlarging and Viewing a Specific Area
Click the area you want to enlarge.

The area you clicked is enlarged to 100% (actual pixel size).
Click again to revert to the full view.
To change the display area drag on the image.

5\@/5 To display an image in an enlargement ratio other than 100%

Select any enlargement ratio from the [Preview] menu.

@ While in the preview window, you can select the [Preview] menu »
[Preview control panel] to use various preview functions. For details,
see “Checking an Image Using the Preview Control Panel” (p.21).

Displaying the Navigator Palette

The navigator palette shows the enlargement area of a selected image.

Select the [View] menu » [Navigator palette].
The navigator palette appears.

Mavigator

1 T

When an image is enlarged in the preview or other window, the
enlargement display area is indicated in the navigator palette.
The area to be enlarged can be changed by dragging the
enlargement display area on the image.

Mavigator

r

Change the enlargement
display area by dragging

5 a
N
L T

o il |

You can click the [[E]] button at the bottom right of the main
window to show/hide the [Navigator] palette.
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Checking the Image in Detail Downioading

Displaying the Main Window (Multi-layout)

By switching the main window to “multi-layout”, you can use the preview control panel to check the image in detail.

Click a change layout button at the bottom of the main window (thumbnail layout).
The main window (multi-layout) appears.
In the main window (multi-layout), you can select from two layouts, with horizontal thumbnails or vertical thumbnails.
Click the area you want to enlarge in the image displayed in the preview display area to display the image at actual pixel size (100%). Click the
image again to revert to full display.
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Checking an Image Using the Preview Control Panel

With Preview control panel, you can check the image in detail.

You can use this panel in the main window (multi-layout) and edit image
window. If the preview control panel is not displayed, you can display it
by selecting [Preview control panel] from the [Preview] menu. By
default, the [[E]]] button and [] button are selected. When you select a
movie, the displayed content changes. For information on the display
when movies are selected, see “Playing Back Movies and Saving Still
Photos” (p.150).

Changing the Magnification

200% - |E) |-E-) Y - - |E| m - n:u:n:u - OJ - -

Display the image at actual pixel size (100%).

Click the [[§ ] button to display the image at the set
magnification displayed. If the [[ElIE]] button is used to
enlarge/reduce the image, the magnification set for this
button also changes accordingly*.

*Excluding actual pixel size (100%)

Enlarge/reduce the image.

Revert the zoomed image back to fit-to-window view.

Comparing with a Pinned (Fixed) Image

You can split the window into two sections, and compare the images on
the left and right by “pinning” an image in the left section then scrolling
images in the right section. It improves efficiency of image selection.

K1 200% ~ |::_ -B] v 1 " |E| m - n:u:n:n - OJ - ﬂ -

Select an image and click the [[iE]] button.

1R

o il | B |

Pinned (fixed) image

The window divides into left and right, and the selected image is
pinned.

When you pin an image and perform scrolling, the image on the
left (pinned image) remains and only the image on the right is
scrolled, which is convenient for image selection.

To pin another image, select the image, then select [Pin] from the
menu that appears when you right-click with the mouse.

After pinning an image, you can click the [] button to switch
between top-bottom and left-right split screens.
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Displaying Multiple Images at the Same Time

x1 200% ~ |%) |-B Y Y Y |E| B v dm v OJ A v

Select multiple images, and click the [[&]] button.

The selected image is displayed.
You can display up to 8 images.

Displaying Grid Lines

x| 200% - |E) |-E-') Y Y Y |E| B - n:u:n:u - OJ - -

Click the [[§] button beside the [[]] button, and set
the spacing between grid lines on the menu that
appears.

To set the spacing, enter values (8 to 256, in pixels), or move the
slider.

After specifying settings, click the [Close] button and close the
window.

Select an image and click the [[]] button.
The image with grid lines is displayed.

Displaying AF Points

%1 200% ~ |%) |-E] v ‘F ‘F |E| BH v gm v OJ - ﬂ A

Click the [[]] button beside the [[E]] button, and
select the item to display on the image on the menu
that appears.

Select [Show only AF points in focus] or [Show all AF points].

Select an image and click the [[E]] button.
An image with the AF points selected in step 1 is displayed.

@ AF points are not displayed for images whose image size has been

changed and then been converted and saved (p.95), images for
which you selected an effect other than [Shot settings] as correction
of fisheye lens distortion aberration, or images which have had
settings specified during RAW processing on the camera for
distortion correction or chromatic aberration correction.
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Displaying Areas Beyond the Set Range with
Warning Indicators (Highlight/Shadow
Warning)

You can set up warning indicators for both highlighted and shadowed
parts, which is effective for checking the clipped highlights and shadows
and preventing excessive adjustment of an image. Where the area on
the image has exceeded the set range, you can display the highlighted
part in red and the shadowed part in blue.

1 200% > © @ [F-[E-ME-0 =- &~ %G- H-

Click the [[]] button beside the [EF]] button, and
specify settings on the menu that appears.

Highlight/shadow warning display settin... n

Show shadow warnings

Threshold{0-64) 32
Warning color -
Show highlight warnines
Threshold{152-255) 254
Warning color -

Cloge

Checkmark the [Show highlight warnings] and [Show shadow
warnings] checkboxes and enter the warning values.

You can also select different warning colors from the dialog that
appears when you click the [[ .. ]] button.

After specifying settings, click the [Close] button and close the
window.

Select an image and click the [[EF]] button.

On the opened image, if there is an area that exceeds the value
entered in step 1, the highlighted part of that area is displayed in
red and the shadowed part is displayed in blue. If you selected
different warning colors, the parts are displayed in the specified
colors.

Comparing Pre- and Post-Editing Images
(Single-Image Display)

x| 200% ~ |§) |-!—-:1 "vv |E| HH v gm v Oj - ﬂ v

Select an image that is being edited and click the
[[iE] button.

By clicking the button, the display switches between the image
before editing and the current image (being edited).
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Comparing Pre- and Post-Editing Images
(before/after comparison) Arrange vertically/
horizontally (two-screen display) / Split
vertically/horizontally (split-image display)

You can display before and after versions of an adjusted image in the
same window and check the adjustment results.

This function allows you to adjust an image while comparing the original
image and image being edited.

x| 200% v |%) |-B ""Y |E| B - n:u:n:u - OJ v -

Select an image that is being edited and click the
[[E&] button.

The image is displayed in two-screen display (Arrange vertically).

The image before editing is on the left, and the currently edited is
on the right.

Change the image display.

The display switches in the following order by clicking the [[ii]]
button.

Arrange vertically (two-screen: left/right) > Arrange horizontally
(two-screen: top/bottom) = Split vertically (split-image: left/right)
- Split horizontally (split-image: top/bottom)

x1 200% * @

Displaying Image Properties
Display the shooting and recipe information for an image in the screen.
You can select items to be displayed.

|-B] v - - |E| m - n:u:n:n - OJ - ﬂ -

Click the [[]] button beside the [[[i]] button.

The [Properties display settings] window appears.

Specify display settings.

Preferences

Gereral settings

Image Processing 1 2
View ssttings

Image Proceszing 2

Use Recommended Settines

Show Av/T/T50 on thumbnails
Show icon
Shaw HOR icen on thumbriails
Show HOR ican on previews

on thumbrail to indicate edited recipes

Previem properties font

[ro0ux 16 pt

Froperties to display

Display settings for thumbnails with info v Restare Defaults

< >

*Changes take effect after restarting
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Downloading

Select [Display settings for preview properties] from the . . . . .
[Properties to display] pulldown menu. Checking an Image in Multi-Function Preview
Specify display items with the [Add >>] button and [<< Remove]

The preview window shows the coordinates of the mouse cursor and the
button. Items that can be selected appear in the list box at left, P

work color space. By switching to multi-function preview, you can also

and actually displayed items appear in the list box at right. You check image details in the same way as the main window (multi-layout
can also change the display order with the [Move Up] button and g y ( yout).
[Move Down] button. . .
After specifying settings, click the [OK] button. Sele_Ct the [Tools] menu } [Prev_'ew Scre_en display
With the [Preview properties font] option, you can specify the font settings], and then [Multi-function preview] from the Editing
used for information displayed in the preview window. dialog that appears. Images
Select an image and click the [El] button. Open the preview window (p.18). Printing
The image and properties selected in step 2 are displayed in the A multi-function preview with various functions at the bottom of Images
screen. the screen is displayed. T —t
If the recipe contents of an image being edited are displayed in o —— I Processing
i X . t % Digital Photo Professional 4 - IMG_0001.CR2] Large Numbers
before/after comparison (two-screen display/split-image display), Ble Edt Viw Thumballs Preview Lsbel Adjstment Tools Window Help of RAW Images
edited items are displayed in red.
Remote
Shooting
Playing Back
Movies and Saving
Still Photos
——
Handling
RAW Movies
HDRPQ
Mode
x1 200 @ @ [F~[-[ME- /M =@~ @&~
Specifying
For how to use the displayed functions, see “Viewing an Image in Preferences

the Main Window (Thumbnail Layout)” (p.13) and “Checking an —

Image Using the Preview Control Panel” (p.21 to p.25). @ @

@ All the property items may not be displayed depending on the @
combination of window, preview window, or the size of thumbnails.



Checking an Image in Second Windows

Second windows are preview windows that you can open additionally
for thumbnails and image previews. You can display up to 4 second
windows for an single image to check the focus in all parts of the image,
etc.

Select an image, and then select [Show second
screen] from the menu that appears when you right-
click with the mouse.

Digital Photo Professional 4 - (IMG_0001.CR2) B3

T T

& Digital Photo Professional 4 - [IMG_0001.CR2)

A second window is displayed.

To display an additional second window, repeat the operation.
You can change the size of second windows as desired.
Click the displayed image to switch between actual pixel size
(100% view) and fit-to-window view.

When you magnify an image in the second window, the right-
clicked position on the image will be the center for the
magnification.
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Opening and Closing Window Panels (Panes)

Panels (panes) at the top, bottom, left, and right of each window can be
closed to suit the tasks being performed.
You can use DPP in an optimal layout.

Click the [|J"l]] for a panel to open or close.

Example: main window (thumbnail layout)

When a panel is closed, you can point to [[JJlJ] with the mouse
to temporarily open the panel.
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Changing the Display Method and Order of Palettes

For any palette (tool palette, navigator palette, histogram palette, quick
check palette, and camera control palette), you can change how the
palette is displayed (docked/floating), or the display order of multiple
docked palettes.

Changing the Display Method (Dock/Float) of Palettes

Right-click on the palette’s title bar (where its name
is shown) and click [Dock/float] in the dialog that
appears.
A docked palette is then displayed floating, and a floating palette
is then displayed docked.

To revert to the original display method, repeat the same
operation again.

Rearranging Palettes

When multiple palettes are docked, you can rearrange their order from
top to bottom.

Right-click on the palette’s title bar (where its name
is shown) and click [Move one up] or [Move one
down] in the dialog that appears.

The order of the palettes is changed.
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Exiting DPP

In the main window, select the [File] menu P [Exit].

Close window Ctrl+W
Save Ctrl+5
Save As.. Ctrl+5hift+5
Convert and save.. Ctrl+D
Batch process... Ctrl+B
Save still image from movie... Ctrl+5hift+D

Save still image from RAW movie..  Ctrl+Shift+)

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Print contact sheets Alt+Shift+P
Plug-in printing »
Add to collection Ctrl+G
Remove from collection Ctrl+Shift+G

Clear cellection

Select collection »
Delete collection 3
Bookmark

Remove bookmark

Mave to Recycle Bin Del
[ Exit Alt+F4 J
DPP exits.

@ Digital Photo Professional Survey Program
Canon requests that information related to your Canon product be
sent to Canon (in case of using your Canon product in China, to the
legally approved research company) through the Internet. Canon
uses such information for development and marketing of products
that better meet customer needs.
Even after agreeing, you can change the send settings anytime in
the [Survey] tab sheet (p.180) in [Preferences].

@ A confirmation dialog box for saving the images appears when you
try to exit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images
adjusted.
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3 Organizing and Sorting Images
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can sort images into groups.
Note that this function does not apply to movie files.

Select multiple images to check in the main window.

Display the quick check window.
Click the [Quick check] button.

File Edit View Thumbpails Preview Label Adjustment Tools Window Help

Edit Irmage Remote Shooting

Filter ON OFF o'

Boaok mark.

=-[ i Deskiop
The quick check window appears.

Click the [[E] or [[H] button to switch between
images to be checked.
Quick check window

 Digital Photo Professinal 4 - [Folder: C:AUsers\xoo\ Desktopioaa 03]

All the images displayed in the main window can be checked in
the quick check window.

If you click the [[Bll] button, the first image is displayed, and if you
click the [[g]] button, the last image is displayed.

Click the [[B]] button to return to the main window.
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Click the area you want to enlarge.

- - o T e - - L -

The area you clicked is displayed at 100% (actual pixel size).
To change the display position, drag on the image.

If you click the [ |E2] button, you can display the image at 50%.
Click again to revert to the full view.

To exit, click the [[E}] button.

In addition to 100% and 50%, you can display images at 12.5%,
25%, 200%, 300%, and 400%. Click the [ﬂ] button beside the

] button on the screen, and select a magnification from the
menu that appears.

If you click the [ |EZl] button (the selected magnification appears
on the button), the image appears at the selected magnification.
However, after the quick check window is closed, the image
returns to its original 50% view.

When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF
points are not displayed for images which have had their image
size changed and then been converted and saved (p.95), which
have had settings specified during RAW processing on the
camera for distortion correction and chromatic aberration
correction, which are composited, or which are created as HDR
(High Dynamic Range) images.

Ay

> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switching between images using the keyboard

You can also switch between images by pressing the <—> or <«>
key.

Switching between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Operations using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on an image.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ ] marks) for each subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [[El] to [E]-

Thurmbnail position

o Bottom

P L=it
v"1 v"2 \/3 v"4 \.—"5 . Click

The selected check mark appears in the upper left of the window.

Check mark

Click the [Clear] button to remove the check mark.

@ The values of check marks attached to images in versions before
DPP 4 are not maintained.
You can also attach check marks from the menu that appears by
right-clicking with the mouse on an image in the main window.

Setting Ratings
Display the image you want to rate, and then click
any one of the [¢].

O Bottom ® L=it
\/1 \/2 \f3 \/4 \/5

Click

+ < 2/16

. AF points

Info

The rating is set and an icon corresponding to the selected [$%]
appears in the upper left of the window.

(Window shown with a rating of three [%])

To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Rating icon

To cancel the rating, click the same [¢%] as when the setting was
made on the right of the window.

® As the file structure of the image data is changed when a rating is
set to an image, it may not be possible to check the image
information in third-party software.
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Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks

or setting ratings (indicated with [s%] marks) for each subject or theme.

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark
to, and then click any of [El] to [E]-

L ‘l.f!hi' : Select
i il | B N e
e Click
The selected check mark appears in the upper left of the image
frame.
Check mark

Click the check mark again to remove the check marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [¢].

. ciill | B | s

Select

Click (changes to [5%¢] after clicking [ @])

The rating is set and an icon corresponding to the selected [§%z]
appears in the image frame.

(Sample window shown with a rating of three [$%] as an example)

Rating icon

To cancel the rating, click the same [$%] as when the setting was
made.
Set [Reject] with the [Label] menu or the quick check window

(p.31).
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:@/3 To select multiple images in the main window

Click on desired images while holding down the <Ctrl> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <Shift> key.

@ The [Label] menu can also be used to attach check marks and set
ratings.

You can display and change the rating settings set in DPP with

other EOS software and with any supported EOS camera (for the

EOS 7D, version 2.0.0 or later firmware) except the EOS-1D

Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS-1D Mark II N,

EOS-1Ds Mark Il, EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS 5D

Mark Il, EOS 5D, EOS 50D, EOS 40D, EOS 30D, EOS 20D/

EOS 20Da, EOS 10D, EOS D2000, EOS D30, EOS D60,

EOS 550D, EOS 500D, EOS 450D, EOS 1000D, EOS 400D,

EOS 350D, and EOS 300D.

» EOS Utility version 2.9 or later:

Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.

» With any supported camera (for the EOS 7D, version 2.0.0 or
later firmware) except the EOS-1D Mark |V, EOS-1Ds Mark 111,
EOS-1D Mark Ill, EOS-1D Mark II N, EOS-1Ds Mark Il, EOS-1D
Mark I, EOS-1D, EOS-1Ds, EOS 5D Mark I, EOS 5D, EOS 50D,
EOS 40D, EOS 30D, EOS 20D/EOS 20Da, EOS 10D,

EOS D2000, EOS D30, EOS D60, EOS 550D, EOS 500D,

EOS 450D, EOS 1000D, EOS 400D, EOS 350D, and EOS 300D:

Ratings set in DPP are displayed in the playback screen. You can
also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change in DPP the rating
settings set for images on any supported EOS camera (for the
EOS 7D, version 2.0.0 or later firmware) except the EOS-1D
Mark 1V, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS-1D Mark II N,
EOS-1Ds Mark Il, EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS 5D
Mark I, EOS 5D, EOS 50D, EOS 40D, EOS 30D, EOS 20D/
EOS 20Da, EOS 10D, EOS D2000, EOS D30, EOS D60,

EOS 550D, EOS 500D, EOS 450D, EOS 1000D, EOS 400D,
EOS 350D, and EOS 300D.
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Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [Thumbnails] menu P [Sort] » desired item.

The images are arranged in the order according to the selected
item.

Main sort items
File name: ascending order

Description

Images are sorted by file name in
alphanumeric order (0 to 9 = A to Z).

Extension: ascending order Images are sorted in the following order:
RAW images - JPEG images = TIFF

images > MOV movies > MP4 movies.

Shooting Date/Time: Images are sorted by shooting date and
ascending order time from the earliest.

Check mark: ascending order Images with check marks take priority
and are sorted in number order.

Rating: ascending order

Camera Model Name:
ascending order

Sorted in order of fewest [{%].

Sorted in order of least digit used in the
camera model name. (Ex.: EOS-1D X -
EOS 6D)

Lens: ascending order Sorted in order of shooting lens with

shortest focal length.
ISO speed: ascending order Sorted in order of lowest speed.

Shutter speed: ascending order Sorted in order of fastest shutter speed.

Aperture value: ascending order Sorted in order of lowest aperture value.

Focal length: ascending order Sorted in order of shooting lens with
shortest set focal length.

* You can also arrange images by [Image Size], [RAW Type], and
[Recipe editing status].
* Descending order sorts all items in the reverse of ascending order.

Arranging Freely

Drag and drop the image to the desired location.

The image moves to the desired location.

You can also select multiple images (p.35) and move them.

The order of rearranged images is temporarily registered as
[Custom] in the [Filter/Sort pane] and maintained until you exit
DPP or select another folder in the folder area.

Select the [Thumbnails] menu P [Sort] » [File name] and [Ascending]
to revert to the order before the images were rearranged.

|

:@: Maintaining the order of rearranged images
You can maintain the order of rearranged images even if you exit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View Settings] tab sheet in [Preferences] to maintain
the order of images without changing the image file names (p.178).
Maintain order and change image file names
You can use the rename function to maintain the order of images and

change the image file names all at once in the order they were
rearranged (p.142).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Thumbnails] menu » [Group RAW and
JPG versions].
The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [(R+J)] mark (p.184).

? RAW images with the extension “.CR2” or “.CR3” can be
displayed as a single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2”, “©.CR3”, and
JPEG images simultaneously. Images that have been simultaneously
shot with a camera that shoots RAW images with the extension “.CRW”
or “.TIF” cannot be displayed as a single image.

-Z\@/E When a single image is displayed
Image displayed
The RAW image is displayed in all windows.
Edited image
The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.
However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.
* Deleting an image (p.39)
* Moving or copying an image (p.39)
* Checkmarking (p.33, p.34)
» Rating (p.33, p.34)
* Rotating an image (p.13)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[(R+J)] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2.

@ If you cancel selection of [Group RAW and JPG versions], the RAW
image and JPEG image are displayed as separate images.
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Checking Image Information

Select the image for which you want to check the

image information.

Select the [View] menu » [Info].

The image information window appears.

Select a tab sheet and check information.

Image information window

IMG_0001.CR2 x| IMG_0001.CR2 x| IMG_0001.CR2 x|
[ EXif Tnformation | XMP/IPTG Information | Recipes Exif Information _AMP/P TG Information | Recipes Exif Information | XMP/IPTG Infor mation | FEGIES |
Ttem Value ~ | Description -] Ttem Value A
[Document Title]
File Name: IMG_0001CR2 Briehtress adiustment 000
il size i PEPESEYBest Uhite balance (Auta)
Picture Style {Landscape)
Gamers Mode| Caron E0S 300 [Greatar] Gontrast 0
Firmware Firmware Version X% IRRIOOOR Shadow 00
Shaating Date/Time  XXXH/XN/XX XXKNXY [Oreatars job Titke] g‘jg:"j’;‘ne gg
Grmer's Name RHRAOTOR Color saturation 00
Shostine Mode Bperiure-Priarity AE S— Linear oit
EEEen Black point 000
Tu(Shutter Speedy 1440
w(Shutter Speed) KRHHHKIHHK Midpoint 000
AviAperturs Valie) 56 White point 100
Mtering Mode Evalustive Metering EE;;;’)‘?}‘{';;&"E’] Sharpness Strereth: 40 Finer
Exposure Compensa., #uta Lighting Optimizer  Standard
RGE fane curves Criginal
150 Speed 3200 [Keywards] Reduce lminance noise 10
futa IS0 Speed oN FRRIHRIGONR Reduce chrominance naise 110
- Goler adjustment off
Lens EF17-40mm /4L USM [Comyright Status] Coler adiustment o
Focal Length 24 D KRHOHHKOK Saturation 000
Imags Size MO0 N Red off
] gl (el s Crange off
Bspect ratia 82
HRHOBHKO ellom ot
Image Quality R P it
Flash oif [Gopyrieht infa URL] A o
RHHOTOR
FE lock OFF Blue off
White Balance Mode  Puto ;’4‘;2:‘3 g::
AF Mode Marual focusing Lens corrsstion on
Pioture Styls Landscaps Digital Lens Optimizer  Oft

Sharpness 4 ~

< >

Peripheral illumination 00 w
Chematic shereation

<

1nnn RN RN

Shooting information is displayed in the [Exif Information] tab
sheet, while IPTC* information appended to the image after
shooting is displayed in the [XMP/IPTC Information] tab sheet.
IPTC* information provides additional comments on images,
such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [XMP/
IPTC Information] tab sheet.

* International Press Telecommunications Council (IPTC)

The contents of the [Exif Information] tab sheet will vary
depending on the camera model.

Recipe contents applied to an image are displayed in the
[Recipes] tab sheet.

ALy
~ N

=@> Convenient uses in the main window

Switching displays

If a different image is selected in the main window when the image
information window is displayed, the image information for that image
will be displayed.

Difference with the thumbnail with shooting information
Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in
[Thumbnails] menu » [With shooting info] (p.14).
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Organizing Images
This section explains how to delete unwanted images, move or copy
images, etc., to organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Move to Recycle Bin].

The image is moved to the [Recycle Bin] and is deleted from
DPP.

The images are deleted completely from your computer when the
[Empty Recycle Bin] operation is performed on the [Recycle Bin]
on the desktop.

Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <Ctrl> key and
release when the image is in the destination folder.
File Edit View Thumbnails P s Window Help

Er

Folder
=[] Desktop
&£ This PC

Desktop
Documents
Downloads
Music
Pictures
Videos
05 (C) A TiT 7
DATA2 (D:)
Ei-—== DATA (E)
E-= REMOVABLE DISK (1) @ 150
=8 BD-REDRIVE ()
- REMOVABLE DISK (K) MG 001.CR2
-= REMOVABLE DISK (L) i
-=e REMOVABLE DISK (M:)
-1 Libraries
_ t:! Network
M Holiday
B . Travel

i
&
i
L ¥
1
i J
FL.0 i { F5.6

The images are moved or copied to the destination folder.
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <Ctrl> key and
release when the folder is in the destination folder.
File Edit View Thumbnpails Preview Label Adjustment Tools Window Help
Eclit Irnage

Folder

=[] Desktop
-l oo

. Documents
R Downloads

E Pictures
T

' Travel ”
0 T T
S| B e
B DATA2 (D) I=1;
== DATA (E) @ 1503200
== REMOVABLE L ISK (I
48 BD-RE DRIVE 1})
—+= REMOVABLE [ ISK (K)
—= REMOVABLE [ ISK (L)
= REMOVABLE [ ISK (M)

IMG_0001.CR2

F3.6

The folders are moved or copied to the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders are displayed in the [Bookmark] tab sheet in the main
window.

Select the folder for which a bookmark is to be
registered.
File Edit View Thumbnails Preview Label Adjustment Tools Window Help
Re

Folder

&= Deskiop
- oo

Desktop
.} . Documents
' Downloads
" F Music

- = pictures
‘ = . Travel
‘ ZZ r Videos
B1-Ge 05 (C)
B DATA2 (D)
g DATA (E)
Bt REMOVABLE DISK (1)
--&& BD-RE DRIVE (%)
- REMOVABLE DISK (K
- REMOVABLE DISK (L)
- REMOVABLE DISK (M)

nnnnnn

- [Holiday

Select

F4.0 f

Select the [File] menu » [Bookmark].
The folder selected in step 1 is registered in the [Bookmark] tab
sheet in the main window.

Deleting Bookmarks
You can delete a folder registered in [Bookmark].

Select the [File] menu » [Remove bookmark].
The selected folder is deleted from bookmarks.
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4 Editing Images

RAW IMages ....c.uuiiiiiiieeeee e
RAW IMages......coooiiiiiiiii e
RAW Development ..........cccoooiiiviiiiiiiiiieeeeeeeeen
When RAW Development is to be Done....................
Advantages of a RAW Image .............eevvvvvivinnnnnnnnnnees

Editing JPEG and TIFF Images ............ccceevveeeennnnee

Tool Palettes .........oovviiiiii e

Editing with the Basic Adjustment Tool

Palette ...
Adjusting Brightness ..o
Changing the Picture Style .............ccccceeiii.

Using a Picture Style File ...........ccccooeevennne..
Adjusting Color Tone by Changing White Balance....
Adjusting Color Tone Using Click White Balance......
Adjusting White Balance with Color
TempPerature .........ccooove e
Tuning White Balance...............ccccoeeeveeennen,
Adjusting Contrast ...........ooovvvviiiiiiiiiiiiiiis
Adjusting Brightness of Shadows/
HIghlights ..o
Changing Color Tone and Color Saturation...............
Adjusting Monochrome.............coouviiiiiiiiieeiiiin.

T Adjusting Dynamic Range.............cccooveue.....
Adjusting Gradation and Luminance Automatically ...
Using the Auto Lighting Optimizer.....................o.
Adjust Face Lighting .........cooviiiiiiiiiiiiiiiis
Adjusting Image Sharpness..........ccccvvvvvvvenennnninnnnnnnns

Detailed Setting of Image Sharpness ....................
Adjusting Clarity...........ooevviiiiiiiiiiiiiiiiiees
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Editing with the Tone Adjustment Tool

Palette ... 62
Adjusting Brightness and Contrast.............ccccceveeeen... 62
Adjusting Color Tone Using Click White Balance....... 63
Adjusting Tone CUrve .........ccccccoeeeecueeecnnnn.e. 64

Example of a Tone Curve Operation...................... 65
) Adjusting Dynamic Range...........cccccvvevee.... 66
Using the Auto Lighting Optimizer..........cccccccoovnnneee. 66

Editing with the Color Adjustment Tool

Palette ... 67
Editing with the Color Adjustment Tool
Palette ... 67

Adjusting a Specific Color Gamut........................... 67
Adjusting Hue and Saturation for an Entire

IMAgE. .. e 68
Adjusting in Monochrome..........ccccccoeeeeeieeiicccnneee. 68

Editing with the Detailed Adjustment Tool

Palette ..., 69
Reducing NOISE .........cooiiiiiiiiiiei e 69
Adjusting Image Sharpness.........cccccceveciieeeeeiiiiiiennnnn 70
Reducing Color Moiré inan Image......................ooo. 70

Editing with the Trimming/Angle

Adjustment Tool Palette ..............coiiiiiiiii s 71

Editing with the Lens Correction Tool Palette.......... 74
Correcting Lens Aberration............cccoevvieiiieiiniieennnn, 74
Making Corrections........cccoeeeeeeeieiiiiiii 75

Effects of Distortion Correction for Fisheye
LENSES ... 76
Shooting Distance Information Slider ......................... 77
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Correcting Multiple Images ata Time............cccccee..... 78
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RAW Images
RAW Images

A RAW image is image data that has recorded output data of imaging
sensor. As image processing is not performed inside the camera when a
photo is taken and the photo has been recorded in the special form of
“‘RAW image data + Image processing conditions information at the time
of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

RAW Development

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“‘development”.

When RAW Development is to be Done

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP. As a result, RAW images displayed
in DPP are images whose development processing has been
completed.

With DPP, you can view, edit and print RAW images without being
particularly conscious of the development processing.

Advantages of a RAW Image

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Therefore, it is the
perfect data for users who want to get creative with the images after
shooting, as you do not have to worry about image deterioration.

In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe” (p.98).

iy

" RAW image

Contents adjusted using the tool

palettes can be handled
—1| individually as a recipe file

(extension “.dr4”) (p.98, p.99).

7

In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.99), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.100). However, a
recipe file with saved RAW image adjustments cannot be applied to
JPEG or TIFF images.

Downloading
Images

Viewing
Images

Sorting
Images

Editing
| s

 E—

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences

—_—

Q0
©



Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the tool palettes below.

» Tone Adjustment tool palette

* Color Adjustment tool palette

* Detailed Adjustment tool palette

* Trimming/Angle Adjustment tool palette

* Partial Adjustment tool palette

* Dust Delete/Copy Stamp tool palette

* Settings tool palette
Because adjustments made with these tool palettes (the recipe) only

change the image processing conditions, the “original image data itself”

remains unaffected. Consequently, there is none of the image
deterioration that normally accompanies editing and you can readjust
your image any number of times.

Image processing conditions information

f— Contents adjusted using the tool
palettes can be handled
—1 individually as a recipe file
(extension “.dr4”) (p.98, p.99).

In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.99), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.100). However,
recipe data with saved JPEG or TIFF image adjustments cannot be
applied to RAW images.

@ You can also adjust HEIF images in DPP in the same way as JPEG/
TIFF images.
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Tool Palettes

With DPP, you can adjust images with the tool palettes by switching
between various tool palette windows according to your editing
requirements. Since adjustments made with the tool palettes only

change the image processing conditions, the “original image data itself’

remains unaffected. As there is no image deterioration that normally

accompanies editing, you can readjust your image any number of times.

The various functions of the tool palettes are explained in more detail
under the respective topics.

Trimming/Angle Partial
Adjustment tool Adjustment tool
palette palette

Correctiontool

LenS Tool palette
ctiontool =

palette ’—

Basic

Adjustment Copy Stamp
tool palette tool palette
Detailed Settings tool
Adjustment palette

tool palette
""""" Color
Tone
) Adjustment
AdJUStment Auto Lighting Optimizer tOOJI palette
tool palette

Low Standard Strong
Adj face lighting

Clarity

Picture Style
Gamma adjustment

Auto M Linear
-100 -80 -60 -40 -20 00 ! 4.0

Basic Adjustment tool palette
Makes basic adjustments to a RAW image (p.48).

Tone Adjustment tool palette

Adjusts the tone curve and applies the Auto Lighting Optimizer (p.62).

Color Adjustment tool palette

Adjusts the hue, saturation and luminance of a specific color space. The
hue and saturation for an entire image can also be adjusted (p.67).

Detailed Adjustment tool palette

Reduces noise and adjusts the image sharpness (p.69).

Trimming/Angle Adjustment tool palette
Crops an image and adjusts the image angle (p.71).

Lens Correction tool palette
Corrects lens aberration in the image (p.74) and applies the Digital
Lens Optimizer (p.79).

Partial Adjustment tool palette

Adjusts the selected area of an image (p.82).

Dust Delete/Copy Stamp tool palette

Erases dust from an image and corrects image by copying sections
of the image (p.86).

Settings tool palette

Configures settings such as the work color space (p.91).
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g% Using the different tool palettes

We recommend that you use the Basic Adjustment tool palette to make
adjustments to RAW images. However, if you find that the Basic
Adjustment tool palette does not offer a sufficient range of adjustments,
or if you want to use specific functions that are only available in the Tone
Adjustment tool palette (p.62), completing initial adjustments with the
Basic Adjustment tool palette and then using the Tone Adjustment tool
palette to make just the minimum of adjustments needed is
recommended.
For noise reduction (p.69) and lens aberration correction (p.75), you
should first complete necessary adjustments in the Basic Adjustment
and Tone Adjustment tool palettes, and then adjust with the Detailed
Adjustment tool palette (p.69) and Lens Correction tool palette (p.74).
You can click the [] button at the bottom right of the main window
to show/hide [Tool palette].

Downloading
Images

|

Viewing
Images

|

Sorting
Images

{

Printing
Images

|

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

|

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences




JPEG/TIFF

Editing with the Basic Adjustment Tool Palette

The Basic Adjustment tool palette makes basic adjustments to RAW
images. With this tool palette, you can adjust the image brightness, set
Picture Style, adjust the white balance, adjust the contrast, adjust the
color tone and saturation, adjust the dynamic range, apply the Auto
Lighting Optimizer and adjust the image sharpness.

Note that the only adjustments you can make to JPEG/TIFF images are
applying the Auto Lighting Optimizer and adjusting the image
sharpness.

Select an image in the main window, etc.

Display the Basic Adjustment tool palette.

Brightness adjustment

White balance adjustment

#

™ (Auto: Ambience priority) -
¥
" o

G

— —

Auto Lighting Optimi;
Low Standard Strong
Adj face lighting

Clarity

Picture Style
Gamma adjustment

Auto
-100 -80 -60 -40 -20 00 20 40

Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

Tool palette

Reverts the image to
the original settings

Enter a numerical
value

Drag the slider left or right

@ The adjustment range is —3.0 to +3.0 (in 0.01-stop increments when
entering a value).
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Changing the Picture Style

If the image looks different from what you visualized at the time of
shooting, you can get it closer to what you expected by changing the
Picture Style. Even if you have saved the image (p.95) with
[Monochrome] (p.55) selected, you can still change to another Picture
Style at any point by simply selecting a Picture Style other than
[Monochromel].

Ficture Style
By (Standard) o
Gamma adjustment ¥

B Linsar

0 50 40 20 00 20 40

Reverts the image to
the original settings

Select

Move midpoint to match

Downloading
Images
N ——
Picture Style Description )
. . Viewing
The Picture Style set with the camera when the Images
image was shot.
When a mode in the Creative Zone is selected on the
B0 camera, the Picture Style set is displayed in (). Sorting
When a mode in the Basic Zone is selected on the -
camera, [Shot settings] is displayed in (), and image
characteristics that are according to the selected Edjfthg
shooting mode are applied. | s
Standard The image Iqoks VI.VId.- _ . -,
Generally, this setting is suitable for most images. Printing
The color tone will be adjusted to suit the scene. Images
The colors will look vivid. Especially the colors of —
Auto . . L ,
blue skies, greenery, and sunsets will be vivid in a Processing
shot of nature, outdoor, or sunset scenes. Large Numbers
of RAW Images
For nice skin tones.
: Effective for close-ups of women and children. By
Portrait . . , Remote
changing the [Color tone], you can adjust the skin Shooting
tone (p.55).
For vivid blues and greens. Playing Back
Landscape Effective for making images of landscapes Movies and Saving
impressive. Still Photos
Suited for detailed outline and fine texture \ ]
Fine Detail  description of the subject. The colors will be slightly RE\?anelm?es
vivid.
For natural colors and subdued images.
Neutral Effective for base images which are to undergo HI\DIIEd':Q
adjustment.
When the subject is photographed under a color o
: ; Specifying
temperature of 5200K, the color is adjusted Preferences
Faithful colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment. @ @
For black and white images.
Monochrome  You can also adjust with [Filter effect] or [Toning

effect] (p.55).
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Picture Style

(Picture Style file
registered in the

camera)

Description
Displayed when selecting an image shot with the
Picture Style file registered in the camera.
In the list, the name of the Picture Style file is
displayed in ().

[Picture Style file
applied in DPP]

The name of the Picture Style file applied in DPP is
displayed in [].

You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style.

[Auto] is not applied to images shot with the EOS-1D Mark 1V,
EOS-1Ds Mark I, EOS-1D Mark Ill, EOS-1D Mark Il N, EOS-1Ds
Mark Il, EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS 5D Mark II,
EOS 5D, EOS 7D, EOS 60D/EOS 60Da, EOS 50D, EOS 40D,
EOS 30D, EOS 20D/EOS 20Da, EOS 10D, EOS D2000,

EOS D30, EOS D60, EOS 550D, EOS 500D, EOS 450D,

EOS 1000D, EOS 1100D, EOS 400D, EOS 350D, EOS 300D,
PowerShot G3 X, PowerShot G1 X Mark Il, PowerShot G7 X,
PowerShot G9 X, PowerShot SX60 HS, PowerShot G5 X,
PowerShot G16, PowerShot S120, PowerShot G1 X, PowerShot
G15, PowerShot S110, PowerShot S100, PowerShot G9,
PowerShot G10, PowerShot G11, PowerShot G12, PowerShot
S90, PowerShot S95, PowerShot SX1 IS, PowerShot SX50 HS,
or PowerShot SX70 HS. When changing the Picture Style with
several images selected, although you can select [Auto] if images
shot with any supported camera other than the above are
included, [Auto] will not be applied to the images shot with the
above cameras.

You can apply [Fine Detail] to all images shot with supported
camera models except the PowerShot G3 X, PowerShot G1 X
Mark Il, PowerShot G7 X, PowerShot G9 X, PowerShot SX60
HS, PowerShot G5 X, PowerShot G16, PowerShot S$120,
PowerShot G1 X, PowerShot G15, PowerShot S110, PowerShot
S100, PowerShot G9, PowerShot G10, PowerShot G11,
PowerShot G12, PowerShot S90, PowerShot S95, PowerShot
SX1 1S, and PowerShot SX50 HS.

You cannot select [Auto] with multiple-exposure RAW images
created with the camera.
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Using a Picture Style File

A Picture Style file is a Picture Style extension file.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon website effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Click the [Browse] button in the [Picture Style] panel.

Gamma adjustment LA

B Ui

G0 =40 =20 00 20 40

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.
To apply a different Picture Style file, follow the procedure from
step 2 again.

@ The Picture Style files that you can apply to the camera are files with
the “.PF2” or “.PF3” extension only.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source to match the scene at the
time of shooting an image of, for example, pale-colored flowers.

Tool palette

‘White balance adjustment

Reverts the image to

* the original settings

P 1 2 ]

o ]

Select

i3 () is the white balance set on the camera when the image was shot.

* When a mode in the Creative Zone is selected on the camera,
the white balance set is displayed in ().

 When a mode in the Basic Zone is selected on the camera,
[Shot settings] is displayed in (), and image characteristics that
are according to the selected shooting mode are applied.

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.52).

@5 Tune with color tone

To make further fine adjustments to color tone after adjusting the white

balance, you can use [Color tone] (p.55) for tuning towards your expectations.

You cannot register the adjustment results as personal white
balance (p.137) when you have selected [ jf%§( )] from the list box.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

@ Refer to your camera’s Instruction Manual for details on each white
balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Tool palette

Click

The coordinates of the cursor position and
the RGB values (8-bit conversion) Reverts the

image to the
original settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click
the [[El}] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.

@ You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.

Downloading
Images

M —

Viewing
Images

|

Sorting
Images

{

Printing
Images

|

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

|

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences




Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

Tool pa lette

Caolor temperature -

s

Displays the value of
the setting

Drag the slider left or right

@ The adjustment range is 2000 to 10000K (in 10K increments).

Tuning White Balance

This is a function that makes fine adjustments to the white balance.
Using this function, you can achieve the same effects as third-party
color temperature conversion filters and color correction filters. The
adjustable range is £10 steps. This function is aimed particularly at high-
end users who are familiar with the roles and effects of color
temperature conversion filters and color correction filters.

Tune the white balance by dragging the point in the
adjustment screen in the [Fine-tune] panel.

Fine-tune

Enter the values to set

Drag the sliders left

or right

B stands for blue, A for amber, M for magenta and G for green.
The color is adjusted towards the color to which the point moves.
You can also fine-tune your adjustment by using the sliders or
entering the adjustment values.

Drag

@ To register the adjustment outcomes as a personal white balance
(p.137), select a setting other than [ % ( )] from the [White
balance adjustment] list box before tuning the white balance. If
you selected [ ( )] from the list box and tuned the white
balance, you cannot then register the outcomes as a personal
white balance.

You cannot change or adjust the white balance in multi-exposure
RAW images generated on the camera.

@ The adjustable range is 0 to £10. (in 0.1-stop increments when
entering a value).
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

Reverts the image to
the original settings

Picture Style

Yy (Standard) -

Gamma adjustment

Drag the slider left or
right (9 steps)

Enter a setting (in 0.1-
stop increments)

Adjusting Brightness of Shadows/Highlights
You can adjust the brightness of shadows and highlights in an image.

By adjusting only shadows or highlights in an image, you can reduce the
effects of clipping in shadows and highlights.
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Sorting
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Y (Standard) - Browss...

Gamma adjustment ¥

B Linear
-0 =40 -20 00 20 40
o

Drag the sliders left
or right

Enter a setting (in 0.1-
stop increments)

@ If you make a major adjustment to the highlights or shadows in an
image, the image may look unnatural. In such a case, reduce the
degree of adjustment.
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Changing Color Tone and Color Saturation

Tone and overall color saturation can be adjusted.
If Picture Style (p.49) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (this page).

Reverts the image to
the original settings

Drag the sliders left or
right

or tone N— + ju—

Enter a setting (in 0.1-

saturation — r— i
aturation 3= stop |ncrementS)

Color tone: Move the slider to the right to make tones
more yellowish, and to the left to make tones
more reddish.

Color saturation: Adjusts the overall color intensity for the
image. Move the slider to the right for more
intense colors, and to the left for less intense
colors.

@ The adjustment range is —4 to +4.

Adjusting Monochrome

When the Picture Style (p.49) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering, or with a look
of monotone color photograph.

Select [Monochrome] in the [Picture Style] list box.

Picture Style [~ Reverts the image to

SR tho orginal setings

Gamma adjustment A

B Linear
5.0 =40 -20 00 20 40
v

Displays the values of
the settings
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Filter effect: Creates a monochrome photograph where the white of
clouds and the green of trees are emphasized.

Filter Example of effect
None General monochrome image without filter effect.
Yellow Blue sky is reproduced more naturally and white

clouds emerge clearly.

Blue sky becomes somewhat darker. The

Orange brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: Creates a monochrome photograph to which a single
color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

ALy

=@ Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider to the right.

Adjusting Dynamic Range
Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Y (Standard) -

Move downwards
Output white points

Move to the left or right
Input white points

; T Move to the left or right
/ Mid (medium tone) point
e — : : : -+— Move upwards

= 0.0 0.00 Output black points

I{ B ]

Alr
Ak

You can also adjust
the dynamic range by

00 "
entering values

0o
0o
0o
0.0

AR ArRArEAERAL

Move to the left or right
Input black points

The horizontal axis shows the input level and the vertical axis
shows the output level.

Checkmark the [Move midpoint to match] checkbox to link the
mid-point to your adjustments to the input white points and input
black points.
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A/

=< [Linear] - A function for advanced adjustment

Use [Linear] when you adjust images using image editing software that
has advanced editing functions. Note that when [Linear] is
checkmarked, the image becomes dim.

@ [Contrast], [Highlight], [Shadow], and [Auto Lighting Optimizer]
(p.58) will not function when [Linear] is checkmarked.

Adjusting Gradation and Luminance Automatically

In order to give the image desirable gradations and luminance,
automatic adjustments are applied for an appropriate dynamic range.

Click the [Auto] button.

In order to give the image desirable gradations and luminance,
the dynamic range is automatically adjusted.

White points, midpoint, and black points in the [Gamma
adjustment] panel as well as [Highlight] and [Shadow] in the
[Advanced] panel are adjusted automatically.
Settings that are reset and those that are not with this adjustment
are as follows.

Settings that are reset

- Auto Lighting Optimizer

- [Contrast] in the [Advanced] panel

Settings that are not reset

- Brightness adjustment

- White balance adjustment

- Linear*

* White points and black points are automatically adjusted.

@ An image may look unnatural after automatic adjustment. In such a
case, reduce the degree of shadow and highlight adjustment.
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Using the Auto Lighting Optimizer

If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more favorable image.

You can also change the setting of the image shot with the camera’s
Auto Lighting Optimizer function.

This function also can be used for JPEG/TIFF images in addition to
RAW images.

* ALO stands for Auto Lighting Optimizer.

Checkmark the [Auto Lighting Optimizer] checkbox.

&uto Lighting Optimizer

Checkmark

Standard Strong

For the image shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Change the setting according to your preferences.
Auto Lighting Optimizer

Select from three
levels: Low/Standard/
Strong

—

Loy Standard

Auto correction is applied to the image to match the setting.
For the image shot with the camera’s Auto Lighting Optimizer
function, the setting at the time of shooting is applied as the
default value.

To cancel the Auto Lighting Optimizer, remove the check mark
from the checkbox.

When [Highlight tone priority] is set to [Enable] on any supported
EOS camera other than the EOS-1D Mark IV or EOS 5D Mark II,
the Auto Lighting Optimizer cannot be used for RAW images.
You cannot use the Auto Lighting Optimizer with multiple-
exposure RAW images created with the camera.

When you apply Auto Lighting Optimizer to the RAW and JPEG
images shot simultaneously, the correction results of the two
images may differ.
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Adjust Face Lighting

With adjust face lighting, you can automatically optimize facial lighting

and effectively correct a face that is illuminated at an angle or by a flash.
This function can be enabled when the Auto Lighting Optimizer is used.

Use this function with RAW images from images of people shot with an
EOS R5 or EOS R6.

Select a supported image in the main window, etc.

Checkmark the [Adj face lighting] checkbox.

Auto Lighting Optimizer

Checkmark

The image is corrected.

® You might not be able to checkmark the Adj face lighting
checkbox for images such as where facial details cannot be
discerned or a face is too dark.
Noise may increase.
Adjustment may be less effective at high ISO speeds.

Adjusting Image Sharpness

You can make the overall atmosphere of an image sharper or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and
[Unsharp mask].

[Sharpness]: Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting value), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]: Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting value), the more the image’s edges
are emphasized for a sharper image.

[Fineness]: Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the easier it becomes to emphasize fine
details.

[Threshold]:  Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

@ [Unsharp mask] cannot be used with images other than RAW
images.
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Select [Sharpness] from the list box and adjust the Detailed Setting of Image Sharpness
setting. Select [Unsharp mask] from the list box and adjust
Picture Style [~ Reverts the image to the setting.

Standard - rm— the original settings
g g =

wle

n (Standard) o Browse..

Gamma adjustment b

Gamma adjustment A

G0 -40 20 00

- B Lincar

G0 40 20 00 20 40

Color

Eharpness

Select [Sharpness]
Strength — e Y Enter a setting (in 0.1-
stop increments)

Select [Unsharp mask]

Fineness Enter a setting (in

Drag the slider left or right hreshold _ 0.1-stop increments)

Drag the slider left
or right

@ Adjust image sharpness with the window view set to [400%], [200%]
or [100%]. If the view is set to [Fit to window] (full view), you may not
@ The adjustment range is 0 to 10. be able to correctly check the adjustment results.
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Adjusting Clarity

This function allows you to change the contrast at the edges of an
image. It can be used with images shot on a camera model that allows
clarity to be set on the camera.

Select an image to adjust in the main window, etc.

Display the Basic Adjustment tool palette and adjust
the image.

Clarity Reverts the image to
the original settings

Enter a numerical
value

Drag the slider left or right

The further the slider is moved to the right, the more clarity the
image has.

@ The adjustment range is -4 to +4.
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JPEG/TIFF

Editing with the Tone Adjustment Tool Palette

With the Tone Adjustment tool palette, you can adjust images with the
same functions as general image editing software.

Select an image in the main window, etc.

Display the Tone Adjustment tool palette.

Tool palette

Adjusting Brightness and Contrast

The brightness and contrast of an image can be adjusted. Since the
adjustment range is broader than the same functions in the Basic

Adjustment tool palette, the image color may be saturated, or the image

quality may deteriorate if you adjust too much. Be especially careful

when adjusting.

Reverts the image to
the original settings

]

— Drag the sliders left or
right

—Enter a setting (in 0.1-
stop increments)
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Brightness: Move the slider to the right to make an image
brighter and to the left to make an image darker.

Contrast: Used to adjust modulation and degree of contrast
of color. Move the slider to the right to make
contrast of an image stronger and to the left to
make contrast weaker.

@ The adjustment range is —100 to +100 (in 0.1-stop increments when
entering a value).

Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[lE@] button.

] .9 A iz

Lztment | 4=,
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Click on a point that is to be the standard for white.

Click
The coordinates of the cursor position and
the RGB values (8-bit conversion)

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click
the [[El}] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.

@ The histogram display changes according to adjustment. You can
also display the histogram before making any adjustments.

Adjusting Tone Curve

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.185).

Select the tone curve mode and interpolation
method.
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Make adjustments.

Tore curve adjustment

. Luminance R G B
. Straight

ra

=

'—‘r—

A

RGB: Adjusts RGB
in a batch

R, G, B: Adjusts
each channel

You can display pre-
and post-adjustment
histograms

Coordinates of [[]
(when several
coordinates are set,
coordinates of last-
set [[])

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[]] is 8.

To delete a [[], either press the <Del> key or double-click on the [[]].

Example of a Tone Curve Operation

Makes medium tones brighter

Makes medium tones darker

Makes tones sharper

Makes tones softer
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Move downwards
Output white points

| 3 o

I Reverts the
Luminance R & B image to the
Straight original
settings
Move to the o — Move to the
right left
Input black Input white
points points
Input black Input white.
point numerical [ 0 2l | pointnumerical
value (RN S o value
Output black Output
pointnumerical i white point
value numerical
Contrast CCNES| iy

Move upwards
Output black points

The horizontal axis shows the input level and the vertical axis shows
the output level.

@ The setting range of black points is 0 to 247 (in 1-stop increments

when entering a value).

The setting range of white points is 8 to 255 (in 1-stop increments
when entering a value).

You can display pre- and post-editing histograms (p.65).

Using the Auto Lighting Optimizer

For information on using the Auto Lighting Optimizer, see “Using the
Auto Lighting Optimizer” (p.58) in “Editing with the Basic Adjustment
Tool Palette”.
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JPEG/TIFF

Editing with the Color Adjustment Tool Palette el

With the Color Adjustment tool palette, you can adjust the hue, ——
saturation and IurrJ1inance ina srr;ecific ci/)Ior gamutjfor 8 color gamuts Viewi
(red, orange, yellow, green, aqua, blue, purple and magenta). You can Editing with the Color Adjustment Tool Palette |,!,$:323
also adjust the hue and saturation for the entire image and tune
monochrome images. Adjusting a Specific Color Gamut Sorting
Select an image in the main window, etc. Use the sliders to make adjustments. You can also make adjustments Images
by directly entering a numeric value. ——
H: Adjusts the hue. Eﬁg
Display the Color Adjustment tool palette. S: Adjusts the saturation. I s

L: Adjusts the luminosity.

 E—
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Adjusting Hue and Saturation for an Entire

Image

Use the sliders to make adjustments. You can also make adjustments

by directly entering a numeric value.

Hue: Move the slider to the right to make color tones more

yellowish, and to the left to make color tones more reddish.

Saturation: Adjusts the overall color intensity for the image. Move the
slider to the right for more intense colors, and to the left for

less intense colors.

Calor adjustment

Hue

Saturation

|

Orange

|

Yellow

|

Revert all adjustments
to the original settings

Enter the values to set

Drag the sliders left or
right

@ The adjustment range for hue is —30 to +30; and for saturation is 0

to 200.

Adjusting in Monochrome

Press the [Monochrome] button to set the 8 color gamuts to their least
saturation (-10) and create a monochrome image. After creating it, you
can tune the monochrome image with the H and L sliders for each color
gamut, adjusting the hue and brightness.

Color adjustment

Hue

Saturation

LY

Oranege

I~

*re o

I~

——— [

Monochrome

Drag the sliders left or
right

Revert all adjustments
to the original settings

Enter the values to set
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Editing with the Detailed Adjustment Tool Palette R
You can use the Detailed Adjustment tool palette to reduce the noise . . —
that occurs in images shot at night or at high ISO settings. This tool Reducmg Noise Viewing
palette can also be used in conjunction with the sharpness adjustment . . o . . . Images

. . s . You can reduce noise that arises in images shot at night or with a high
functions. Note that you can use the functions in this tool palette with
JPEG and TIFF images as well as RAW images ISO speed.
9 ges. * NR stands for Noise Reduction. Sorting
. . . . Images
Select an image in the main window, etc.

Adjust an image.

Display the Detailed Adjustment tool palette.

 E—

Tool palette Enl t
niargemen Printing
display Images
Processing
Check window Large Numbers
of RAW Images
Remote
Shooting
Maize reduction
.IF!II e |Uminance e I Playing BaCk
F"j':;i_l'" i Drag the sliders Movies and Saving
) ) Still Photos
Reduce chrommmance noise Enter a Settlng (In 01' Dl
: stop increments
ise ¥ P ) Handling
-— = You can set a noise reduction level from within a range of 0 to 20. RAW Movies
Reduce chrominance noise v The larger the setting, the larger the noise reduction effect.
P— [ s . . .
B Fes: (R The noise reduction effect can also be checked in the check HDR PQ
—_— window. Mode
Sharphess | 4=
AR
. s M Preferences
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Y
ZQ)= Setting the same noise reduction level for several images

You can set the same noise reduction level for several images by first
selecting multiple images in the main window, and then adjusting the
noise reduction level using the [Reduce luminance noise] and [Reduce
chrominance noise] sliders.

@ If [Reduce luminance noise] is set, resolution may be reduced
along with reduction of noise.
If [Reduce chrominance noise] is set, color bleeding may occur
along with reduction of noise.

Adjusting Image Sharpness

You can also use this palette to adjust the image sharpness. For
information on making adjustments, see “Adjusting Image Sharpness” in
“Editing with the Basic Adjustment Tool Palette” (p.59).

Reducing Color Moiré in an Image

You can reduce color moiré* occurring in an image.

*Color moiré: Occurrence of a color appearing that is not originally in an
image. In particular, tends to occur when taking photos of latticed or
similar patterns.

Checkmark the [Reduce color moiré] checkbox and
adjust using the slider.

Moize reduction

Feduce luminance noise

— =

Reduce chraminance noise

—— o

Reduce color mairé

_

® Depending on the subject, you may not be able to correct color

moiré completely.

Using this function may cause hue to change depending on the
subject. If there is a noticeable change in hue, lower the level of
adjustment.
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JPEG/TIFF

Editing with the Trimming/Angle Adjustment Tool Palette

You can crop only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before cropping.

Select the image to be cropped.
Display the Trimming/Angle Adjustment tool palette.

You cannot make adjustments with the Trimming/Angle
Adjustment tool palette in a window that only shows thumbnails.

Adjust the angle of the image as needed.

Trimming/angle adjustment window

Largest possible
trimming range

Drag (0.01-degree increments; adjustment range: —45 to +45
degrees)

Use the mouse (click A/V¥)to adjust the angle or directly enter
the adjustment angle (0.01-degree increments; adjustable
range: —45 to +45 degrees)

If you click [Center on Screen], you can display the trimming
range in the center of the window.

When correcting lens aberrations, it is recommended to perform
lens aberration correction before adjusting the angle of the
image.

If you have only adjusted the angle of the image, the image will
be cropped at the largest possible trimming range.

Select a ratio and drag the trimming range.

Select a trimming ratio
Cancel

Drag the trimming
range

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

@ When aspect ratio information is attached to an image shot with any
supported camera other than the EOS 5D Mark I, the displayed
trimming range is based on the aspect ratio information.
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List of aspect ratios (width : height)

Free -

T T 1 O ST ST O e e S0 0D D —

o
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Custom
[Free]:

You can crop an image to any size, regardless of
the selectable ratio.

[Custom]: You can crop an image at the specified ratio.

Return to the main window.
The trimming range frame is displayed in the cropped image
(p.184).
When the cropped image is displayed in a preview window or the
edit image window, it is displayed in its cropped form.

? Cropped images

The trimmed range can be reverted to its original condition at

any time

A cropped image is displayed or printed as a cropped image.

However, since the image is not actually cropped, you can always

revert to the original image by clicking the [ [ lka3ll] button in the

trimming/angle adjustment window or performing the “Re-Editing an

Image” procedure (p.97).

Display of the cropped image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.184).

* Preview window:  The image is displayed in its cropped condition.

« Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the preview window display.

Printing a cropped image
You can print as a cropped image by printing it in DPP.

The image becomes a cropped image when converted and saved
The cropped RAW image actually becomes a cropped image when
converted to a JPEG or TIFF image and saved (p.95).

Images that have aspect ratio set will be displayed as cropped
images

When aspect ratio or cropping information is attached to a RAW
image shot with any supported camera other than the EOS 5D Mark
I, the image will be displayed with the set trimming range based on
the information. Since the image is not actually cropped, you can
change the trimming range or revert to its condition before cropping.
However, when a JPEG image is shot either with an aspect ratio set
with a camera that supports aspect ratio information or with the EOS
5DS/EQOS 5DS R set to crop shooting, its trimming range cannot be
changed or the image cannot be reverted to its condition before
cropping since the image is actually cropped and saved.*

When reverting to the trimming range that is based on the aspect ratio
information at the time of shooting, click the [ [ EaIl] button. Also, if
you want to cancel all the trimming range, click the [Clear] button.
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* When shooting with EOS 5DS/EOS 5DS R, EOS 5D Mark IV, EOS
5D Mark 1ll, EOS R5/R6/R/Ra/RP (with any setting other than [1.6x
(crop)]), or EOS 7D Mark Il and [Add cropping information] is set in
Custom Functions, aspect ratio information is only set and the
image is not actually cropped, even for JPEG images.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
cropped image in the main window together with the images to which
you want to apply the trimming range and then display the Trimming/
Angle Adjustment tool palette. With the cropped image displayed,
click the [Copy] button and then click the [Paste] button. This will
apply the trimming range to all the images selected when the
trimming/angle adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <Ctrl> key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <Shift> key.

@ For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view the image in detail in the
trimming/angle adjustment window.
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Editing with the Lens Correction Tool Palette

With the Lens Correction tool palette, you can use the lens aberration
correction functions and the Digital Lens Optimizer to correct lens
aberration in your images and to improve their resolution. This tool
palette can also be used in conjunction with the sharpness adjustment
functions. Note that the lens aberration correction functions and the
Digital Lens Optimizer can only be used with RAW images.

Select an image in the main window, etc.

Display the Lens Correction tool palette.

M Distortion

Shot settines

Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

You can only correct aberration in RAW images which have been shot
with compatible lenses. JPEG or TIFF images cannot be corrected.
Note that even though the EOS 20D/EOS 20Da, EOS 10D, EOS D2000,
EOS D30, EOS D60, EOS 350D, and EOS 300D are EOS cameras
supporting the Digital Photo Professional, they are not compatible with
the lens aberration correction function. Also, note that the lens
aberration correction function is compatible with the EOS 5D with the
firmware version 1.1.1 and the EOS 30D with the firmware version
1.0.6.

® To use this function, the EOS Lens Registration Tool (version 1.4.20
or later) must be installed.

@ Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window (p.80).
You can also correct RAW images taken with the compatible lens
even when the extender is attached.
You can also correct RAW images shot with EF50mm /2.5
Compact Macro fitted with Life Size Converter EF.
The aberration correction function is not available for images shot
with a lens other than those given under “Compatible Lenses”.
They are therefore not displayed and cannot be used.
The lens aberration correction function is not available for
multiple-exposure RAW images created on the camera.
EF cinema lenses (CN-E lenses) are not compatible.
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Making Corrections

You can make corrections to any of the five aberrations as below, either
one at a time or simultaneously.
Peripheral illumination
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
Distortions Diffraction

Select an image in the main window.

Display the Lens Correction tool palette and
checkmark the items to be corrected.

Enlargement display section

The image is corrected and redisplayed.
In the main window, the [# 1] mark is displayed on the image to
indicate that the lens aberration correction is applied (p.184).

Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check and
then checking the enlargement display section in the top of the
window. You can choose from 4 display scales between 1:1 and
1:4 for the enlargement display.

You can lessen the degree of correction by moving the slider to
the left.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

To correct distortion aberration of images shot with a fisheye lens
(EF8-15mm f/4L USM Fisheye or EF15mm /2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].

For detailed information on each effect, see “Effects of Distortion
Correction for Fisheye Lenses” (p.76).

For images shot with EF8-15mm f/4L USM Fisheye, a fine-tune
slider is also displayed when you select [Emphasize Linearity]
from the [Effect] list box.

Adjust the amount of correction for distortion aberration with the
adjustment slider, and then adjust with the fine-tune slider if more
adjustment is required.

When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.
[Diffraction correction] corrects only those images shot with a
camera with a diffraction correction function. By checkmarking
this option, images are corrected according to the camera’s
diffraction correction function. Note that this function cannot be
used at the same time as the Digital Lens Optimizer.

The adjustment range of distortion correction is either [0 to +100]
or [-20 to +120], depending on the camera model that was used
for shooting. The adjustment range for images shot with a
fisheye lens mounted is [0 to +100] regardless of the camera
model that was used.
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Downloading
Images
Effects of Distortion Correction for Fisheye Emphasize Distance
Lenses This converts the image to an “equidistant projection” style image. Viewing
This projection method preserves distance relationships. Images
Shot settings Equidistant projection displays a distance in the same distance
By selecting this option, only the aberration corrections will be anywhere from the center to the periphery. In particular, when .
performed to correct the optical distortions. shooting a celestial body such as the celestial sphere, same heights |S°rt'"9
: 7 . i mages
above the horizon(declination) are captured at the same heights. This
method is therefore used in such photography as celestial
photography (star maps, solar path diagrams, etc.). Eﬂg
| S
Printing
Images
Processing
Large Numbers
of RAW Images
Emphasize Linearity Remote
This converts the image to a “central projection” style image. This Shooting
projection method is employed for general lenses. . .
Since central projection displays straight lines as straight lines, a Emphasize Periphery Playing Back
wide-view panoramic image can be obtained by selecting this option. This converts the image to a “stereographic projection” style image. M°"s"t’.S"aP“hd tSavmg
However, the periphery is stretched, resulting in decreased resolution. This projection method emphasizes the periphery. 1 Folos
Stereographic projection allows position relationships on a spherical )
' surface, such as N, S, E, W on a map, to be displayed correctly. It is Handling
' / therefore used for world maps and monitoring cameras. RAW Movies
By selecting this option, the periphery is stretched and may result in —
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Emphasize Center

This converts the image to an “orthographic projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography. By
selecting this option, the center is stretched and may result in
decreased resolution.

@ When selecting any of the options, [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center], it will yield results similar to that of the selected projection
method. However, the conversion does not really apply a change of
projection method in a strict sense.

Accordingly, be aware that they are not suited for scientific or other
such purposes.

Shooting Distance Information Slider

When correcting RAW images and if shooting distance information has
been saved to the image, the slider is set automatically according to
this shooting distance information. However, if no shooting distance
information is saved to the image, the slider is set automatically to the
right end at infinity position and a [<!>] appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.
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For RAW images shot with MP-E65mm /2.8 1-5x Macro Photo or
EF50mm f/2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

The [Shooting distance information] slider is applied to all the
correction items with check marks.

If the lens requires no adjustment with the [Shooting distance
information] slider, the slider cannot be used.
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Correcting Multiple Images at a Time

You can apply the same corrections to several images by first selecting
multiple images in the main window, and then performing correction
procedures (p.75).

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.99).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.69). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high 1ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.70).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.55) and/or the color saturation (p.68) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

® The periphery of the image may be truncated when [Distortion]
correction is made.

Digital Lens Optimizer

This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability or
any deterioration of resolution resulting from diffraction phenomena.
These optical phenomena cannot be corrected under Lens aberration
correction (p.74). Correction is achieved using the designed value of
each lens. You can correct these optical phenomena in RAW images
which have been shot with compatible lenses. JPEG, TIFF, S-RAW, and
M-RAW images cannot be corrected. To use this function, [Lens data] for
the lens used to shoot images first needs to be downloaded to your
computer. Before using the Digital Lens Optimizer, it is recommended

that you set [Sharpness] or [Strength] for [Unsharp mask] for images to 0.

Note that even though the EOS 20D/EOS 20Da, EOS 10D, EOS D2000,
EOS D30, EOS D60, EOS 350D, and EOS 300D are EOS cameras
supporting the Digital Photo Professional, they are not compatible with
the Digital Lens Optimizer. Also, note that the Digital Lens Optimizer is
compatible with the EOS 5D with the firmware version 1.1.1 and the
EOS 30D with the firmware version 1.0.6.

@ To use this function, the EOS Lens Registration Tool (version
1.4.20 or later) must be installed.
The Digital Lens Optimizer is also available for images shot with
an extender attached to a compatible lens.
You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.
EF cinema lenses (CN-E lenses) are not compatible.
[Diffraction correction] cannot be used at the same time as the
Digital Lens Optimizer.
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Using the Digital Lens Optimizer

Check the status of [Lens data] for [Digital Lens
Optimizer].

Shoeting distance information

[Not Available] is displayed for an image shot with a non-
compatible camera or lens, or for a non-compatible image such
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot
be used for these images.

If [No] is displayed, proceed to step 2. To use the function, you
need to download the lens data for the lens used when shooting
the image. It is recommended that you check the lens used when
shooting the image beforehand. The lens used can be checked
using the image information and shooting information displays.
You can also check it with the menu that appears when you right-
click with the mouse on an image.

If [Yes] is displayed, proceed to step 4.

Click the [[ESE] button.

Shocting distance information

The [Add or Remove lens data] window appears.

® To use this function, an environment with Internet access

(subscription to a provider and an in-place line connection) is

required. Internet Service Provider (ISP) connection fees or access

point connection fees may apply.

@ Before you click the [|[jifiSll] button in step 2, Lens data [No] may

be displayed instead of [Not Available] for non-compatible images.
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Checkmark the checkbox for the lens used to shoot
the image, and click the [Start] button.

[} Add or Remove lens data (Version 1.8.20) “
Select a lens category
Ultra wide and wide Macro EF-M
Standard and medium telephata Zoam T3-E
Telephota EF-5 Select all Glear all
Extender EF 4% EF2x 1L lenses anly

[ EF20-86mm /3 5-4 5 USM ~
[ EF24-70mm /281 T USM

[ EF24-70mm /2351 USM

[] EF24-70mm /4L IS LUSM

=

—
EF24-105mm 1/35-56 IS 5TM
=

=
[] EF24-105mm /4L 15 USM

[ EF28-70mm /241 USM

[ EF28-80mm /4-55 [T

[] EF28-90mm £/4-55 I

[[] EF28-80mm £/4-5.6 [T USM

[] EF28-105mm 1/35-45 USM

[] EF28-105mm 1/3.5-4.5 I USM
[] EF28-105mm 1/4-55

[] EF28-105mm 1/4-5.5 USM

[] EF28-135mm 1/3.5-56 IS USM
[] EF28-200mm /3 5-55

[[] EF28-200mm 1/3.5-5.6 LS

[ EF28-800mm 1/3 5-56L IS USM
[ EF55-200mm {/4 5-5.5 T USM
[ EFE5-200mm 144 5-5.6 LISM

[ 1 FEI0-20itmm 473 81 15 T 1S

]

l Start ' Cancel

Destination Folder.. #dd: 1 / Delete

Mote

The lens data is downloaded to your computer.

When the downloading of the lens data ends, the indication for
the lens data changes to [Yes].

Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window.

If you remove the check mark from the checkbox for already-
downloaded lens names and click the [Start] button, the lens data
will be deleted from your computer.

Depending on the type, current state, etc. of software running on
your computer, the download of the lens data may fail. If it occurs,
wait for a while then try downloading the data again.

If you want to change the destination where lens data is saved
when there is already downloaded lens data, move the previously
downloaded lens data from the old folder to the new destination
folder manually.

Checkmark the [Digital Lens Optimizer] checkbox
and adjust the image.

Shooting distance information

& Lens data : Yes
Reverts to its condition
before adjustment

Digital Lens Optimizer

— 4 =

]

@ Since the lens data downloaded with DPP version 3.x is not
compatible with DPP version 4.x, the lens data must be downloaded
again.

@ When applying the Digital Lens Optimizer, the effect of [Sharpness]
or [Unsharp mask] may become excessive. It is recommended that
you set [Sharpness] or [Strength] for [Unsharp mask] for images to 0
before using the Digital Lens Optimizer. Adjust [Sharpness] or
[Unsharp mask] again after applying the Digital Lens Optimizer to
images.
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Use the slider to adjust the Digital Lens Optimizer effect.

If no shooting distance information is saved to the image, the
shooting distance slider is set automatically to the right end at
infinity position and a [<!>] appears above the shooting distance
slider.

If the lens requires no adjustment with the [Shooting distance
information] slider, the slider cannot be used.

Images cannot be corrected for [Chromatic aberration] in the lens
aberration correction tool pallet if the Digital Lens Optimizer has
been applied.

In the main window, the [ﬁ] mark is displayed on the image to
indicate that the Digital Lens Optimizer is applied (p.184).
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JPEGITIFF

u u - Ll Ll D I d'
Editing with the Partial Adjustment Tool Palette ®images
The Partial Adjustment tool palette adjusts the selected area of an Select [Adjustment group]. C—
|m.age.. . _ e Viewing
With this tool palette, you can adjust brightness, contrast, hue, and Al B ST Images
saturation, and reduce color moiré. G —
Supported image formats are CR2, CR3, TIFF, and JPG. Sorting

Images

Making Partial Adjustments to Images

([Brightness], [Contrast], [Hue], [Saturation]) Contrast
———— =
Select an image in the main window, etc. Hue
-_—— _ Printing
. . . Saturation Images
Display the Partial Adjustment tool palette. e el 1100 |
Processing
Tool palette Large Numbers
(51 of RAW Images
L] - " Select [Adjustment group] from [IER]. [IER], [IER], [IERW], and
Set Adjustment Area [] Remo_te
_ - (By default, [[JEm] is selected.) Shooting
_._ For information on adjustment groups, see “Adjustment Groups” ‘—‘
Blur radius (p85) P!aymg Back.
Movies and Saving
Click the [Set Adjustment Area] button. Still Photos
Handling
e : RAW Movies
Set Adjustment Area
[,
Size HDRPQ
——— Mode
Blur radius —
_ : * : . .
Saturation S peCIfyl ng
. A circular cursor appears in the window. TN e
—_—




Downloading
Images
— Click or drag the circular cursor on the image to ——
select the area of adjustment in the image. Viewing
Images
Use the sliders to adjust [Adjustment items] as \
necessary. Sorting
Images
fdjustment eroup

Erightnezs Printing
—— m Images
Ciontrast _—
+ N
m Processing
Hue Large Numbers
Saturation
—— m Remote
Shooting

\

Circular cursor ) ) _ Playing Back
] ] ] ) Adjustments are applied to the area selected in step 6. Movies and Saving
Drag the sliders to adjust [Size] and [Blur radius] for You can use the [, (SR, [E3E], and [N Still Photos
the circular cursor. buttons below [Adjustment items] to return and check positions
selected with the circular cursor. Available buttons, from the left, Handling

are [Undo All], [Undo], [Redo], and [Redo All]. RAW Movies

Set Adjustment frea
: HDR PQ
== Mode

Size

*
Blur radiuz Specifying

—feee—— [ Preferences

|

[Blur radius] adjusts blurring at the border of the selected area.



Downloading

Images

Making Partial Adjustments to Images -
. iewing
(IReduce color moiré]) Images

This function partially reduces color moiré in images. i
Before making adjustments, see “Reducing Color Moiré in an Image” ISr:;tmg
: . : - ges

(p.70) for information on reducing color moiré.

Changes edited with this function are not displayed in the
following images.
* Thumbnail images
* Navigator images
* Images in the HDR [Select images] window (see p.110, step 3)
* Images in the [Contact sheet] window for printing a thumbnail
list (see p.134, step 3)
However, edited changes are applied when four images or
fewer (JPEG/TIFF images) are selected.
Changes edited with this function are not applied in the DPP
histogram display.

Select an image in the main window, etc.
Display the Partial Adjustment tool palette.

Click the [Reduce color moiré] button in [Adjustment
group].

A dialog box for [Reduce color moiré] appears.

Click the [Set Adjustment Area] button, and use the
[Size] and [Blur radius] sliders for the circular cursor
to make adjustments.

Click or drag the circular cursor on the image to
select the area of adjustment in the image.

Use the [Reduce color moiré] slider in [Adjustment
items] to specify the setting.
Adjustments are applied to the area selected in step 5.

You can use the [IESEN]. [IIESEN]. (B3], and [IETN]
buttons below [Adjustment items] to return and check positions
selected with the circular cursor. Available buttons, from the left,
are [Undo All], [Undo], [Redo], and [Redo All].
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Changes edited with this function are not displayed in the
following images.
* Thumbnail images
* Navigator images
* Images in the HDR [Select images] window (see p.110, step 3)
* Images in the [Contact sheet] window for printing a thumbnail
list (see p.134, step 3)
However, edited changes are applied when four images or
fewer (JPEG/TIFF images) are selected.
Changes edited with this function are not applied in the DPP
histogram display.

Adjustment Groups

Adjuztment group

[ Feduce color mairé

The Partial Adjustment tool palette comprises 5 adjustment groups

that allow adjustments to be made with [Brightness], [Contrast], [Hue],

and [Saturation] options, and 1 adjustment group that allows

adjustments to be made with the [Reduce color moiré] option.

+ A different adjustment area can be selected for each adjustment
group.

» Adjustment groups [IER]. [(IER]. [IER]. [IEW]. and [[IEE] allow
different values to be specified even for a same adjustment option.

By default, adjustments from all adjustment groups are applied to an

image. However, you can click the [[F] button and select to apply or

not apply adjustments from each adjustment group.

Positions selected with the circular cursor, that can be checked using

the (IS, [IESN], (M=), and [IEETEN] buttons below

[Adjustment items], can be checked per each group.

The order of adjustment groups in which adjustments are applied to

images is (1) [Reduce color moiré], (2) [IER]. (3) [IER]. (4) [IEW],

(5) (IEM), and (6) [NEM]-
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JPEG/TIFF

Editing with the Dust Delete/Copy Stamp Tool Palette

You can use this tool palette to erase dust and other marks in a shot
image and to correct an image by copying part of the image and pasting
it onto an unnecessary part of the image.

Note that you can use the functions in this tool palette with JPEG and
TIFF images as well as RAW images.

Dust Delete/Copy Stamp Tool Palette

N el Dust Delete Data

(Dark)

Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images can be used to
automatically erase dust spots.

Select an image with dust delete data attached in the
main window, etc.
Display the Dust Delete/Copy Stamp tool palette.

You cannot make adjustments with the Dust Delete/Copy Stamp
tool palette in a window that only shows thumbnails.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

Dust spots are erased in a single operation.

Return to the main window.

Downloading
Images

|

Viewing
Images

|

Sorting
Images

{

Printing
Images

|

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

|

Handling
RAW Movies

HDR PQ
Mode

|

Specifying
Preferences




? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [[Ea3l] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.97).

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.88) or the copy stamp function (p.90).

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.95).

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image from which you
want to erase dust spots.

Display the Dust Delete/Copy Stamp tool palette.

Click the point from where dust is to be erased.

Click

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spot to be

erased.
If the dust spot is dark in color, click the | Dark) ] button,
and if the dust spot is light in color, click the [ RTINS |
button.

When you move the cursor over the image, the dust erasure
range is indicated with [O].

Place the dust spot to be erased within the [O] and
click.

Click

The dust spot within the [O] is erased.

Click on another part of the image to continue erasing dust spots

within the displayed image.
To erase dust in another part of the image, either right-click with

the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.

When the dust spot cannot be erased, [@] is displayed.

Return to the main window.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.90).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [ [ Ea3l] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.97).

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.95).

Ny

=< Useful functions of the copy stamp window

Switch between full screen display/normal screen display using

shortcut keys
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

@ For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1 to 3 in “Manually Erasing Dust (Repair
Function)” (p.88).

Specify the section to be copied.
Click on the section that is to be the copy source after clicking the
[Select Copy Source] button.
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To change the section that is to be the copy source, perform the Trﬂ:tigsg
operation above again. 9
To fix the p(.)S.Itlon of the copy source, checkmark [Fix Copy Preeeg
Source position]. Large Numbers
) of RAW Images
Correct the image. el
Click or drag on the part of the image you want to modify. [+] in Remote
the window indicates the copy source and [Q] indicates the copy Shooting
destination.
The copied image is pasted in the position to which it was Playing Back
dragged. Movies and Saving
Still Photos

For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s y
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Setting Work Color Space

A different work color space (p.177) from the default settings (p.186) can
be set for each image.

Display the Settings tool palette » select the color
space to be set.

Settings tool palette

Tool palette
B 1
]
HODR P2
Q it ®0n

‘Wiork color space

oof colors

Profile : Settings..
-—— Mone —

|:|r|:|f il

zimulation profile

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.177), this
default setting will not be applied and the individually set color space will
remain.

-:@/3 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Using the Soft-Proof Colors Function Downioading

By using the soft-proof colors function, you can apply a selected printing According to the profile selected in step 2, select —
p}[‘i;”e OrﬂCMYﬁ S'Tu'a?on f_rOf"de to th; d'Spt'syed '”?fge- Tfl‘_‘ta r‘i'r"ab'“ty either [Use printing profile] or [Use CMYK simulation Viewing
of the soft-proof colors function depends on the monitor quality, the . } Images
monitor and printer profiles, and surrounding lighting conditions where profile], and checkmark the [Soft-proof colors] -
you are working. checkbox.
Sorting
Images

Click the [Settings] button.

Toal te X

—

Printing
Images
Profile : Settings... _—
10.0.0.6.6.6.6.6.6.9.9.0.0.4.4 Processing
O Use printing Large Numbers
of RAW Images
The profile selected in step 2 is applied to the displayed image
; including its thumbnail. Remote
The [Color management] tab sheet in [Preferences] appears. o , _ . _ _ i
[ g ] [ Iapp The profile is not applied to images displayed in the quick check bty
Select the profile to apply from the [Printing profile] window. _
or [CMYK simulation profile] list box, and click the Moci':g';‘ﬂng:",‘ing
[OK] button. Still Photos
N
Detel settnge of ik e pace Handling
S S RAW Movies
o
s HDR PQ
@ Use the 0S settines Mode
O Monitar prafile
] ., Specifying
CMYK gimulation profile Prefe rences
[~ MNore — -]
——
*Ghanges taks etfect after restarting Ganel @
|
The [Color management] tab sheet in [Preferences] closes. Q



Specifying the Size when Opening RAW Images

This applies only to RAW images with the extension “.CR3” that were
shot with [ cam ] selected on the camera.

This function specifies the image size when a RAW image is selected
and opened in DPP. When the selected RAW image is converted and
saved as a JPEG or TIFF image, it is also saved at the same size. This
function is not available for images shot with the Dual Pixel RAW
function set on the camera.

Select the RAW image » display the Settings tool
palette » select the size when opening RAW images
in DPP.

Settings tool palette

Toal palette

Settings...

5 n opening RAW images
Criginal zize (da not chanee) <

The image size when opening RAW images in DPP is set.

The default setting shows the size set in [Default size when
opening RAW images] in the [Image Processing 2] tab sheet in
[Preferences].

The settings are saved as recipes for each image.
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Displaying and Saving RAW Images

Specify settings for displaying and saving RAW images.

This function allows you to select a [Prioritize speed] mode in addition to

the usual [Prioritize image quality (recommended)] mode.
Only RAW images shot with a supported camera are supported.

Supported Cameras
EOS-1D X Mark Ill, EOS R5, EOS R6

Select a supported image in the main window, etc.

Display the Settings tool palette.

Select the option.

Viewing and saving RAW images

QO Prioritize image quality (recommended)

@ Prioritize speed

After selecting an option, the RAW image is displayed based on

the setting.

The image quality of a converted and saved image is based on

the setting of the selected option.

[Prioritize image quality (recommended)]: an image is displayed

and saved in normal DPP quality.

[Prioritize speed]: sets a shorter time for displaying and saving
RAW images than [Prioritize image quality (recommended)].

However, some images may be displayed/saved with a
noticeable level of noise.

[Prioritize speed] does not allow “Specifying the Size when
Opening RAW Images” (p.93) to be used.
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JPEG/TIFF

Saving Editing Results

Saving Editing Contents to an Image

All the contents adjusted with the tool palette (recipe) can be saved to
the image or saved as a separate image.

Select the [File] menu » desired item.

Saving as a separate image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

If a JPEG or TIFF image is saved as described below, the image can be
saved as a separate image with the adjustments (recipe) applied to it.
The image is saved as a separate image, so the original image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

The [Convert and save] window appears.

Specify the necessary settings, and then click the

[Save] button.

By default, the image is converted and saved to a JPEG image
with the highest image quality, without changing the image size.
Change the settings according to your requirements.

Close window Ctrl+W
Save Ctrl+5
Save As... Ctrl+Shift+5
Convert and save... Ctrl+D
Batch process... Ctrl+B
Save still image frem movie... Ctrl+Shift+D
Save still image from RAW movie...  Ctrl+Shift+]
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Print contact sheets Alt+Shift+P
Plug-in printing

Add to collection Ctrl+G
Remove frem cellection Ctrl+Shift+G
Clear collection

Select collection

Delete collection

Bookmark

Remove bookmark

Move te Recycle Bin Del
Exit Alt+F4

Your adjustments are saved to the image.

& Convert and save E
save infl ||} oo 02 v @ F e Er
= — Select the save
ST IMG_0001 . .
destination
=
Libraries
LY
This PC
(.; Abgema TENI v [ e |J— C“Ck and save
S T TIFF 16bit + Exif-JPEG (<TIF, %JPG) v
Qutput setting .
. Enter a file name
Output resolution 350 dpi and SeleCt an
[ Resize o H
Width Heieht Image type
572 % 3648 (5472 pixel x 9648 pixel) Unit [pixel
Embed ICC profils
Shootine info setting  Inclde all shooting info

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.
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:@3 To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, saving the image as a separate file (p.95)
is recommended.

@ By saving as a separate JPEG or TIFF image as explained
above, some image deterioration that accompanies editing/saving
occurs as when editing with general image editing software.

By saving as explained above, a timmed image (p.71) or dust-
erased image (p.86 to p.90) actually becomes a trimmed image
or dust-erased image.

You can batch convert and save multiple images (p.139).
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.45 to p.91), so the “original image data itself’
remains unaffected. (The trimming range or dust-erasure information of
a cropped image (p.71) or dust-erased image (p.86 to p.90) is simply
saved to the image.)

For this reason, you can undo any adjustments saved (p.95) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Rotate Left Ctrl+L
Rotate Right Ctrl+R

Apply Dust Delete Data

Work color space »

Revert to last saved settings  Ctrl+Alt+Z
Revert to shot settings Ctrl+Shift+Z

The image reverts to the conditions of the selected item.
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.dr4”) and loaded and
applied to another image.

You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

"JPEG, TIFF image data |
Image processing conditions information

, . RAW i lmage data:
Image processmg conditions information

I \N
L.drd ]

Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.dr4”).

A recipe file with contents that can only be adjusted in RAW
images are not reflected even if it is applied to a JPEG or TIFF
image.

Recipes are not compatible between DPP version 4.x and DPP
version 1.x to 3.x. Images with DPP version 1.x to 3.x recipe files
attached are displayed with the shot settings in DPP version 4.x.
Conversely, images with DPP version 4.x recipe files attached are
displayed with the shot settings in DPP version 1.x to 3.x.
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Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image.

Select the image with the recipe you want to copy.

To copy all items of a recipe, select the [Edit] menu »
[Copy recipe]. To copy only selected items of a
recipe, select the [Edit] menu » [Copy selected
recipe].
The recipe is copied.
To select recipe items, select the [Edit] menu P [Select and copy
recipe settings] and select items in the window that appears.
After specifying settings, click the [OK] button and close the
window.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe].
The recipe is applied to the image.

@ You cannot copy or apply RAW movie recipes.

@ When a recipe for an image is copied and applied to an image in a
different orientation, the image orientation also changes. To prevent
the orientation of the image from changing, select the [Edit] menu »
[Select and copy recipe settings] and remove the check mark from
the [Rotate left / Rotate right: 0°] checkbox in the window that
appears.

Saving a Recipe as a File

Select an edited image, and then select the [Edit]
menu » [Save recipe in file].

The [Save recipe in file] dialog box appears.

To save all of a recipe, select the [Save all recipes] option in the
window displayed.

To select and save recipe settings, select the [Save selected
recipes] option in the window displayed and then click the
[Specify Recipe Details] button. In the window displayed,
checkmark the recipe settings to be saved and then click the
[OK] button.

Select the destination folder, enter a file name, and
then click the [Save] button.
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Loading and Applying Recipes

Select the image to which a recipe is to be applied,
and then select the [Edit] menu » [Read and paste
recipe from file].

The [Open] dialog box appears.

Select a recipe and click the [Open] button.
The recipe is applied to the image.
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JPEG/TIFF

Adjusting by Comparing Multiple Images

You can synchronize the areas in different images to be displayed
among multiple preview windows, and adjust images while comparing
them.

In the preview window, display the multiple images
to be compared.

Align the images.
Select the [Window] menu » [Arrange horizontally] or [Arrange
vertically].
The preview windows are aligned.

Select the [Preview] menu » [Sync preview position]
and [Sync preview display size].

Enlarge the image.
Enlarge and display any of the preview windows.

Other preview windows will also be displayed in the same
position/enlargement ratio.

Move the area to be displayed.
If you move the enlargement display area in one of the preview
windows, the enlargement display area will also change in all
other preview windows.
To cancel synchronization, select the [Preview] menu » [Sync
preview position] and [Sync preview display size] again.

@ Synchronization only applies to the enlargement display position
and the enlargement ratio. Adjustments to the images are not

synchronized.
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Editing Efficiently

Editing in the Edit Image Window

The thumbnail display and the preview window are combined, and
images can be edited efficiently while quickly switching between images
to be edited. Select the images to be edited beforehand in the main
window.

Edit the image.

In the main window, select the images you want to
edit.

Switch to the edit image window.

@ Digital Photo Professional 4 - [Folder: C:\Users\xood Desktop\xoooo_03]

File Edit View Thumbpails Preview Label Adjustment Tools Window Help

Edit Irmage ck Remote Shooting

Filter ON OFF o'

Click

The main window switches to the edit image window.
Edit image window Change the display magnification

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

For information on icons displayed on the frame of a thumbnail,
see “Image Frame Information in the Main Window and Edit
Image Window” (p.184).

The tool palettes, navigator palette, and histogram palette are
displayed and you can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.
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Click the area you want to enlarge.

Click

The area you clicked is enlarged to 100% (actual pixel size).
To change the display area, drag on the image or drag the
enlargement display area (p.19) of the navigator palette.
Click again to revert to the full view ([Fit to window]).

To return to the main window, click the [] button on the
toolbar.

@ With the edit image window, you can only select images from a
folder. To gather images from several folders for editing, see
“Gathering and Editing Images in the Collection Window” (p.104).

Changing the Thumbnail Display Position to Horizontal

Select the [View] menu » [Horizontal Thumbnails].

If you select [Vertical Thumbnails], the thumbnail display reverts
to the vertical position.
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Gathering and Editing Images in the Collection Window

You can gather selected images together in Collection folders for
viewing, comparison and editing.

You can gather images from several folders as well as from a single
folder, allowing you to work with them efficiently.

Click [+ Add collection] in the [Collection] area in the
main window.

@ 15016 o W

[ R IMG_0019.CR2 [ R ] IMG_0i

Guollection

A new collection folder is created in the [Collection] area.
Enter a name for the collection folder.

To create additional collection folders, repeat the operation. Up to
20 folders can be created.

Select the [File] Menu » [Select collection], and
select a collection folder to gather images from the
collection folder names displayed.

Select images or image folders in the main window.
Select the [File] menu » [Add to collection].

The images are added to the selected collection folder, and the
number of selected images in the collection folder is displayed.
When an image set to single-image display (p.23) is added, the
number of images is indicated as two images.

You can also add images to a collection folder by selecting
images and folders and then selecting [Add to collection] from
the menu that appears when you right-click the mouse.

Select a collection folder in the [Collection] area.

Caollection

B3 0001(35)

Images in the selected folder are displayed.
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Check the displayed images.

Edit the images.

Edit the displayed images.
Displayed images are retained in the collection folders even after
exiting DPP.

- To remove images from collection folders

Removing selected images

Select images in a collection folder, select images, and select
[Remove from collection] in the [File] menu. (You can also remove
images from a collection folder by selecting the images, right-clicking
with the mouse, and selecting [Remove from collection] from the
menu that appears.) Note that even if you remove an image from a
collection folder, the original image remains unaffected.

Removing all images

Select [Clear collection] in the [File] menu. Note that even if you
remove all images from a collection folder, the original images remain
unaffected.

Deleting a collection folder

Select a collection folder in the collection area, then select [Delete
collection] from the menu that appears when you right-click with the
mouse. Note that if you delete a collection folder, the original images
remain unaffected.

Modifications to the image are applied to the original image
Modifications made to images in a collection folder are all applied to
the original image.
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Compositing Images
You can combine two images into a single image. You can further
combine images by adding another image to the composited image.

Since the composited image is saved as a separate image, the original
images remain as they are.

@ This function can be used with all image types (p.4) supported by
DPP.

The color space of a composited image will be the color space of
the background image.
Image information is not appended to a composited image.

Select a background image in the main window.

L] % v W@ + B

You can also select a background image from the edit image
window or [Collection] window.

Select the [Tools] menu P [Start Compositing tool].
The compositing tool window appears.

C\Users\sooood\Pictures\ioosod IMG_0001.CR2 [5760 x3840] = E

>
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Select the image to combine.
Select the image to combine from the [Foreground Image] list

box.
-

100%0 view

Foreground Image

IMG_0001.CR2 L

Select an image
IMG_0001.CR2
IMG 0002.CR2
IMG_0003.CR2
IMG_0004.CR2

Composite Method

The selected image is displayed in the [Foreground Image]

thumbnail display.

A preview of the combined background image and [Foreground

Image] is displayed in the composite preview.

The following images can be combined.

* When a background image is selected in the main window:
images in same folder as background image

* When a background image is selected in the [Collection]
window: images in the [Collection] window

* When a background image is selected in the edit image
window: images displayed in the thumbnail display area

You can also combine images of different sizes.

Select a compositing method.

Select a compositing method from the [Composite Method] list

box.
m—

100%% view

Foreground Image

IMG_0002.CR2 W

Position

The compositing method selected in the composite preview is
applied.

The compositing method can be selected from five types: Add,
Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.109).

If you select [Weighted], you can set the proportion of the image
to be combined. Use the [Weight] slider at the bottom of the
[Composite Method] list box or directly enter a value to set the
proportion.

By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).
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Position the images.

@ C:\Users\wooood\Pictures\oooo\IMG_0001.CR2 [5760 x3840]

o |

Composite
Weighted

Compose in RAW Format

Weight

Position

100% view

Foreground Image

IMG_0002.CR2

Method

50.0 =

Shift large amount (50 pixels)

2
- Shift small amount (1 pixel)
WD m
j Align image centers
x o vpb  H|——— Youcan also directly enter the position
Conte coordinates of the [Foreground Image]
Sove Ao to align it.

Close

By default, the background image and the [Foreground Image] are
displayed with their centers aligned.

[Compose in RAW Format]

Checkmark the [Compose in RAW Format] checkbox as necessary.

You can set [Compose in RAW Format] under the following

conditions.

Both the background image and [Foreground Image] are RAW

images, and all the following conditions are met.

» The cameras used to shoot were of the same model

» The ISO speed setting at the time of shooting was the same

» The highlight tone priority setting at the time of shooting was
the same

» The image sizes (original size) are the same

The following functions are not available for images composited
with [Compose in RAW Format].

 Auto Lighting Optimizer (p.58)

* Picture Style Auto (automatically set to Standard) (p.49)
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Click the [Save As] button.

Position

"

4

“

Continue

Save As...

Close

Specify the required settings in the window that appears and then
click the [Save] button.

By clicking the [Continue] button, images are combined to create
a new background image, and you can continue by combining
another image.

To finish, click the [Close] button.

Compositing Methods

Add

The background image and [Foreground Image] are added and
images are combined.

Average

The background image and the [Foreground Image] are combined in
proportions of 50% each.

If you want to change the proportion of the [Foreground Image], select
[Weighted].

Weighted

Set the proportion of the [Foreground Image] and then combine the
background image and [Foreground Image].

Lighten

The background image and the [Foreground Image] are compared,
with only brighter portions of the [Foreground Image] being combined.
Darken

The background image and the [Foreground Image] are compared,
with only darker portions of the [Foreground Image] being combined.

@ You can display this function as a function button in the main

window’s toolbar (p.127).
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Creating HDR (High Dynamic Range) Images

You can create images with a wide dynamic range where clipping in Select the [Tools] menu » [Start HDR tool].
highlights and shadows has been reduced, and images that appear like The [Select Images] window appears.

paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different
exposures for the same scene (negative exposure, standard exposure,

You can also display the [Select Images] window from the edit
window and edit image window.

positive exposure) to create an HDR image. However, you can also Specify the required settings, then click the [Start
create an HDR image from two images, or even only one. HDR] button.
Since an HDR image is saved as a separate image, the original images = T

=] Select Images

remain as they are.
* HDR stands for High Dynamic Range.

@ This function can be used with all image types (p.4) supported by
DPP except HEIF images.
Image information is not appended to an HDR image.

IMG_0001.CR2 IMG_0002.CR2 IMG_0003.CR2

Select an image in the main window.

[] Auto Align

Close

To change the selected image or add another image, click the
[Browse] button, and in the [Open] dialog box that appears,
select the image file and click the [Open] button.

If you select two images of the same size, you can checkmark
the [Auto Align] checkbox for auto image alignment. However,
auto image alignment may not work properly with repetitive
patterns (lattice, stripes, etc.) or flat, single-tone images.

By clicking the [Start HDR] button, the [Adjust Image] window
appears.

@ After using auto image alignment, the periphery of the images is
partially deleted.
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Make required selections to adjust the image.
(. Adjust Image = E'

Presets

Natural v

Tone/Color

Brightness:(50)

Saturation:(50)

Contrast:(30)

Detall Enhancement
Strength:(0)

Smoothness:(0)

IMG_0001.CR2 / IMG_D002.CR2 | IMG_0003.CR2

Sliders in [Adjust Image] window
[Tone/Color]

[Brightness]: Adjusts the overall brightness of the image. Move
the slider to the right to brighten the image, and to
the left to darken the image.

[Saturation]: Adjusts the overall color saturation of the image.
Move the slider to the right to make the color
deeper, and to the left to make the color weaker.

[Contrast]: Adjusts the overall contrast of the image. Move
the slider to the right to make contrast stronger
and to the left to make contrast weaker.

[Detail Enhancement]

[Strength]:

Adjusts the overall contrast and contrast of
details together. Move the slider to the right for a
stronger effect.

[Smoothness]: Adjusts the overall smoothness of the image.

[Fineness]:

Move the slider to the right for a smooth and
natural impression.

Adjusts the clearness of details. Move the slider
to the right for a sharper outline.

[Presets] and finishing effects

With [Presets], you can select from the five preset finishing
effects below from a pulldown menu ([Natural] is selected by
default), instead of operating the sliders individually. By selecting
a finishing effect, each slider moves according to the setting. You
can also operate and adjust the sliders after selecting an effect.

[Naturall:

[Art standard]:

[Art vivid]:
[Art bold]:

[Art embossed]:

In high-contrast scenes, rendering in areas
where highlights or shadows are usually clipped
is corrected, for a finish with reduced highlight
and shadow clipping.

Gives a finish with painting-like tonality for an
impressive image.

For a more vivid look than with [Art standard].
For a more vivid look than with [Art standard],
that makes the subject pop out.

Tones down vividness more than [Art standard],
for an old-fashioned feel.
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Click the [Save As] button.

Fineness; (0}

Save As...

Close

Specify the required settings in the window that appears by
clicking the [Save As] button and click the [Save] button.

@ You can display this function as a function button in the main
window’s toolbar (p.127).
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Using the Dual Pixel RAW Optimizer

By setting the Dual Pixel RAW function on the camera compatible with
the function before shooting RAW images, images are recorded as
“special RAW images (Dual Pixel RAW images)” with dual pixel
information appended from the imaging sensor. This is called Dual Pixel
RAW shooting. Using this function, the [Dual Pixel RAW Optimizer], with
Dual Pixel RAW images, you can make use of the Dual Pixel data
recorded with the Dual Pixel RAW image for microadjustment of the
position of maximum sharpness and resolution using the depth
information contained within the file, repositioning the viewpoint or
foreground bokeh for a more pleasing result, and reducing the
appearance of ghosting in images.

® Cautions for Dual Pixel RAW shooting
Note the following when shooting in Dual Pixel RAW.
Common to all functions
« Effects are most easily gained when the lens aperture value is
/5.6 or lower.
« Effects may be different between shooting in vertical orientation
and horizontal orientation.
* It is recommended that the ISO speed be ISO 1600 or lower.
Only for “Microadjustment of the position of maximum sharpness
and resolution using the depth information contained within the
Dual Pixel RAW file”
* It is recommended that the lens focal length be at least 50 mm.
* It is recommended that this function be used when the camera
is at a distance from the subject.”
* Use the following as a guide to subject distances according to
focal length.
When the lens focal length is 50 mm, the subject distance
should be approx. 1 m-10m/ 3.3 ft. - 32.8 ft.
When the lens focal length is 100 mm, the subject distance
should be approx. 2 m-20 m /6.6 ft. - 65.6 ft.
When the lens focal length is 200 mm, the subject distance
should be approx. 4 m-40m/13.1 ft. - 131.2 ft.

@ You can display this function as a function button in the main
window’s toolbar (p.127).

Microadjustment of the Position of Maximum
Sharpness and Resolution Using the Depth
Information Contained within the Dual Pixel RAW File

Microadjust the position of maximum sharpness and resolution, using the
depth information contained within the Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

LY C\Users\user\Pictures\xoo0odIMG_0010.CR2 [6720 x 4480] = = “

Checkmark the [Image Microadjustment] checkbox.
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Adjust the image.

& C\Users\user\Pictures\oooed\ IMG_0010.CR2 [6720 x 4480]

Use the slider to adjust the resolution based on depth information
and the level of resolution.

Click the [OK] button.

Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.95).

If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.

This function cannot be used at the same time as “Reposition the
viewpoint or foreground bokeh for a more pleasing result” or
“Reduces the appearance of ghosting in images”.

Reposition the Viewpoint or Foreground
Bokeh for a More Pleasing Result

Reposition the viewpoint or foreground bokeh for a more pleasing result,
using the dual pixel information recorded in Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.
Checkmark the [Bokeh Shift] checkbox.

Specify the area to adjust.

Ci\Users\user\Pictures\poo0od\IMG_0020.CR2 [6720 x 4480] ~clEl|

»

Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.

You can also remove the check mark from the [Show borders]
checkbox to hide the border.
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Adjust the image.

@ CA\Users\user\Pictures\xooood IMG_0020.CR2 [6720 x 4480] o B “

Use the slider to adjust the viewpoint.

Click the [OK] button.
Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.95).

If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.

Resolution may expand in the depth direction according to the
level of adjustment.

If the border of the selected area in the image appears unnatural,
lower the level of adjustment.

This function cannot be used at the same time as
“Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file” or “Reduces the appearance of ghosting in
images”.

Reduces the Appearance of Ghosting in Images

Reduce the appearance of ghosting in images, using the dual pixel
information in Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

Checkmark the [Ghosting Reduction] checkbox, and
specify the area.

e

C:\Users\user\Pictures\ioooo\IMG_0030.CR2 (6720 x 4480] = = “

Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.

You can also remove the check mark from the [Show borders]
checkbox to hide the border.

Any ghosting and flare in the specified area is reduced.
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Click the [OK] button.

Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.95).

There may be cases where the subject's outline and any bokeh
look unnatural, or where an increase in noise or noticeable
changes in hue or brightness occur.

There may be cases where the border of the selected area in the
image looks unnatural.

This function cannot be used at the same time as
“Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file” or “Reposition the viewpoint or foreground bokeh
for a more pleasing result”.
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Using Depth Compositing

Depth compositing generates a single image from several images that is
in focus over a wide area. This function combines images with the Depth
Compositing tool, and outputs the combined result as a depth composite
image. It is then possible to also correct the output image using the
Depth Compositing Editing tool.

This function can also be used with images shot without using focus
bracketing on the camera.

See “Cautions when shooting images for depth compositing” (p.118)
and “Cautions for using depth compositing” (p.119).

Supported Images

« JPEG, TIFF images ':
All cameras compatible with DPP
* RAW images:

Cameras EOS 5D Mark IV, EOS R5, EOS R6, EOS R, EOS
Ra, EOS RP, EOS 90D, EOS M6 Mark II,
PowerShot G5 X Mark Il, PowerShot G7 X Mark Il

Loy RF, EF, and EF-S lens groups (excluding TS-E lenses

and fisheye lenses)

Supported *1
formats CR2, CR3, JPG, TIFF

The camera, lens, shutter speed, aperture value,
focal length, image format, and image size must be
the same.

Shooting
conditions

TTIFF images converted and saved in DPP

Even if the above conditions are met, the following images are not
supported by depth compositing.

* RAW images created by multiple-exposure shooting

» Images without shooting information

* Images saved as HDR PQ mode display images

* Images of 1600 x 1600 pixels or less, or 9999 x 6666 pixels or more

Using the Depth Compositing Tool
Select multiple images in the main window, etc.

For images shot using focus bracketing on the camera, you can
perform depth compositing even if you select only one image.
Select the [Tools] menu » [Depth Compositing] »

[Start depth compositing tool].
The Depth Compositing tool window appears.
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Downloading
Images

Adjust and set items as necessary, and then click the
[Execute] button.

5 cautions when shooting images for depth .
compositing fragas

Depth Compesiting X After performing depth compositing, the combined result may

Perforning ceoth compositin from 10 images. have a narrower gngle of view thgn when irr.1ages' were .shot. Sorting
When shooting with focus bracketing, shooting with a wider angle Images

Amaunt of bokeh - (0) v of view is recommended. After depth compositing, you can crop

Specify larger values for subjects with significant bokeh.

‘Weighted toward nearer subjects : (1) '

Specify larger values when nearer and farther subjects overlap.

Smoothness of compositing boundary : (00 ' .
Specify larger values to make the compositing boundary smaoth. ShOOtlng. Printing
Auto brightness adiustment Repeating patterns such as lattice patterns and stripe patterns, or Images
images where the entire screen is flat and lacking contrast may
Output il not be combinable. Processing
B e e o e e e e | When shooting multiple images, start by focusing on the image Ic;?ll'ggvl\’lljnr?ab;;:
— J nearest to you and work progressively farther away. -
* & cource image tolder will be saved in the same folder as the output file. When shooting mUItIpIe images, images where the focus differs
— largely may result in a combined image with uneven focus or that sﬁggfi:\eg
may not be combinable.
Images are combined and a depth composite image is output. Depth compositing assumes that images of still subjects are BT ey
A source image folder (folder name: DPP_DC _...) is output in the being combined. Images shot of moving subjects may not be s g:ving
same folder as the depth composite image. combinable. . ' §till Photos
The source image folder is used to correct the depth composite If multiple subjects are in the screen, images may not be
image with the [Depth Compositing Editing Tool]. combinable dgpendlng on how subjects are arranged, for Handling
To change the output destination or format of a depth composite e e L gl
. . . . The lenses below are recommended.
mage, click the [Browse] button to make the settings in the RF35mm F1.8 MACRO IS STM, RF50mm F1.2 L USM, RF28-
window that appears. 70mm F2 L USM, RF24-105mm F4 L IS USM HDR PQ
[Auto brightness adjustment] suppresses any change in EF16-35mm f/4L IS USM, EF24-70mm f/4L IS USM, EF100mm R
brightness between images used for depth compositing with f/2.8L MACRO IS USM, EF180mm f/3.5L MACRO USM
automatic correction when brightnesses are slightly different. EF-S35mm /2.8 MACRO IS STM, EF-S60mm /2.8 MACRO Specifying
USM, EF-S18-135mm /3.5-5.6 IS USM Preferences

@ You can display this function as a function button in the main

window’s toolbar (p.127).

the image if necessary.

For best results, set the aperture value in a range of f/5.6-11
before shooting.

Be sure to use a tripod and lock the camera firmly in place before

EF-M28mm /3.5 MACRO IS STM, EF-M15-45mm /3.5-6.3 IS

STM, EF-M18-150mm /3.5-6.3 IS STM
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G cautions for using depth compositing

When the Depth Compositing tool is started up, the content of

recipes that are attached to images in focus is reflected in the

depth composite image (excluding the following items).

» Stamp

* Dust delete data

* Reducing color moiré (Partial Adjustment tool palette)

» Angle adjustment (Trimming/Angle Adjustment tool palette)

* Size setting when opening selected RAW image in DPP (p.93)

* Color adjustment for a specific color gamut (including
[Monochrome])

 Dual Pixel RAW Optimizer

* Auto Lighting Optimizer

» Shadows/highlights

The Depth Compositing tool does not start up if an image in focus

is not supported.

Using the Depth Compositing Editing Tool

If intended results were not obtained with the Depth Compositing tool,
this function copies the portion of the image to be corrected from a
source image to the depth composite image (in this tool, the [Edited
Image]).

Select the depth composite image in the main
window, etc.

Select the [Tools] menu » [Depth Compositing] »
[Start depth compositing editing tool].
The Depth Compositing Editing tool window appears.

@ C\Users\User\Desktop\)CO00GXOCENimM\DIC_IMG_XOC0LIPG (DPP_DC_1T) o x

Source Image Edited Image

Zoom in 100% ~

Radius(95)

Blur radiusi 160)

Select a source image

I+ + /10 »> > [ Close |

A thumbnail of the source image is automatically displayed at the
bottom of the screen. However, thumbnails of source images are
not automatically displayed if the name of the depth composite
image or the source image folder is changed or the save location
is moved. Select the source image folder that was output at the
same time the depth composite image was output.
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Select a source image and modify it as necessary.

@ CiAUsers\User\Desktop\XXHOOCCOU mg\DC_IMG_XXXX.JPG (DPP_DC_1) [u]

Source Image Edited Imaee Zoom in 100%

Set Adjustment Area

Radius(35)

v
Elur radiust 160)
)
|4 - Py |
1 |_
Circular cursor
< > Save hs
ey <+ 110 > > Glose

Select a source image from the thumbnails of source images
displayed at the bottom of the screen.

If the [Source Image] and [Edited Image] are shots of different
areas, a black frame may be displayed around the [Source Image].
Clicking the [Set Adjustment Area] button displays a circular cursor.
Click or drag the portion of the [Edited Image] that you want to
correct with the circular cursor, and the same portion of the [Source
Image] is copied.

Use [Radius] to set the size of the adjustment area, and use [Blur
radius] to set blurring at the border of the adjustment area.

You can return through the corrections you made with the

[ [« [ 2 [[21]] buttons. Available buttons, from the left,
are [Undo All], [Undo], [Redo], and [Redo All]. However, if you
changed to another source image, you cannot return through
corrections you made using the source image before the change.
A recipe attached to a depth composite image is not applied in the
[Edited Image] in this function.

Also, depth composite image recipes are not attached to image
files saved with this function.
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Save the image.

[ Save bs.. ]

Cloze

Click the [Save As] button to select and save required settings.
To exit, click the [Close] button.

@ You can display this function as a function button in the main
window’s toolbar (p.127).
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Using the RAW Burst Image Tool

This function can be used with rolls (continuous-shot image files)
captured in RAW burst mode on Canon digital cameras.
A roll is edited, saved, printed, etc. as a single RAW image in DPP,
however, a “representative image”* is selected automatically for this
purpose.
For detailed information on RAW burst mode, refer to the Instruction
Manual included with a RAW burst mode-capable camera.
You can use this tool to do the following:
» Change the representative image in a roll
» Save one image in a roll
» Extract and save any range in a roll
* Representative image: the image displayed in thumbnails, etc.
representing all the images in a roll

Starting Up the RAW Burst Image Tool

1 Select a roll in the main window, etc.

@ Only rolls shot with RAW burst mode on a Canon digital camera
are supported.

(Thumbnail icon: &)

Select the [Tools] menu » [Start RAW Burst Image
tool].

=» The RAW Burst Image Tool window is displayed.
@ To exit, click the [Close] button.

@y CAXXX_ XK OO X XXX o X

B | x1| |[100% ~

Use as Rep. Image +F |4~

-
¥
=
¥
[=

Yo dl 1645 e [=Ir}"]

| Cloge

@ You can display this function as a function button in the main
window's toolbar (p.127).
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RAW Burst Image Tool window functions

@) CAXXK XXX XXX [XHXX % XXXX]

Image display area

Set image display
maghnification

Display image at no
magnification

Display image fit to window ——
Lead image marker (p.125)——
Slider (p.124, p.125) ———

L)

Uze az Rep. Imaege

Set lead image in roll after
extracting (p.125)

Move to image before

&

—— Representative image mark
Displayed when
representative image
displayed

—— Set displayed image as
representative image (p.124)

—— Move to representative
image

— Revert to image when
captured

Discard all editing done with
this tool and revert to image
when captured

(p.124, p.125)

Extract and save any range
in aroll (p.125)

Cloge

Save one image in a roll
(p.124)

Number of displayed image
Number of displayed image/
number of allimages inroll are
displayed

Position of representative

image in roll

Set last image in a roll after
extracting (p.125)

Move to image behind
(p.124, p.125)

Last image marker (p.125)
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Cha

nging the Representative Image in a Roll

You can change the representative image to any image in a roll.

Display the RAW Burst Image Tool window.

Perform steps 1 to 2 of “Starting Up the RAW Burst Image Tool”
(p.122).
The RAW Burst Image Tool window is displayed.

Display the image you want to be the representative
image.

w1 s

\ @ r
» [E]

Use as Rep. Image +P -

=¥
B

I Close |

Use the slider or [ JIp_]1and [ _4il_]] buttons to display the
image you want to set as the representative image in the image

display area.
The position of the current representative image is indicated with
a [[F]] mark above the slider.

Change the representative image.

x1| [100% « [ Use as Rep. Image ] +P
A r 4
v » ] A [E])
U 1r
o dll 22/45 13 o

£ Closs i

Click the [Use as Rep. Image] button.

The representative image changes to the currently displayed image.

To revert to the image when captured, click the [[ |« |] button.
To exit, click the [Close] button.

Saving One Image in a Roll

You can extract any one image in a roll and save it.

Display the RAW Burst Image Tool window.

Perform steps 1 to 2 of “Starting Up the RAW Burst Image Tool”
(p.122).
The RAW Burst Image Tool window is displayed.

Display the image you want to save.
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Still Photos
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Preferences

To revert settings to those when captured, click the [[ [« ]
button.
To exit, click the [Close] button.
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Downloading
Images
. . . Set the last image.
Extracting and Saving Any Range in a Roll -

iewing
You can extract any range in a roll and save it as a separate roll. ] Dt ] oo~ Ceclesliepiinaes add I+ Images

: : ® o
Display the RAW Burst Image Tool window. - s Sorting
¥o @ 09/45 T oy 0 Images

Perform steps 1 to 2 of “Starting Up the RAW Burst Image Tool”

(p.122).
The RAW Burst Image Tool window is displayed.

£ Close i

Use the slider or [ |lp_]1and [[ 4|1 buttons to display the : S

Set the lead image.

image you want to set as the last image in the image display

 E—

— — - - area, and then click the [[ oy ] button. Printing
The last image marker ([F]) moves, and the last image in the roll Images
O r ® ' . _ is set.
ad + 2] Processin
W Save the roll. g
=1 a) o @ - — Large Numbers
of RAW Images
9% IR 111" Use az Rep. Image P |4~
l Cloze ;
\ r r SRemote
. . | hooting
Use the slider or lay th »E » @
' [[ 1 ]1and [E] b'uttons. to disp ay the 23
image you want to set as the lead image in the image display o | [ 4l a6/1p i | [ o : :
area, and then click the [[ guo |] button. Motilz)sﬂgr? nggwl/(ing
The lead image marker ( E) moves, and the lead image in the Close Still Photos
roll is set. Specify the necessary settings in the window that appears by
clicking the [| =2 ] button and save the roll. Handling
To revert settings to those when captured, click the [ [« ] RAW Movies
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@ Editing performed with this function is not supported with these

functions: “Copying a Recipe and Applying to Another Image”
(p-99), “Saving a Recipe as a File” (p.99), and “Loading and
Applying Recipes” (p.100).

Editing performed with this function cannot be reverted to the
states in [Revert to shot settings] or [Revert to last saved settings]
in the [Adjustment] tab in the menu even if they are selected.
However, you can press this function's [] button to revert
the image to the captured image.

Even after changing the representative image in a roll with this
function, shooting information for the roll displayed in the main
window, etc. is information for the representative image at the
time of shooting.

Adjustments (recipe) made to a roll in the main window, etc. are
not applied in the window for this function (except for 90° image
rotation).

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Adobe Photoshop.

Select the [Tools] menu P [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, see p.141.

@ Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.185) is added. The ICC profile
contains information about [Preferences] (p.177) or work color
space (p.91) set for each image as described and the appropriate
color information is relayed to Photoshop.
When you exit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred
image as a separate image in Photoshop is recommended.
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Customizing the Main Window Toolbar

You can display buttons for frequently-used functions in the main

window’s toolbar.

You can also change how the buttons are laid out.

Select the [Tools] menu » [Customize toolbar].

The [Configure Toolbar] window appears.

Select functions to display in the toolbar.

Configure Toolbar

Select items to show in the toolbar.

Print

HDR Taol
Dual Pixel RAW Optimizer
Photoshop

Move Up

Mavee Dioven

Cloze

To rearrange buttons, select the function you want to change,
and then click the [Move Up] or [Move Down] button.
After specifying settings, click the [Close] button and close the

window.

The settings are applied to the main window’s toolbar.
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[ ] L] D I d.
Using Cloud Processing *images
It has become possible starting with DPP version 4.12.10 to use the
network service “Canon Cloud Imaging” to process supported images

with higher-performance noise reduction.
This processing is called “Cloud Processing”.

Enabling Cloud Processing Viewing

To use cloud processing, you must first enable it. Images
How to enable cloud processing is described below.

This section explains how to use this function. This function cannot be
used if you select China as your region when installing DPP.

Supported Images
ISO 3200 or higher RAW images shot using an EOS-1DX Mark I

the function. Y
. . . . ] rinting
Requirements for Using this Function Start up [Setup.exe] in the [DCC] folder that appears Images
0S: Windows 10 (1709) or later and install [DPP Cloud Connect]. S
If [DPP Cloud Connect] installation fails, on your PC, navigate to La,;?ﬁﬁf,lﬂ%,s
[Windows Settings]»[Update & Security]®»[For developers] and of RAW Images
select [Sideload apps] from the [Use developer features] menu,
and install again. Remote
After completing installation, return option selections in the [For Shooting
developers] menu to as they were.
Playing Back
Movies and Saving
Restart DPP. Still Photos
[Cloud Box] appears in [Collection] in the main window.
In the main window, etc., select and run [Log in] in Handling
RAW Movies
the [Cloud] menu.
Cloud processing is enabled.
HDRPQ
Mode
Specifying
Preferences

In the main window, etc., select [Enable cloud
processing] in the [Cloud] menu.

Check the contents in the dialog box that appears,
and click the [Agree] button to agree and start using
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@ To use this function, an environment with Internet access
(subscription to a provider and an in-place line connection) is
required.

Internet Service Provider (ISP) connection fees or access point
connection fees may apply.

@ Disabling cloud processing
You can disable cloud processing with the following procedure.
In the main window, etc., select [Disable cloud processing] in the
[Cloud] menu.
Start up the uninstaller, and [DPP Cloud Connect] is
uninstalled.

Start up DPP again.
Cloud processing is disabled.

Cloud Processing and CIP Image Editing

By using cloud processing, a “CIP image” is generated from the original
RAW image. The “CIP image” is an image that has been processed with
higher-performance noise reduction by using the network service
“Canon Cloud Imaging”.

The procedure for cloud processing and editing CIP images is described
here.

Enable cloud processing (p.128).

In the main window, drag the image you want to use
cloud processing to [Cloud Box] in [Collection].

Cloud Bex(9) xx remainin

Cloud Box

Special folder for working with images generated after cloud
processing.

The number of remaining that can be processed currently is
displayed.
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Cloud processing is carried out. As a result of cloud processing,
a CIP image is generated from the RAW image and saved in
[Cloud Box]. The original RAW image is not affected by cloud
processing.

CIP images are displayed with a [mm ] icon in the thumbnail
image.

You can also select an image you want to use cloud processing
and select the [Cloud] menu P> [Process in cloud] to use cloud
processing.

To stop the process during cloud processing, select [Cancel]
from the menu that appears by right-clicking with the mouse. An
image for which cloud processing was stopped is displayed with
a ['] icon in the image’s thumbnail image in [Cloud Box], but you
can continue cloud processing again.

If cloud processing fails, an image is displayed with a ['] icon in
the thumbnail image in [Cloud Box]. Continue cloud processing
again.

You cannot edit [Digital Lens Optimizer], [Diffraction correction],
or [Chromatic aberration] settings for CIP images. It is
recommeded that you complete this editing before using cloud
processing.

You cannot carry out [Cropping], [Stamp], or [Partial adjustments]
during cloud processing.

CIP images cannot be handled with software other than DPP.

Open [Cloud Box], select the CIP image you want to
edit, and edit.

CIP images can be edited in the same way as normal RAW
images.

However, you cannot edit [Digital Lens Optimizer], [Diffraction
correction], [Chromatic aberration], [Compose in RAW Format] in
the compositing tool, or [Size when opening RAW images]
settings.

Using Noise Reduction (Cloud)

[Noise reduction (cloud)] in the Detailed Adjustment tool palette is a
noise reduction function that can be used only with CIP images
generated after cloud processing. How to use this function is described
here.

Open [Cloud Box] in the main window (p.129), and
select an image.

Open the Detailed Adjustment tool palette (p.69).

Checkmark the [Noise reduction (cloud)] checkbox,
and make adjustments.

Moize reduction |4

 S—— - |
Y [

M Reduce color moiré
—_—
Moise reduction ":-'- lew '-4:"

stop increments)

Drag the slider left or right

You can set a noise reduction level from within a range of -4.0 to
4.0.

The larger the setting, the larger the noise reduction effect.

The noise reduction effect can also be checked in the check
window.
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5 Printing Images

Printinganimage ...,
Printing with Shooting Information.........................
Printing a Thumbnail List (Contact Sheet

Printing) ..........
Plug-in printing
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the image to be printed.

Select the [File] menu » [Print].
The printer’s print settings dialog box appears.

Print.
Specify the optimum settings for printing photographs in the
printer’s print settings dialog box and click the [OK] button.
Printing begins.
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Printing with Shooting Information

You can freely layout one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

(3 C:\Users\xood\Desktop\occe: 03\IMG_0001.CR2 x|
Printer | Image | Text SetﬁngsJ
Printer:
fe e et v
Properties. ..
Media: 297.0mm x 210.0mm
A4 v
Media orientation:
() Portrait (@) Landscape
Media type:
Print Quality:
Borderless:
Print profile:
CMYK profile:
CMS settings...
Print Cancel Apply

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [E]] on the [Text] tab sheet
and select the necessary items in the window that appears.

The settings of each tab sheet in step 3 are memorized when printing or

To maintain the settings

the [Apply] button is clicked. The settings can be applied to another
image when printing.

Memorized settings are options in [Printer], [Media], [Media orientation],

[Registration marks], [Header], [Footer], and [Image Information], and
settings in the [Settings] tab sheet.

5

You can set printer profiles (p.178).
If CMYK simulation is set, the image is printed in the set colors.
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.

Select the [File] menu » [Print contact sheets].

Specify the required settings for printing, and then

click the [Print] button.

Switches the settings tab sheet

& Contact sheet “
Frinter | |mage | Text Settings]
Frinter:
HOOCOONK v
Properties...
Media: 210.0mm x 297.0mm
Ad W

Media orientation:
(®) Portrait () Landscape
Media type:

Print Quality:

Borderless:

Print profile:

CMYK profile:

CMS settings...

' Print ' Cancel Apply

Print preview

-Z\@/E To maintain the settings

The settings of each tab sheet in step 3 are memorized when printing or
the [Apply] button is clicked. The settings can also be applied to another
image when printing.

Memorized settings are [Printer], [Media], and [Media orientation], and
settings in the [Image] and [Settings] tab sheets.

@ You can set printer profiles (p.178).
If CMYK simulation has been set, the image is printed in the set
colors (p.177).
By using this function in the edit image window, all images in the
window (not only the selected ones) are printed in a thumbnail
list.
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Plug-in printing
Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for printing
photographs and then print.
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6 Processing Large Numbers of RAW Images

Batch Apply White Balance to Images (Personal

White Balance) ..o 137
Registering Personal White Balance......................... 137
Applying Personal White Balance ...............cccc......... 138

Batch Save as JPEG or TIFF Images (Batch

Processing)....ccccouveeriiiiiiiiiice e 139

Batch Transfer Images to Image Editing Software ......... 141

Batch Change the File Name of Images................ 142
Changing the File Name of Images in the Order in
the Main Window ..........cccuvivieiiiiiiiee e 142
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Personal white balance data for versions before DPP 4 cannot be
applied.

Registering Personal White Balance

Adjust the white balance (p.52, p.53).
To adjust white balance, select a setting other than [ ()] from
the [White balance adjustment] list box (p.51). Registering the
adjustments is not possible if [ [f4( )] is selected.

In the Basic adjustment tool palette, click the
[Register] button.

The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

Register personal white balance H

Register current setting in personal white balance

Save..

? To use the registered personal white balance on another
computer

In step 3, click the [Save] button to write as a file.

Copy the file to another computer.

In DPP on another computer, display the window of step 3.

Click the [Load] button and in the window that appears, select the
copied file.

®You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.
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Applying Personal White Balance

In the main window, select the image to which a
personal white balance is to be applied.

Select the [View] menu » [Tool palette].
The tool palette appears.

Click the personal white balance number button that
is to be applied.

Tool palette

Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.
The images are saved as separate images, so the RAW images remain

unaffected.

In the main window, select multiple images to be

converted.

Select the [File] menu » [Batch process].

The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

IMG_0022GR2
IMG_0023CR2
IMG_0024 GR2
IMG_00255R2
IMG_0026GR2
IMG_00275R2
IMG_0026GR2
IMG_002905R2
IMG_0080GR2
IMG_00315R2
IMG_0082GR2
IMG_00335R2

Shooting info setting Include all shooting info

File name
(®) Gurrent file name

() Mew file name

String Additional string

aonoanat
i
Ex.: IMG_D001.JPG, IMG_0002.JPG
Image transfer settings

[ Open imags using saftware

Convert RAW images only

Batch settings H

IMG_0001CR2 Destination folder
TMG_0002GR2 ®) Same as original files
IMG D00EGR2 -

- ) Lse: this fald
TMG_0004 GR2 — e e oler
IMG_0005GR2 C¥lzers¥user¥Pictures
MG D006 GR [] Greste storage subfolders for each file type
MG 0007 GR2
TG DIDE R Exif-JPEG Subdalder name  IPEG
IMG_000AGR2
TMG 0TGRS Output setting
TMG_00T1 GR2
MG D012 6R2 Save as type Exif-.JFEG (4.IPG) Tmage quality 1
TMG_00130R2
MG 0014GR2 Output resalition 350 dpi
MG D015 GRE
IMG_0017CR2 [ Resize o
TMG_00TBGR2 Width Height
[MG_00190R2 5472) x 364t (5472 pixel x 3648 pixel) Unit | pisel
TMG_D020GR2
MG 0021GR2 Embed ISC profile

Execute Gancsl

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Exit] button appears in the
batch processing dialog box.

In the processing dialog box, click the [Exit] button.

If you have selected [New file name] in [File name], [Sequence
number] has to be set.

By saving as explained above, a trimmed image (p.71) or dust-
erased image (p.86 to p.90) actually becomes a trimmed image
or dust-erased image.

You can also use this function in the editimage window. However,
all images in the window (not only the selected ones) are
converted and saved.
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? Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.95) to edited RAW images.

E\@/E To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, converting and saving images as JPEG
or TIFF images is recommended.

-:@/3 Skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the preview window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike
“Transferring a RAW Image to Photoshop” (p.126), you transfer images
that have first been converted and saved as a separate image, so the
transferred image will not be deleted after exiting the destination
software. The software used here as an example is Adobe Photoshop.

In the main window, select multiple images to be

transferred.

Select the [File] menu » [Batch process].
The [Batch settings] window appears.

Perform settings required for transferring (e.g. file

format).

Checkmark [Open image using software].

IMG_0001GR2
IMG_000205R2
IMG_00035R2
IMG_0004 GR2
IMG_00055R2
IMG_0006 GR2
IMG_0007CR2
IMG_0008CR2
IMG_0009GR2
IMG_00105R2
IMG_0011GR2
IMG_00125R2
IMG_00135R2
IMG_0014 GR2
IMG_0015GR2
IMG_0017 GR2
IMG_0018CR2
IMG_00195R2
IMG_0020 GR2
IMG_0021GR2
IMG_0022GR2
IMG_0023CR2
IMG_0024 GR2
IMG_0025GR2
IMG_00265R2
IMG_0027 GR2
IMG_0028CR2
IMG_00295R2
IMG_0080GR2
IMG_0031GR2
IMG_0032GR2
IMG_0033CR2

Batch settings

Destination folder
®) Same as original files
() Use this folder
C¥lUsers¥userfPictures

[ Greate storage subfolders for sach file typs

Exif-JPEG Subfolder name  JPEG
Qutput setting
Save as type Exif-JPEG (x JPG)
Output resolution 360 | dpi
[] Resize v
Width Height

472 x 3648 (6472 pixel x 3648 pixel)
Embed IGC profile

Shooting infa setting  Include all shooting info

File name
(®) Current file name
) New file name
String Additional string
nonoonat

v
Ex.: IMG_0001.JPG, IMG_0002.PG
Image transfer settines

[] Open image using software

Convert RAW images only

Image quality 10

Unit | pixel

Execute Cancel

The [Open] dialog box appears.

Select Photoshop.
In the [Open] dialog box, select a Photoshop file or a shortcut
and click the [Open] button.
The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop.

Click the [Execute] button.
The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop starts up
and transferred images are displayed in transferred order.

To reset the transfer destination to another software, click the
[Browse] button in [Image transfer settings], and in the [Open]
dialog that appears, select the software and click the [Open]
button.

You can also use this function in the edit image window. However,
all images in the window (not only the selected ones) are
transferred.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings and click the [Execute]
button.

a C\Users\ood\ Desktop\aooae_03\ -0

File name Extension
DPP v || Shooting Date/Time v || Sequence number v | Do not change v
Basic Settings Format settings
Sort Sequence number
®) Fit to main window 0001 []Save sequence number
") File name

Shooting Date/Time
Shooting Date/Time

Year Month Day v

Same file name for RAW +IPEG images
YY-MM-DD v

[[] copy and Rename
Insert underbar
Users\xood Pictures

Original File Name Modified Fie Name
IMG_0001.CR2 ~ DPP_12-08-08_0001.CR2
IMG_0001.JPG DPP_12-08-08_0001.JPG
IMG_0002.CR2 DPP_12-06-23_0002.CR2
IMG_0003.CR2 DPP_12-08-09_0003.CR2
IMG_0004.CR2 » DPP_12-08-10_0004.CR2
IMG_0005.CR2 DPP_12-08-10_0005.CR2
IMG_0006.CR2 DPP_12-08-12_0006.CR2
IMG_0007.CR2 DPP_12-08-12_0007.CR2
IMG_0008.CR2 . DPP_12-08-12_0008.CR2

( Execute Cancel

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text appears in [Modified File Name], the file name is
duplicated. Changes cannot be made if even one file name is
duplicated. Change the settings so that duplication does not occur.

@ You can change the file name of only one image in the main
window by selecting the thumbnail, right-clicking with the mouse,
and selecting [Rename] from the menu that appears.

You cannot start up the rename tool from the [Collection] window
(p.104). You also cannot change the file name of one image.

Changing the File Name of Images in the
Order in the Main Window

When you change the order of the images in the main window, you can
change in one operation the names of the files for the images, in the
order they were rearranged.

Change the order of the images in the main window
(p-36).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].

Select [Fit to main window].

@ C:\Users\xxx\Desk|

File name
DPp v | Shooting Date/Time

Basic Settings

Sort

(@) Fit to main window

(_) File name

(_) Shooting Date/Time

Specify the required settings.
To copy an image, checkmark [Copy and Rename].

Click the [Execute] button.
The file names are changed and the order in the main window is
maintained.
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7 Remote Shooting

Remote Shooting.........ccoooviiiiiiiii
Registering Click White Balance in the Camera
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i D loadi
Remote Shooting ounloading
To save to the currently selected folder, select [Current Folder].

You can perform remote shooting by using “EOS Utility” which enables — _
To create a new folder for saving images, select [Use this folder],

communication with a camera in combination.

i o Viewin

For remote shooting, “EOS Utility Ver. 3.x" must be installed on your click the [Selec.t] bgtton, then select the destination and enter a Imageg
computer. For information on cameras compatible with “EOS Utility Ver. name for [Destination folder]. —
3.x, refer to “EOS Utility Ver. 3.x Instruction Manual” (electronic manual After specifying settings, click the [OK] button. -
in PDF format). The remote shooting window appears. Ir:ag;gg

Click the [Remote Shooting] button on the toolbar in

. . Editing
the main window. Images

@ Digital Photo Professional 4 - [Folder: C:\Users\xood Desktop\xoooo_03]

File Edit View Thumbpails Preview Label Adjustment Tools Window Help Printing
Images
Edit Irmage Cluick Check Remote Shooting
—_—
Folder ey ON | OoF | d Processing
> ) Large Numbers
=[] Desktop of RAW Images

7 &3 This PC

Remote shooting setting window appears.

 E—

Set the [Destination] in the Specify Remote Shooting Playing Back
Folder window. Movies and Saving
Still Photos
S ——
Specify Remote Shooting Folder “
Deztination Rxlvavnsl"ng
() Gurrent Folder ovies
C¥Uzers¥onnodooond oo
(®) Use this folder HDR PQ
C¥Uzers¥ooondnnoa Select.. Mode
Destination falder
Mew folder 1
Specifying
File hlaz Preferences
rDo rot modify ] Settings.. —
Cancel @ @

©
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@ You can change the [File Name] for Specify Remote Shooting
Folder window.
(If [Do not modify] is selected, images are saved with the file names
set on the camera.)

Click the [Settings] button to display the Set file name for captured
image window.

Set file name for captured image E

Do not modify W
File Prefix Customize...

IMG

Aszign Sequence No.
Mumber of Digits 4
Start 1

Shooting Date Format | Day Month Year v Delimiter |Underline w

DD-MM-YYYY v

[ OK ] Cancel

Select a naming rule for image file names from the list box.

You can click the [Customize] button and customize naming rules

for file names.
You can individually set prefix characters, number of digits for
serial numbers, and the start number for file names.
If you are using the shooting date in file names, you can specify
the date format (order and style for year-month-date) and
dividing characters on the Set file name for captured image
window.

After specifying settings, click the [OK] button.
The Set file name for captured image window closes.
After clicking the [Remote Shooting] button, you can click the
[m] button at the bottom right of the main window to show/
hide the [Camera Control] palette.

You can perform shooting while checking the image by switching

the window to multi-layout.

Connect a camera and a computer, and turn on the

camera’s power.

Click the [Live View] button.

Camera
EQS WK

1750 F4.0 150400

ination :

zubfolder

Live View window of “EOS Utility” appears.
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Downloading
Images

Specify the required settings. Specify the required settings. T —

_ i Viewin
S Remote Live View window - - @ EOS XXX = = Imagesg

S

WhiteBalance

[alad

Lv_ClickivB

— Sorting
. < Images

[_‘l. [ J

Apply to shot images

' A Editin
[ ) [ L | Imageg
‘ [_‘ k 4 [ J
Printing
oW 45 | 17| L & Images
Pic St ard
Processing
Large Numbers
of RAW Images
——

Cl-lcL ol ol o |

Live View shoot. .

For detailed instructions on setting procedures, refer to “EOS

Utility Instruction Manual” (PDF electronic manual).  — — Playing Back
y ( ) Movies and Saving
Click the [Settings] button. Still Photos
For detailed instructions on setting procedures, refer to “EOS
a Control il i ” H Handling
Utility Instruction Manual” (PDF electronic manual). RAW-Mavies
:
1/50 F40 150400 Take the picture.
HDRPQ
Mode
——
1750 F40 IS0400 S pe ci fyi ng
Preferences
N —
Create subfolder
00
Re: dto:
@
0

The capture window of “EOS Ultility” appears. 146



The shot image is displayed.

The shot image will be saved in the folder created in step 2.

The images in the folder mentioned above will be displayed in

the thumbnail display area.

You can also create a sub-folder in the folder mentioned above to

save images. To create a sub-folder, click the [Create subfolder]

button on the remote shooting window, enter [Folder name] on

the screen appeared, then click the [OK] button.

Press the [l ] button to display DPP and EOS Utility windows

uniformly in line.

» Supported with EOS Utility version 3.8 and later.

* If you are using multiple monitors, DPP’s main window and
EOS Utility’s remote window can only be lined up uniformly
when on the same monitor.

@Do not exit “EOS Utility” when remote shooting is being set or

5

performed.

In the cases below, perform shooting with EOS Utility.

* You want to autofocus with EOS Utility’s shoot button

* You want to perform continuous shooting

You can perform shooting while comparing the shot image with a
pinned image by pinning an image (p.21). This is convenient for
image selection.

Registering Click White Balance in the Camera

During remote shooting, you can register click white balance to the
connected camera. To use this function, EOS Utility version 3.4.20 or
later must be installed on your computer.

This function is not available on EOS M series cameras other than the
EOS M50 Mark Il, EOS M50, or PowerShot cameras.

Display the shot image to be used as the standard
for white balance.

This function supports only RAW images with a “©.CR2” or “.CR3”
extension.

Select the destination where to register click white
balance.

L=l
EQi5 KK

1750 F40 IS0400

subfolder

Reeistered to :

A0

Select the destination where to register white balance from the
[Registered to] list box. Options in the list box depend on the
camera model.
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Select a point that is to be the standard for white
balance in the shot image, and register the white
balance in the camera.

era

EQi5 KK

1750 F40 150400

iIder

leg red o
Pad o]

=

Click the [[EZT=M] button, and in the displayed image in step 1,
click on a point that is to be the standard for white balance with
the mouse.

The white balance is registered to the destination selected in
step 2, and applied to displayed images.

Click [[IEZI=H] again to exit the function.
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Playing Back Movies and Saving Still Photos

Playing Back Movies and Saving Still Photos

150
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Playing Back Movies and Saving Still Photos

In systems running Windows 8.1 or later, you can use DPP to play back MOV or MP4 movies shot using a supported camera and save still photos from
the movies as JPEG or TIFF images. To use this function, [Play with Digital Photo Professional 4] must be selected in [Movie file playback] in the
[General Settings] tab sheet in [Preferences].

Note that you cannot edit MOV or MP4 movies in DPP. For details on playing back RAW movies and saving still photos, see “Working with RAW
Movies” (p.154).

Double-click the movie thumbnail in the main window (thumbnail layout).

R TR

JRGB (

The preview window appears.
If the preview control panel does not appear, select the [Preview] menu P [Preview control panel].
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Use the preview control panel for each operation.

(1)

(2)

()

(4)
()

(6)

(10) Save as still photo

(4) Show playback time

(5) Frame position slider

(6) Frame no./Total frames

(2) Next frame

(1) Play/pause

(3) Previous frame

Play/pause
Play and pause the selected movie.

Next frame
Move forward one frame. When movie playback is paused,

this allows you to advance the movie one frame at a time.

Previous frame
Move back one frame. When movie playback is paused,
this allows you to rewind the movie one frame at a time.

Show playback time
Shows the playback time.

Frame position slider
By dragging the slider left or right, you can move the
playback position while a movie is playing or paused.

Frame no./Total frames
Shows the current frame number in the movie being
played back or shown and the total number of frames.

(7

(8)

9

(7) Mute/unmute
(8) Volume slider
(9) Viewing LUT on/off

Mute/unmute
Turns audio output on or off.

Volume slider
Drag the slider left or right to adjust the volume for the
movie being played back.

Viewing LUT on/off

Enables or disables Viewing LUT for movies shot with
Canon Log specified.

This setting can also be changed during movie playback.

(10) Save as still photo

Allows you to capture a still photo of the movie frame
currently being displayed.

When you click the button, the [Convert and save] window
(p.95) appears. Specify the necessary settings, and then
click the [Save] button to save the image.

Note that you cannot save a still photo while the movie is
playing back. Pause the movie and then save the still
photo.

If the preview control panel does not appear, select the [Preview] menu P [Preview control panel].
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@ MP4 movies shot with Canon Log are converted to sSRGB color

space before being displayed and saved.
You can play back MP4 movies that have [HDR PQ] set to [On]
with HDR PQ. To display movies in HDR PQ, your computer

system must meet the “System Requirements for HDR PQ Mode”.

On a system where display in HDR PQ is not possible, a movie is
displayed in SDR based on the [HDR assist display (movies)]
(p.179) setting in [Preferences].

Only HEIF format can be selected for saving still photos (p.172).
On some supported cameras, shooting a movie generates a
“THM” file that is saved together with the movie file.The “. THM”
file has the same image number as the movie file and records the
shooting information. In DPP, the movie file and “. THM” file must
be stored in the same folder when the movie is played back.

You can also play back movies in the following windows:

* Main window (multi-layout)

+ Edit image window

* Remote shooting window (multi-layout)

* Multi-function preview window

In Preferences, you can change the movie playback application

to that used by your computer’'s OS or to EOS MOVIE Utility.
(p.174)

For information on EOS MOVIE Utility, refer to the EOS MOVIE
Utility Instruction Manual.
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Working with RAW Movies

Users can work with the RAW movie (extension: .CRM) format in DPP
version 4.12.0. RAW movies can be handled as either movies or still
photos in DPP.

As a movie, they can be played back and edited using the RAW movie
tool.

As a still photo, they can be handled as a RAW image file in the same
way as CR2/CR3. However, RAW movies shot with a camera having
Canon Log set ON are developed with Canon Log OFF.

DPP supports RAW movies shot only with a supported camera. RAW
movies shot with a camera having Canon Log 3 set ON are not
supported.

This section explains how to work with RAW movies.

Supported Cameras
EOS-1D X Mark Ill, EOS R5

Changing the Image Displayed for a RAW Movie

You can change the image displayed for a RAW movie file to any frame
within the file.

While you can edit, save, print, etc. a RAW movie file as a single RAW
image in DPP, the displayed image is automatically selected for doing
this.

Select a RAW movie file in the main window, etc.
The thumbnail icon is [
Display the Settings tool palette.

Select the frame you want to set as the display image
in [RAW movie frame selection].

R movie frame selection

i

Use the slider or [[J[§] and [[fIl]] buttons to select the frame you

want to set as the display image, and the display image changes.
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Grabbing and Saving a Displayed RAW Movie Image

You can grab and save the frame of the displayed RAW movie file
image.

Select a RAW movie file in the main window, etc.

The thumbnail icon is [[gg]].
To change the displayed image, follow the steps in “Changing the
Image Displayed for a RAW Movie” (p.154).

Select the [File] menu » [Grab current frame from
RAW movie and save], and click [OK] in the dialog
that appears.

The [Grab current frame from RAW movie and save] dialog
appears.

Set items as necessary and click the [Save] button.

[Grab current frame from RAW movie and save] dialog

@, Grab current frame from RAW movie and save x
4 > This PC * Syslmage (D) * RAWMovie v O s RAWMovi F
Organize - New folder . a
o A e Date modifiec
& This PC Name Date modified
% 3D Objects XXXXX.CRM
= Desktop
Documents
4 Downloads
2 Music
= Pictures
# Videos
<. Local Disk (C)

- Sysimage (D)
< Data (E)

v

File name: JSESSHSEHY

Save as type: CRM (*.CRM)

4 Hide Folder ' Save ' Cancel

The frame is saved based on specified settings.
Savable format is only CRM.

®Any image editing made to the original movie file is not carried over
to the new saved file.
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Saving Several Still Photos from a RAW Movie

You can save several still photos from a RAW movie file.

Select a RAW movie file in the main window, etc.
The thumbnail icon is [[gg]1.

Select the [File] menu » [Save still image from RAW
movie].

The [Save Still Image from RAW Movie] dialog box appears.
Set items as necessary

[Save Still Image from RAW Movie] dialog box

Save Still Image from RAW Movie *

Save range settings

I:I frame(z) Settings..

* Saving takes longer when many frames are saved.

Destination folder settings

Destination folder : Ci¥lzers vransmyraass Erowsze...

Ex.: Hhok ktokt ok TIF

Qutput setting
Save as type  TIFF 16bit (*TIF) -

Qutput resolution dpi

[] Resize
Width Height

Wk X otk | (oot QR 3 ot P ) Unit |pixel
Embed ICC prafile

Shooting info setting  Include all shoating info =

Execute Cancel

[Save range settings]: Set the range of frames to save. By
default, only the single display image frame (selected frame) is

set. Set the range in the [Save Settings] dialog box that appears

by clicking the [Settings] button.

[Save Settings] dialog box

Save Settings *

(® Save the specified number of frames

Mo. of frames before :

Mo. of frames after :
() Save the range between in and out points

Ma. of frames :

* In and out points can only be get in the RAW movie tool.

==

* [Save the specified number of frames]: Specify the number of
frames and save.

[No. of frames before] specifies the number of frames before
the display image (selected frame) to save.

[No. of frames after] specifies the number of frames after the
display image (selected frame) to save.

Up to 10 frames can be saved with each of [No. of frames
before] and [No. of frames after].

» [Save the range between in and out points]: All frames in the
range selected in the RAW movie tool are saved as still
photos.

 After specifying settings, click the [OK] button.

The [Save Settings] dialog box closes.

[Destination folder settings]: Specify the destination folder where

still photos are saved.

[Output setting]: Specify settings for outputting still photos.
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Downloading
Images
Save the still photos. . .
Starting Up the RAW Movie Tool -~
seEslimeasemEREene . The RAW movie tool allows you to play back and edit RAW movie files. Images
Save range settings
l:l frame(z) Settings.. i
* Bavine takes longer when many frames are saved. ® The environment below is recommended for running the RAW Isr:;tlgg
Dest?nat?on folder settings mone tOOI . 9
DESE"”E_"'“” folder iles TR T Bronse. The minimum environment also below is necessary for running
x" S the RAW movie tool. Editing
Output setting _ Recommended environment Images
S 5 e an 185t (% TIF) | = * CPU: Intel Xeon CPU E5-2687W v3 3.1 GHz x 2 or more (max.
Cutput resalition ! 3.5 GHz using Turbo Boost) -
I » GPU: NVIDIA GeForce RTX 2080 -
e dhEE X = otk | (oot QR 3 ot P ) Unit |pixel ° RAM 32 GB or more
_ » Storage: SSD readable 400 MB/s or faster X
[ Embed IGG profile .. . Processing
Shooting info setting  Include all shooting infa - Mlnlmum enVIronment Large Numbers
* CPU: Intel Core i series or later of RAW Images
Gancel « GPU: Environment with NVIDIA GPU —
* VRAM: 4 GB or more (8K movies: 8 GB or more) Remote
Click the [Execute] button to create a folder in the destination * The RAW movie tool cannot run in a non-NVIDIA GPU Shooting
folder with the name of the movie file. Still photos are saved environment (example: AMD GPU, Intel GPU).
according to the settings specified in step 3. Install the latest-version GPU driver. Playing Back
Movies and Saving
Still Photos
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RAW Movies
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Specifying
Preferences

Q0O

@ Depending on your system requirements or the number of frames
being saved, it may take a long time to save.
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Select a RAW movie file in the main window, etc.
The thumbnail icon is [[fg]1.

Select the [Tools] menu » [Start RAW Movie Tool].

The RAW Movie tool window appears.
To exit, click the [Close] button.

o a0 > I oy

Bx1 200 @ @
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List of RAW Movie Tool Window Functions

[Save movie] button (p.162)

[Grab and save] button
(p.162)

Frame display area

Set last frame for saving
(p.161)

Next frame (p.160)
Play/pause (p.160)
Previous frame (p.160)
Set start frame for saving

(p.161)

o A4 » I oy

l x1 200% * © ®

Display frame fit to window (p.21)

Display frame at no magnification (p.21)
Set the frame display magnification (p.21)
Reduce/enlarge the frame (p.21)

Mute/unmute (p.160)
Volume slider (p.160)

Viewing LUT on/off (p.162)

RAW mavie
Canon Log

9. Sharpness

Strength

lor adjustment

Frame no./Total frames (p.160)
Frame position slider (p.160)

Tool palettes (for RAW

movies) (p.162)

Show playback time
In point marker (p.161)
Out point marker (p.161)
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Playing Back RAW Movies
You can play back RAW movie files with the RAW movie tool.

Select a RAW movie file in the main window, etc., and
start up the RAW movie tool.

Start up the RAW movie tool according to the procedure at
“Starting Up the RAW Movie Tool” (p.157).

Control movie playback.

Next frame Show playback time
Play/pause
Previous

frame

Ao Al > I Oy xeedess

x1 200% v © @ ) m—m——uT

Frame no./Total frames
Frame position slider

Mute/unmute
Volume slider

Play/pause: Play and pause the selected movie.

Next frame: Move forward one frame. When movie playback is
paused, this allows you to advance the movie one frame at a
time.

Previous frame: Move back one frame. When movie playback is

paused, this allows you to rewind the movie one frame at a time.

Show playback time: Shows the playback time.

Frame position slider: By dragging the slider left or right, you can

move the playback position while a movie is playing or paused.
Frame no./Total frames: Shows the current frame number in the
movie being played back or shown and the total number of
frames.

Movies shot with Canon Log (color space: BT.2020) are played
back in BT.709 color space.

You cannot edit with the tool palettes (for RAW movies) in the
RAW movie tool while a RAW movie is playing back.

You cannot use the [[Jliilj] button for applying a Viewing LUT
while a RAW movie is playing back.
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Saving any Range of a RAW Movie as Still Photos

You can save any range of a RAW movie file as still photos.

Select a RAW movie file in the main window, etc., and
start up the RAW movie tool.

Start up the RAW Movie tool according to the procedure at
“Starting Up the RAW Movie Tool” (p.157).

Set the lead frame.

b |

o 4 » I» ofy  coex

x1 200% * O @ ) =———uT

Use the slider or [[[]] and [[fIl]] buttons to display the frame you
want to set as the lead frame in the frame display area, and then
click the [[ERIE]] button.

The in point marker (J§ll) moves, and the lead frame in the movie
is set.

Set the last frame.

1 r
I&‘bm ‘" > ") DL_I{!- NN e— ) — 0000

x1 200% ¥ O @ ) m———iyT

Use the slider or [[[[]] and [[fIl]] buttons to display the frame you
want to set as the last frame in the frame display area, and then
click the [[[EEM] button.

The out point marker ([l]) moves, and the last frame in the movie
is set.

Save the range.

Specify the necessary settings in the window that appears by

clicking the [Save movie] button and save the range.

The range is saved to the folder created in the destination folder

with the name of the movie file.

Files are saved as a still photo (JPG/TIFF/DPX*) + an audio file

(WAV file) and numbered sequentially.

Note the following for [Save as type] that can be selected.

* When [HDR PQ] for the RAW movie is set to [On] : Only DPX*
is selectable.

* When Canon Log (color space: BT.2020)is set for the RAW
movie : Only DPX* is selectable.

* When Canon Log (color space: BT.709)is set for the RAW
movie : Only 16-bit TIFF format is selectable.
When selecting DPX, you cannot specify settings for [Image
quality], [Output resolution], [Embed ICC profile], or [Shooting
info setting].
For the files saved in DPX format cannot be viewed in DPP.
*DPX: Digital Picture Exchange

If the movie was shot without audio on the camera, no audio file

(WAV file) is output.
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Grabbing and Saving any Range from a RAW Movie

You can grab and save any range from a RAW movie file.

Set any range of a movie file following steps 1 to 3 of
“Saving any Range of a RAW Movie as Still Photos”
(p.161).

Click the [Grab and save] button.

The [Grab and save] dialog appears.
Make required settings and click the [Save] button.

[Grab and save] dialog

e,

v | %

T > This PC > Sysimage (D:) > RAWMovie v O Search RAWMovie

Organize New folder B ]

~
‘ ame Date modified Type ze
™ This PC Nam Date modified ype Siz

23D Objects XXXXX.CRM 6/2020 2:50 PM CRM File 926,810 KB

= Desktop

# Videos
< Local Disk (C)

- Syslmage (D)
~- Data (E)

v

EREL OO0 XX CRM]

Save as type: CRM (*.CRM)

 Hide Folder | sae ) cancel

The range is saved based on specified settings.
Savable format is only CRM.

@Any image editing made to the original movie file is not carried over

to the new saved file.

Editing a RAW Movie

You can edit RAW movie files with the tool palettes (for RAW movies) in
the RAW movie tool.

Select a RAW movie file in the main window, etc., and
start up the RAW movie tool.

Start up the RAW Movie tool according to the procedure at
“Starting Up the RAW Movie Tool” (p.157).

Edit.

\ r
WO Al P P Off X e—— oo

FJ x1 2006~ © @® o)) =mlm== = LUT

Use the tool palettes (for RAW movies) to edit.
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The tool palettes (for RAW movies) other than the Settings tool

palette have the same basic functions as the original tool palettes

(p.46). See instructions for each original tool palette.
See the table below for differences in operation.

Icon Tool palette name Description
Basic Adjustment tool |Differences from the Basic Adjustment
palette tool palette (p.48) are as follows:
(for RAW movies) * [Linear], [Clarity], [Ad] face lighting] not
] settable

» Automatic adjustment of gradation and
luminance not possible

* Only [Unsharp mask] settable for
[Sharpness]

Tone Adjustment tool
palette
(for RAW movies)

Differences from the Tone Adjustment

tool palette (p.62) are as follows:

» If[HDR PQ] is set to [On], click white
balance is not available

Color Adjustment tool
palette
(for RAW movies)

Same editing possible as with the Color
Adjustment tool palette (p.67)

Detailed Adjustment tool
palette
(for RAW movies)

Differences from the Detailed
Adjustment tool palette (p.69) are as
follows:

* [Reduce luminance noise] and
[Reduce chrominance noise] can be
adjusted using the slider only when
the [Noise reduction] checkbox is
checked (adjustment range: -10 to 10)

» [Reduce color moiré] not settable

* Only [Unsharp mask] settable for
[Sharpness]

Lens Correction tool
palette
(for RAW movies)

Differences from the Lens Correction

tool palette (p.74) are as follows:

» [Chromatic aberration] and [Peripheral
illumination] correction: click the
(= I! button to apply shot
settings.

« [Distortion]: correction possible only
for images shot with an RF lens.

« [Digital Lens Optimizer] not settable

« [Diffraction correction] and [Color blur]
correction not possible

The following tool palettes are unavailable for RAW movies:
Trimming/Angle Adjustment tool palette, Dust Delete/Copy
Stamp tool palette, Partial Adjustment tool palette, Settings tool

palette.

Editing using the Settings tool palette

RAW movie
Canon Log

Neutral -

Sharpness |4~

Strength

Color adjustment
Hue

Saturation

Work color space

BT.709

HDR PQ setting
Canon Log checkbox

Color matrix selection

Sharpness setting

Color adjustment

Work color space

* You can set HDR PQ. When set to [On], the RAW movie file
selected with the RAW movie tool is displayed in HDR PQ. On
a system where display in HDR PQ is not possible, the movie
is converted and displayed in SDR based on the [HDR assist
display (movies)] setting in [Preferences] (p.179).

» Canon Log checkbox: If checked, you can perform color matrix
selection, sharpness setting, and color adjustment with this
tool palette. Only for movies shot on a supported camera
having RAW movie shooting and Canon Log set ON.

+ Color matrix selection: Select from EOS Original and Neutral

color matrices.

» Sharpness setting: Set the sharpness.
» Color adjustment: Set the hue and saturation.
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» Work color space: When the Canon Log checkbox is
checkmarked, you can select either of BT.709 and BT.2020
work color spaces. Note that in DPP, movies cannot be
displayed in BT.2020 even if BT.2020 is set.

» Viewing LUT: Click the [[JliiJj] button in the RAW movie tool to
apply a look-up table (LUT). This allows you to check the
movie with an image close to normal display.

Save the movie.

Specify the necessary settings in the window that appears by

clicking the [Save movie] button and save the movie.

Files are saved as a still photo (JPG/TIFF/DPX*) + an audio file

(WAV file) and numbered sequentially.

Note the following for [Save as type] that can be selected.

* When [HDR PQ] for the RAW movie is set to [On] : Only DPX*
is selectable.

* When Canon Log (color space: BT.2020) is set for the RAW
movie : Only DPX* is selectable.

* When Canon Log (color space: BT.709) is set for the RAW
movie : Only 16-bit TIFF format is selectable.
When selecting DPX, you cannot specify settings for [Image
quality], [Output resolution], [Embed ICC profile], or [Shooting
info setting].
For the files saved in DPX format cannot be viewed in DPP.
*DPX: Digital Picture Exchange

If the movie was shot without audio on the camera, no audio file

(WAV file) is output.

To exit, click the [Close] button.

Editing performed with this function cannot be reverted to the
states in [Revert to shot settings] or [Revert to last saved settings]
in the [Adjustment] tab in the menu even if they are selected.

If [HDR PQ] for a RAW movie is set to [On], and you try to display
the movie on a system where display in HDR PQ is not possible,
the movie is converted and displayed in SDR. A [] is
displayed.
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10 Using HDR PQ Mode

HDR PQ MOdE.......oviiiiiiiiiiiiieeieeeeeeeeeeeeeeeeeeee e 166
System Requirements for HDR PQ Mode.............. 166
Displaying Images in HDR PQ Mode .................... 167
Cautions when Using HDR PQ Mode.................... 169
Saving Images Displayed in HDR PQ Mode in

JPEG/TIFF Format..............oooi 171
Working with Files Saved in HEVC Format........... 172
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HDR PQ Mode

HDR stands for High Dynamic Range and refers to technology that
enables expression of “a wider range of brightness” than with the
conventional range. The conventional range of brightness is referred to
as SDR (Standard Dynamic Range) = “standard brightness range” when
compared to HDR.

The “PQ” in this function’s name, HDR PQ, stands for Perceptual
Quantization and refers to the gamma curve of the input signal for
displaying HDR images. It is capable of brightness up to 10,000 cd/m?
and approximates human visual characteristics. HDR PQ mode displays
RAW images shot with a supported camera in HDR PQ (10-bit) on an
HDR display compliant with the HDR standard. (Actually displayed
images depend on monitor performance.)

You can also edit and save images.

In addition, DPP has the function “Creating HDR (High Dynamic Range)
Images” (p.110). However, this function assumes that display is in
conventional SDR, and combines exposure-bracketed images (HDR
compositing) to achieve image expression that uses a wide range of
gradation from shadows to highlights, and is thus different from HDR PQ
mode.

System Requirements for HDR PQ Mode

System Requirements

gysségﬁsrating Windows 10 (Version 1607 or later), Windows 8.1*

CPU Core i series 3.4 GHz or higher
RAM 4.0 GB or more of RAM (8.0 GB or more
(memory) recommended)

RAW and DPRAW images shot, RAW movies shot
with the EOS R5
RAW images shot with the EOS R6

RAW images and RAW movies shot with the EOS-1D
X Mark Il

RAW and DPRAW images shot with the EOS R,

Supported
images

EOS Ra or EOS 5D Mark IV

* Since HDR PQ cannot be displayed in Windows 8.1, images are
displayed in SDR according to the characteristics of the display so that
they approximate display in HDR PQ as much as possible.

Systems where images are displayed
accurately in HDR PQ

gysst(grp::)erating Windows 10 Version 1803 or later

Video cards: NVIDIA GeForce GTX 10 series,
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Display Products that meet HDR10 standards*
Cable HDMI 2.0a/b

* Images may not be displayed correctly depending on display and GPU
(video card) performance.
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L] u - D I i
Displaying Images in HDR PQ Mode R
This section explains how to display images where system requirements Select an image in the main window, etc., and then T —
are as described in “Systems where images are displayed accurately in open the Settings tool palette and select [On] in Viewing
HDR PQ” on the previous page. Additionally, in Windows, you must [HDR PQ] Images
specify the HDR option for display settings. ’ -

. . Sorting
Check that checkbox in [Preferences] » [View Images
settings] tab sheet » [HDR display] is checked.

Preferences Edltlng
Thumbrnail order @ Off Q On Images
Doyt onloid=i File nane | @ Ascendine
R (O Descending ‘iark, calor space
St o 5 Printing
Images
Reset user interface *
[] Restore defaults at startup = = —_—
aettings..
Processing
I emmiedy Large Numbers
Preview soreen backeround colr of RAW Images
Image zooming mulation profile
®) Singleclick (O Double-click
ool S when G e R oo Remote
[ Ru:a D}-{‘DyR Ay (e (TR e cimmaeis sk evypert BR sl ] Sies when opening RAW imagss Shooting
. , ] L ] Playing Back
The image is displayed in HDR PQ mode. Movies and Saving
e el e e - Images are displayed in HDR PQ only in the main window, the o Rl o2
S ——
If not checked, checkmark the checkbox, click the [OK] button, edit image window, the preview window, second windows, and
and then restart DPP. the enlargement check screen. In other windows, images are RE&"&""Q
: . . L . ovies
displayed in SDR according to the characteristics of the display
so that they approximate display in HDR PQ as much as
possible. t@
The following icons are displayed in the preview window and

thumbnail frames for images displayed in HDR PQ mode.

* Thumbnail frame:

* Preview window (when connected to an HDR display):

» Preview window (when connected to an SDR display, when
the computer’s OS is Windows 8.1):
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HDR PQ mode display when an SDR display is connected
You can use images in HDR PQ mode also when connected to an
SDR display.

When an SDR display is connected, the image is displayed
according to the characteristics of the SDR display so that the
image approximates display in HDR PQ on an HDR display as
much as possible.

However, the large difference in regions that can be rendered
between HDR displays and SDR displays results in a different
impression of colors and gradations.

HDR PQ mode display on a computer with a Windows 8.1
oS

If the computer’s OS is Windows 8.1, images are displayed in
SDR according to the characteristics of the display so that they
approximate display in HDR PQ on an HDR display as much as
possible. However, the large difference in regions that can be
rendered between HDR PQ and SDR results in a different
impression of colors and gradations.

Recommended display environments for mixed HDR PQ
mode images and SDR images

It is recommended that you have a multiple-monitor environment
using two displays, an SDR display and an HDR display, when
using both HDR PQ and SDR display for images. On the SDR
display, you can display the DPP thumbnail display, tool palettes,
and SDR images, and you can use the HDR display to display the
HDR images.
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Cautions when Using HDR PQ Mode

Item

Restriction

Quick check window (p.31)

Displayed in SDR according to the characteristics
of the display so that images approximate display
in HDR PQ as much as possible

Displaying AF points (p.22)

Basic Adjustment tool palette

Display function Not displayable*
Displaying grid lines (p.22)
Highlight/shadow warning (p.23) Not displayable
Displaying properties in preview image (p.24) Not displayable*
Auto Lighting Optimizer (p.58) Unavailable

Changing the Picture Style (p.49)

The following Picture Styles are available
- [Standard], [Portrait], [Landscape], [Fine Detail],
[Neutral], [Faithful], [Monochrome]

Using Picture Style Files (p.51)

Linear (p.57) Unavailable
Automatic adjustment of gradation and luminance (p.57)
Detailed Adjustment tool palette | Reducing color moiré in images (p.70) Unavailable
Partial Adjustment tool palette Reducing color moiré (p.84) Unavailable

Settings tool palette

Setting the work color space (p.91)

Not selectable
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Color matching settings (color setting of the monitor)
(p.178)

Setting the size of RAW images when opening (p.93) Unavailable
Compositing images (p.106)

Tools Unavailable
Generating HDR (High Dynamic Range) images (p.110)
Using the soft-proof colors function (p.92)

Simulation function Unavailable®

* The function is available when using an SDR monitor.

Since recipes that become attached to images when HDR PQ is set to On and when HDR PQ is set to Off are not compatible, neither can be applied

to the other.
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Switching between HDR and SDR modes clears the following recipes:

Basic Adjustment tool palette

Auto Lighting Optimizer / linear / Picture Style* / gamma adjustment

Tone Adjustment tool palette

Tone curve adjustment (RGB), brightness, contrast

Settings tool palette

Work color space, size when opening RAW images

Color Adjustment tool palette

Hue and saturation adjustments for the entire image, color adjustments for specific gamuts

Detailed Adjustment tool palette

Reducing color moiré

Partial Adjustment tool palette

Partial adjustments and reducing color moiré

Dust Delete / Copy Stamp tool
palette

Stamp

Dust delete data

* The recipe is cleared if the Picture Style was set to a style other than [Standard], [Portrait], [Landscape], [Fine Detail], [Neutral], [Faithful] or

[Monochromel].

® Image quality enhancement in HDR PQ mode has been introduced as of Digital Photo Professional 4.10.40. To keep using previous adjustment

results, select the check box for [HDR PQ image quality settings*] in [Image Processing 2], in [Preferences].
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Saving Images Displayed in HDR PQ Mode in JPEG/TIFF Format

You can save the editing results of images displayed in HDR PQ mode
in the same way as SDR images.

See “Saving Editing Results” (p.95) for information on how to save
images.

When saving an image displayed in HDR PQ mode as a separate
image (JPEG or TIFF image), it is saved as an SDR image. The
image is processed so that it approximates display in HDR PQ on an
HDR display as much as possible. However, the large difference in
regions that can be rendered between HDR PQ and SDR results in a
different impression of colors and gradations.

For information on saving images in HEIF format, see “Saving Images
Displayed in HDR PQ Mode in HEIF Format” (p.172).

® When an image displayed in HDR PQ mode is saved as a separate
image (JPEG or TIFF image), the work color spaces of the saved
images are all fixed at sSRGB.
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Working with Files Saved in HEVC Format

You must first install HEVC Codec (or enable it, depending on the
model) so you can display files saved in HEVC format* or save images
that are displayed in HDR PQ mode in HEIF format (extension: .hif).
HEIF stands for High Efficiency Image File format. Saving in HEIF
format allows you to save images while retaining the wide dynamic
range of HDR PQ.

*HEIF image files, HEVC compressed movie files

Preparation for Working with Files Saved in
HEVC Format (Display and Saving)

To work with files saved in HEVC format, HEVC Codec must be
installed (or enabled, depending on the model).

To work with files in HEIF format after shot on an EOS R/Ra, or

EOS 5D Mark IV, download and install Canon HEVC Codec from the
Canon website. You should also start up DPP again after installing.
To work with files in the above format shot on supported cameras, it is
necessary to enable HEVC Codec. Select the images in the main
window, and in the [Help] menu, select [Activate HEVC codec], and
follow the displayed instructions to enable it.

You should also start up DPP again after enabling.

Saving Images Displayed in HDR PQ Mode
in HEIF Format

See “Saving Editing Results” » “Saving as a separate image” (p.95)
for information on saving images. When selecting the image type in
step 3, select [HEIF (*.HIF)] from [Save as type] and then save the
image.

You cannot select the image quality or compression rate when saving
in HEIF format.

You can [Save], [Save As], [Convert and save], or [Batch process]
HEIF images.

You can save a HEIF image as a JPEG or TIFF image. (It is saved as
an SDR image.)

The image is processed so that it approximates display in HDR PQ on
an HDR display as much as possible. However, the large difference in
regions that can be rendered between HDR PQ and SDR results in a
different impression of colors and gradations.

See “Saving Editing Results” (p.95) for information on how to save an
image as a JPEG or TIFF image.

® When a HEIF image is saved as a JPEG or TIFF image, the work

color spaces of the saved images are all fixed at sSRGB.

HEIF files generated with software other than DPP are not
compatible with HEIF files saved in DPP. Only HEIF files saved in
DPP can be loaded into DPP.

Images saved in HEIF format cannot be printed using Print Studio
Pro software for Canon inkjet printers.

Downloading
Images

Viewing
Images

Sorting
Images

Editing
Images

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

0

Specifying
Preferences

172



11 Specifying Preferences

Specifying Preferences.........cccccooeeeviiiiiiiiiicieeinnnnn. 174
General Settings..........ceeeviiiiiiiiiiiiiieeeeeee, 174
IMage ProCeSSING .....uuvvvruieiiiieiceeceee e 175
Color Management..........cccoovvieiiiiiiiiieieiee e, 177
View Settings......ccveeeiiiiiiie e 178
Properties Display Settings .........ccccccevviiiieeeeeiinnnen. 179
SUIVEY .o 180

Downloading
Images

Viewing
Images

Sorting
Images

Editing
Images

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

173



Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.

Refer to the detailed explanations if available, as well as to each
window.

Select the [Tools] menu P [Preferences].

The [Preferences] window appears.

Select a tab sheet, specify the settings, and then
click the [OK] button.

es Startup folder *
ssing 1 @ Last displayed folder
O Specified folder

[C¥Users¥usersPictures Browse

Image Processing 2

Galor management

Wiew settings
Save recipe

(®) Display message when addine file
(O Add to fils automatically

Properties display sett
Survey

Mave file playbackx
@® Play with Digital Phato Prafessional 4

(O Play with default application
Mavies that cannot be played with Canon applications are passed to the default application.

Receiving files from EOS Utility
Automatically focus on a file received

Default value of output resolution *

dpi( 1-60000)

Temporary Files*

Gurrently used 00 ME Delete Reset
Amount of Dusl Pixel RAW cache used 00 MB Delets

Maximum available on disk 4GB 0 | ] 22

Destination C¥Users¥user¥ AppData¥Roaming¥Canon e 15 | Browse

< >

e

*Changes take effect after restarting

General Settings
You can specify the folder that opens when DPP is started up, saving of

recipes, etc.

Preferences X
G sttines Startup folder *
Image Processing | @ Last displayed folder
Imaege Frocessing 2 () Specified folder
Golor management [C¥Users¥usersPictures Browse
View settings
Properties display sett| ~ Save recipe
Survey @ Display message when adding file
(O Add to file automatically
Movie file playback®
® Play with Digital Photo Professional ¢
(O Play with default application
Movies that cannat be played with Ganon applications are passed 1o the default application,
Receiving files fram EOS Utility
futomatically focus on a file received
Detault value of output resolution *
dpil 1-60000)
Temparary Files*
Gurrently used 00 MB Delete Resst
#mount of Dual Pixel RAW cache ussd 00 MB Delete
Maximum availabls on disk 4GB D ] 32
Destination Ci¥Users¥user¥AppData¥Roaming¥Canon e IG ] Browse
< >
#GChangss take effect after restarting G

Movie file playback
Choose the application used for playing back movie files. Movies that
cannot be played back in DPP or EOS MOVIE Utility are played back
with the movie playback application specified with the computer’'s OS
settings. For information on EOS MOVIE Utility, refer to the EOS MOVIE
Utility Instruction Manual.

® If you have changed the movie playback application to EOS
MOVIE Utility, and playback does not start after starting up EOS
MOVIE Utility, check compatible models with the EOS MOVIE
Utility Instruction Manual.
If the movie playback application specified with the computer’s
OS settings is set to EOS MOVIE Utility, MOV and MP4 files shot
with the models that are not compatible with EOS MOVIE Utility
will not be played back. Check the OS settings and change the
movie playback application.
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Default value of output resolution
When saving JPEG or TIFF images created by converting RAW images
(p.95, p.139), the resolution of the JPEG or TIFF images can be set.

Temporarily saved files

You can delete temporarily saved files that were created and improve
operation speed, change file save destinations, or set a limit on disk
usage. Any changes you made will be applied when you start up DPP

again.
[Delete] button:

[Maximum available on disk]:

[Destination]:

[Reset] button:

Click the [Delete] button to delete
temporarily saved files.

Set with the slider (setting range: 0 to
32 GB).

Once usage reaches the limit, files
are erased starting with the oldest.
Click the [Browse] button to change
the save destination in the dialog that
appears.

Click the [Reset] button to revert all
changes to the original settings.

Image processing

You can specify settings for processing images in DPP.

Image Processing 1

Preferences

General settines JPEG image quality *

[] Remave black naise and mesauite naise

Image Processing 2

Modified Pisture Style ssttings *
Retain settings of each Picture Style

Golor management
View settings
Froperties display sett ) )
roperties display = Previsw image cettings
Survey
Show stamp editing status on preview imazes

Select to show stamp editing status on all preview screens.

Glear to show stamp editing status only on the stamp editing screen
Noise reduction defaults#
@) Apply camera settings
(O Set as defaults

Sharpness defaults*
(® Apply camera settings
(O Set as defaults

| Unsharp mask

< >

*Chanees take effect after restarting

0.0
0.0

0.0
0.0
0.0

Applies to RAW images on

Applies to RAW images on

JPEG image quality
[Remove block noise and mosquito noise]

You can improve the quality of a JPEG image by reducing the noise

particular to JPEG images.

This setting is also effective when RAW images are converted to

JPEG images and saved (p.95, p.139) and for JPEG images that to

be saved with a different name. The higher the JPEG image’s

compression rate, the better the effect. And when the compression
rate is low, the effect of noise reduction may not be noticeable.

Modified Picture Style settings

If you checkmark the checkbox, setting values for [Color tone], [Color

saturation], [Contrast], [Unsharp mask], [Sharpness], and other options

will be retained for each Picture Style.
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Noise reduction defaults
You can set a default beforehand for the noise reduction level. Only
RAW images are supported.
When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.

For images not having a recipe attached, the default noise reduction
level set here is applied. If you changed settings, they will be applied to
images as the default noise reduction level when you start up DPP
again.

For images with a recipe attached, the noise level recorded in the recipe
remains as it is and the default for noise reduction level set here is not
applied.

Sharpness defaults
You can set a default beforehand for the sharpness. Only RAW images
are supported.
When [Apply camera settings] is selected, you can pre-set a

sharpness that suits the camera settings beforehand as the default.

When [Set as defaults] is selected, you can pre-set preferred
default settings for the sharpness and unsharp mask beforehand.

For images not having a recipe attached, the defaults for sharpness and
unsharp mask set here are applied. If you changed settings, they will be
applied to images as the default sharpness level when you start up DPP
again.

For images with a recipe attached, the sharpness level recorded in the
recipe remains as it is and the defaults for sharpness and unsharp mask
set here are not applied.

Image Processing 2

Preferences X

Quick check window settings*
®) Show original image
O Show image with recipe applied

Graphics processor settings®

Properties display sstt

Survey Usz eraphics pracessar to speed up preview display

Default size when opening RAW images*
Original sizs (do not change) v

# Applies to display of compact GRS files and to resizing when images are converted
HDR: PQ image quality ssttings *

[] Disable image quality enhancement (from ver. 4.10.40)
* fipplies to imaees captured with the EOS 8D Mark IV and EOS R,

< >

#Changes take effect after restarting

Quick check window settings
You can specify image display settings for the quick check window. By
selecting [Show image with recipe applied], images with a recipe
attached are displayed with the recipe applied. Any changes you made
will be applied when you start up DPP again.

Graphic processor settings
If you checkmark [Use graphics processor for image processing], the
graphics processor is used to allow a faster preview display. The CPU
handles convert and save tasks as well as print tasks as usual. Settings
will be applied the next time DPP is started up.
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@ To use this function, a NVIDIA CUDA (Compute Capability 2.0 or
higher) GPU* with at least 1.0 GB of video memory is necessary.
Additionally, the latest NVIDIA GPU driver must be installed.

* GPU is an abbreviation of “Graphics Processing Unit”.

The [Use graphics processor for image processing] checkbox is
available only when a supporting GPU is installed.

If the OS or other application software is using the GPU,
processing by the GPU may not be possible in some
circumstances. In such a case, the CPU handles processing as
usual.

Default size when opening RAW images
This applies only to RAW images with the extension “.CR3” that were
shot with [c@m ] selected on the camera.
This specifies the size defaults when RAW images are opened in DPP.
This default size is also set when RAW images are converted and saved
as JPEG or TIFF images.
The settings are applied the next time DPP is started up.

HDR PQ image quality settings
Image quality enhancement in HDR PQ mode has been introduced as
of Digital Photo Professional 4.10.40. To keep using previous
adjustment results, select the check box for [HDR PQ image quality
settings*].

Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Default settines of Work color space *

@ sRGE O Apple RGE

O fAdobe RGE O GolorMateh RGE
O Wide Gamut RGE

[] Use shoating color space as work color space

Golor matching settines
For display

O =RaB
(@ Use the 05 settings
O Monitor profile

Printine profile
[ Mone — -

G simulstion profils
[-—= MNone — -

< >

*Chaness take effect after rectarting

Default settings of Work color space

You can select the color space (p.186) to be applied as a default setting
of RAW images from five types. The color space set will be applied as
the color space when a RAW image is converted and saved (p.95,
p.139) or printed (p.132 to p.135).

If you change the color space, and you restart DPP, the set color

space is applied as the default color space.

You can check the color space that is set in an image in all windows

except the quick check window.

If you checkmark [Use shooting color space as work color space],

the color space specified with the camera when the image was shot

will be set as work color space.
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:@: Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, cropped, dust-
erased) images. Change the settings individually.

@ You can set a color space that is different from the default settings
for each image (p.91).

Color matching settings (color setting of the monitor)
Where a profile (p.185) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.
If you select [Use the OS settings], the color profile set in Windows
will also be applied in DPP. If you are using multiple monitors, the
profile set for each monitor is applied to DPP.
Select the [Monitor profile], click the [Browse] button. You can
select a profile for your monitor in the dialog box that appears.

Ay

5@3 Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.

Printing profile (color setting of the printer)
Where a profile is not attached to the printer you are using to print
images, you can print an image, simulating the colors displayed on
screen by setting the profile in DPP.

@ When you set a profile for printing in DPP, set the color adjustment
function of the printer driver to off. If it is left on, the image may not
be printed in colors close to those displayed on screen.

View Settings

You can set layout for screen display.

Default sort order File name @ Ascending

O Descending

1 Tool tips
Show tool tips

Reset user interface *
[[] Restore defaults at startup

Image background color

Preview screen background color W (default)

Image zoaming
@ Single—click O Double-click

HDR display *
Use HDR display for HDR images (in environments that support HDR display)

HDR ass
@ Exposure
< > QO Tones prior. (highli

#Changes take effect after restarting

Thumbnail order
Specify the default order of images in the main window, and that the
order of rearranged images be maintained. If you checkmark the
checkbox, the order of rearranged images is maintained starting the
next time you select a folder (p.36).

Reset user interface
You can reset user interface settings.
Choose from either of 2 reset states.
By checkmarking the [Restore defaults at startup] checkbox, settings
revert to their original settings for next time you start up DPP. The
checkmark is also removed from the checkbox for the next startup.
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HDR assist display (movies)
This function provides an assisted display of CRM and MP4 files that
have [HDR PQ] set to [On] so that they are easier to view in an SDR

environment. The setting will be applied the next time DPP is started up.

However, this function is only effective in the RAW movie tool for CRM
files.
Exposure prior. (mid-tones): maintains brightness where there are
medium tones in dark areas. Used for checking exposure.
Tones prior. (highlights): maintains color reproduction and gradation
as much as is possible. Used for checking gradation in highlights.

Properties Display Settings

You can specify settings for shooting and recipe information that
appears with thumbnails and in the preview window.

Preferences X

General sattings Use Recommended Settings

Image Proceszing 1
View settings

Show Av/Tw/150 on thumbnails

Shaw ican on thumbnail to indicate edited recipes
Show HOR icon on thumbnails

Show HOR icon on previews

Imaee Frocessing 2
Galor management

Wiew settings

Properties display sat

Survey

Previsw properties font
[s001x 16 pt Erowse

Restore Defaults

Properties to display
Display settings for thumbnails with infa v Restors Defaults

Clear All

Shooting Date/Time

Qwner's name Camera Model Name
Image Size + RAW Type

Lens
Focal Length

Shaoting mode + Metering mode
Aperture Value + Shutter Speed
150 Speed

Exposure Compensation

Size when opening RAW images Add >

<< Remove

< > Mave: Up Mave Danin

Gorce

#Changes take effect after restarting

View settings
You can specify information that appears on thumbnails or previews.
If the [Show Av/Tv/ISO on thumbnails] checkbox is checked, Av/Tv/ISO
information is displayed on thumbnails if thumbnails are set at Size 3 or
larger.

Preview properties font

You can specify the font used for information displayed in the preview
window.
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Properties to display
You can specify detailed settings for [Display settings for thumbnails
with info], [Display settings for thumbnail list], and [Display settings for
preview properties].
Items that can be selected appear in the list box at left, and actually
displayed items appear in the list box at right. Specify items with the
[Add >>] button and [<< Remove] button. You can also change the
display order with the [Move Up] button and [Move Down] button.

@ All the property items may not be displayed depending on the

combination of window, preview window, or the size of thumbnails.

Survey

You can change survey send settings.

Survey Prosram

Chanee settines

Properties display sett

< >

*Ghanees take effect after restarting Gancal

Click the [Change settings] button and change settings in the
dialog box that appears.
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. D loadi
Troubleshooting e
If DPP is not operating correctly, refer to the subjects below. . . .
P J y : A recipe could not be pasted (applied) to another image -~
iewing
. Since recipes are not compatible between RAW images and JPEG or Images
Installation can not be completed correctly TIFF images, neither can be applied to the other.
Select an administrator-level privilege ([Computer administrator], Sortin
. . . . g
[Administrator], etc.) when setting the user. You cannot install the Colors are subdued in the image when viewed with Images

software if the user setting other than an administrator-level privilege
is selected. For detailed information on selecting an administrator-
level privilege, refer to your computer User’s Manual.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Exit
any applications other than DPP.

The card reader does not detect the SD card

Depending on the card reader and computer OS used, SDXC cards
may not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility.

Images are not displayed properly

Images that are not supported by DPP are not displayed. (Thumbnail
images are displayed as [?].) There are various types of JPEG and
TIFF images, so JPEG images other than Exif 2.2, 2.21 or 2.3
compatible images and TIFF images other than Exif compatible
images may not to be displayed properly (p.4).

other software

If a RAW image which has a color space other than sRGB is
converted and saved as a JPEG or TIFF image (p.91, p.177), the
colors will be subdued when viewed in software that is only
compatible with sRGB color space. In such a case, set the RAW
image’s color space to sRGB, convert and save again as a JPEG or
TIFF image, and then view the image.

The Auto Lighting Optimizer (p.58) is a function compatible with
cameras equipped with the Auto Lighting Optimizer.

Adjustments made with the Auto Lighting Optimizer cannot be applied
to RAW images shot with the cameras not compatible with this
function.

The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if the profile for a printer that is to print image is not set
up, the color of the image displayed on screen and the color of the
printed photograph may differ greatly. If the color of the monitor that
displays images is corrected and the profile for a printer is set up
correctly (p.178), the color of a printed photograph and the color of an
image on screen can be more closely matched. Using a Canon printer
automatically sets up the profiles for the printer, so you only need to
set the color of the monitor to bring the colors closer to each other.

Printing a large number of images in batches
cannot be performed
If a large number of images are printed in batches, printing may stop

in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.
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Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under an administrator-level privilege when uninstalling the
software.

Uninstall the software according to the OS software uninstalling
method.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.
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Image Frame Information in the Main Window and Edit Image Window (».13, p.102)

Trimming (cropping) range*2 (p.71)

Check mark
(p.33, p.34) Pinned image setting mark (p.21)

Recipe mark

=]

150800

IMG_0003.CR2

Image type File name

GPS mark ®

Rating mark (p.33, p.34)

Unsaved editing content mark

Digital Lens Optimizer mark (p.79)

*1 Displayed on RAW+JPEG images displayed as a
single image (p.15).

[
[

*2 \When aspect ratio information is attached to an image
shot with any supported camera other than the EOS 5D
Mark Il, the image is displayed as a cropped image.

DPR

] is displayed in RAW images.

Multiple image display mark
(p-22)

IMG_0030.CR2

Lens aberration Shooting
correction mark information
(p-75)

*3 Displayed on images shot on a GPS function-
compatible Canon camera.

] is displayed in Dual Pixel RAW images. *4 Shows that the movie is splitand includes movies
other than that shown in the thumbnail.

The following icons may be displayed:
n - No final movie
n - No initial or final movie

n : No initial movie
] : All split movies present

50D

VGA30IPB,MOV

Split movie mark 4

[ 1 is displayed in an image
frame when editing is not
possible.

Movies played back using
software other than DPP are
displayed with a [ [l ] icon in the
thumbnail image.

For information on icons displayed
in HDR PQ mode, see “Displaying
Images in HDR PQ Mode”
(p.167).
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Glossary
RAW image

EOS camera RAW images are recorded in an uncompressed 14bit or
12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Color space

A color space is the reproducible color range (color gamut
characteristics). DPP supports the following five kinds of color space.

sRGB :

Adobe RGB :

Apple RGB :

ColorMatch RGB :

Standard color space for Windows. Widely used for

the standard color space of monitors, digital
cameras, and scanners.

A wider color space than sRGB. Mainly used for
printing for business purposes.

Standard color space for Macintosh. A slightly
wider color space than sRGB.

A slightly wider color space than sRGB. Mainly
used for printing for business purposes.

Wide Gamut RGB : A wider color space than Adobe RGB.
Refer to the color chart below for the color area of each color space.

Color chart of color spaces compatible with DPP

Y

0.8

sRGB
—— Adobe RCE
-------- Apple RGB
————— ColorMatch RGB
———— Wide Gamut RGB

Color range that can be
seen by the human eye

08 X
Gamma White point
value (color temp.)
sRGB 2.2 6500K(D65)
———— Adobe RGB 2.2 6500K(D65)
............ Apple RGB 1.8 6500K(D65)
——————- ColorMatch RGB 1.8 5000K(D50)
—————— Wide Gamut RGB 2.2 5000K(D50)

CMYK simulation profiles

A profile that simulates colors when printing in a CMYK environment
(printing machine, etc.). With DPP, you can simulate color with four

types of profile.
Euro Standard :

JMPA :

U.S.Web Coated :

Profile normally used for book printing in
Europe, suitable for simulation of standard
European printing.

Profile normally used for book printing, etc. in
Japan, suitable for simulation of magazine
advertising standard color printing.

Profile normally used for book printing in
North America, suitable for simulation of
North American standard printing.

JapanColor2001 type3 : Profile becoming a standard in the Japanese

printing industry, suitable for simulation of
JapanColor standard printing.

Rendering intent

Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below.

Perceptual :

Relative Colorimetric :

Before and after conversion, all colors are
converted to maintain the relationship between
colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However,
depending on the image, the saturation may
change overall.

There will not be much conversion to colors
which are similar before and after conversion,
but colors which are not similar are converted
appropriately. Because there are little changes
to similar colors which comprise most of an
image, you can print a natural-looking image in
which the saturation has not changed greatly.
However, depending on the image, there are
cases where the overall tone of an image
changes somewhat as colors which are not
similar and highlights change.
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Index

A
Adjust Face Lighting ... 59
AdJUuSt JPEG IMaAgES....cciiiiiiiiiiiiiiiee et 45
AdjuSt TIFF IMages.......uuiiiiiiiiiiiiiiiiiiiiiiiiiieii e e 45
Adjusting
Adjustment Contents (ReCipe) ......c..uueeevieeiiiiiiiiiieeee e 100
Apply AdJustments. ... 99
Automatic Adjustment (Gradation, Luminance)............cccccccvvvnnnns 57
BrightneSsS ..o 48, 62
Brightness of Highlights..........ooooovi, 54
Brightness of Shadows...........ci 54
Click White BalanCe ..........coooeuiiiiiiie e 52, 63
Color Saturation .............cccccueeiieiiiiiiiieeee e 55
1070 ] (o] gl =10 0] 0 1=T =1 (0] TP 53
1070 ] (o Ul o) o = TS 55
(076] 011 7= 1) SHT TR 54, 62
Copy AdJUSTMENES ....oeiiiiiiiiieeee e 99
Dynamic Range......cocuuveoiiiiiiiiieeece et 56, 66
Filter Effect ... 56
HUB e 67, 68
MONOCKHIOME ..o 55, 68
Personal White Balance ... 137
Picture Style File ... 51
Saturation ........oon i 67, 68
Save AJUSIMENTES .......ooiiiiiii e 99
T =Ty o] [T 59
Tone Curve AdJustment.........ooooiiiiiiiiiie e 64
Toning Effect ... 55, 56
White BalanCe ... 51
Adjusting Brightness ......coooiiieiiii e 48
AJUSTING Clarity ... 61
Adjusting TONE CUIVE ......uuviiiiiiiiiiiiiiiiiiieiiees e e e e e e e e e eeeeeeeees 64
Adjustment Contents (RECIPE) ......coevviiiiiiiiiiiiiiiiiiiiieeeeee e 98, 185
AdODE RGB.....co e 186
AF POINES .ttt e e e e eeeeaes 22
APPIE RGB .....oeiiiiiiiiiiiiiiiiiitiie s e e e e e e e e e e e e e e e e e e e e e aeaeaaaas 186
AITange IMAGES ......eveiiiiee i 36
Auto Lighting Optimizer.........ccevviiiiiiee e 58
Automatic Adjustment (Gradation, Luminance) .........cccccccoevivviveeennnn. 57

Automatic Dust Erasure Processing..........ccccoveeeeiiiiiiiiieeeiiiicicn e, 87
B
Basic Adjustment Tool Palette..........ccccovvvviiiiiiiiiece e, 48
Batch Apply White Balance to Images (Personal White Balance)..... 137
Batch Change the File Name of Images..........ccccccvvvvvviiivveiieieeeeeeeee, 142
Batch Convert/Save Images (Batch Process) ..........ccccvveevviiiiiinnee. 139
Batch Process (Batch Save JPEG and TIFF Images)........cccceevee..... 139
Batch Process of Multiple Images
Change File Name ...........ovvvieiiiiiiiiiiieeeeeeeeeeeeee e, 142
Convert/Save (Batch ProCess).......ccccvvivveeiiiiiiiiiiiiiiiiiiiieieeeeee, 139
Personal White Balance.............ccvvvviiiiii 137
RecCipe Data ........ccooiiiiiiee s 98
TraNS el . 141
Batch Settings WIiNndoOW.........ccoooiiiies 139, 141
Batch Transfer Images ........ccccccoiee e 141
Batch Transfer Images to Image Editing Software...................o........ 141
Before/After Comparison Display ............ccceevvviviiiiiiiiiiieeeieeeeeeeeeeeeeeeeee 24
DIt NUMDET ... 185
BOOKMArK ... 40
BrIgNNESS ... 62
C
Change File Name...........ooiiiiiiiiiiieee e 142
Change the Display ..........ccoeiiiiiiiiiiiie e 14
Changing the File Name of Images in the Order in the Main
WINAOW ..ttt e e e e e e e e e e e e eeeeas 142
CheCK MarK ......cooviieiiiieeeee e 33, 34, 184
Chromatic Aberration Correction...........ccoceeieeiiciicciies 75
Chrominance Noise Reduction...........cccccoeviiiiiiiiiie i, 69
Click White BalanCe..........ooouieeeeeeeeeeeeeeeee e 52,63, 147
CMYK SImMUIAtioN ... 186
Collection WINAOW ........ccoooiiiiiiiii e 104
(070] (o] g =111 ] G @704 = To1 1] o SRR 75
Color Chart ... 186
Color Management (Color Matching) .........cooooieiiiiiiiiiiiiicc, 185
(0701 o] ST o 7= Lo 1P 186
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ICC Profiles ..o 185
Color Management (Preferences)..........cccooiiiiieeiiiiiniiiieieee e 177
(O70] (o] g =7= 1 (1] =1 11 ] o 1S OPRSRR 55
Color Setting of the Monitor (Profiles)...........ccccuviiiiiiiiiiiiiee 177
Color Setting of the Printer (Profiles) ............ooooeii i, 178
COolOr SPACE ..o, 186

AdODE RGB ... 186

APPIE RGB ... 186

Color Space Setting for Each Image .............evvvvevviieiiiieeeiienieennenn. 91

ColorMatch RGB ..........uuuuuiiiiiiiiiiiiiiiiiiiiiieiiiiiaeiiaveeeseeesveeeeeeeeeeeees 186

SRGB ... . a e e e 186

Wide Gamut RGBi.........oouuiiiii e 186
Color Space Setting for Each Image............ccccoo 91
(O70] (o] g =T 0 g o= = | (1] PP RERR 53
10701 (o] gl Ko [T TSP PPN 55
ColorMatch RGB........oooeeeee e 186
Compositing IMages ........uueiiiiiii e 106
[070] 011 7= 11 SUTTT TR 54, 62
Convert ONe IMage.......ccuuiiiiiiiee e 95
Convert to JPEG or TIFF Image and Save................................. 95, 139
Copy Stamp (Image Correction) ...........ceeeviiiiiiiiiiiieeeeeeeeee e 90
Copying and Pasting (Applying) Recipes...........cccccc, 99
Correct Images (Copy Stamp Function) ...........cccceeeeiiiiiiiiiis 90
CrOPPING oo, 71
Customize toolbar............cooiiiiiii 127
D
Default Color Space Setting........cccvveiiieeeiiiiiiee e 177
Delete IMages........oooooiiiiiiii 39
Deleting

Delete IMages .........oooiiiiiiiiiiiiiiiii 39

Delete the Software........ccccccvvveeviiiiiii 183
Deleting DPP (Uninstalling) ..........coooieiiiiiiieeicccies 183
Depth compositing ........ooooeeii i 117
Detailed Setting Printing (Printing with Shooting Information) .......... 133
Digital Lens OptimMizZer........coovie oo 78
Digital Lens Optimizer mark..........ccoooiiiiieiiieiiccces 184

Display
Before/After Comparison Display...........ccccoviiiiiiiieiiiiiiiiiieeeeeenn 24
Enlarged Display (Preview Window)...............cccccco, 18
Enlarged Display (Quick Check Window) ...........ccccceevviiiiiiieeeeenns 31
Multi-FUunction Preview............ccccooiiiii e 25
Single Image DiSplay ............ueuueiiiiiiiiiiiiiiiiieiieeeeeeeeee e 37
Synchronize Preview WiNdOW............coooiiiiiiiiiiiiiiieeeee e 101
Thumbnail Display (Main Window)............ccccuiiiiiiiiiiiiiiieeeeeeee 13
Thumbnail Display and Enlarged Display
(Edit Image WiNdOW)........ooouiiiiiiieeeeeee e 102
Displaying Image Properties............ccciiiiiiiiiieiiiieeeee e 24
Displaying Shooting Information.............ccccevviieiiiiiiiiiiiiiiieieeeeeeeeee 24
[DTE (o) i{e] g T @7 0] 4 {=Tox1T0] o HN 75
Downloading an Image to Your COMPpPULEr ...........cevvvvveiviiieieeieeeeeeeeee, 11
Downloading Images from a Camera ...........ccccuvieeeiiiiiiiiiieeeeee, 11
Downloading Images from a Card Reader.............ccccooiiiiiieenennns 11
Downloading IMages ........coovuuiiiiii et 11
Downloading Images from a Camera...........ccccceeeiiiiiiiiiieec e, 11
Dual Pixel RAW OptimMiIzZer.........ccuvviiiiiieiieiiiieeee e 113
Dust Delete Data .........oooeeiiiiiiieeeee e 86, 87
Dust Delete/Copy Stamp Tool Palette............uvevveeeeiiiiiiiiiiiiiiiiiieeeeee, 86
Dust Erasure Processing
Automatic Dust Erasure ProCcessing ........cccccooeoooaronniiiiiiiiiiiienes 86
Dust Delete/Copy Stamp Tool Palette ...........ccccceeeiiiiiiiiiiiiiii 86
Image Correction (Copy Stamp Function) ...........ccccvvvvvvviveeeennnnee. 90
Manual Dust Erasure (Repair Function) ...........ccccoeiiiiiiiiniennnn. 88
DynamiC RANGe .........cuuiiiiiiiiiii e 56, 66
E
Edit Image WINOW.............uuuiiiiiiiiiiiiiiiiiiiiiiiiiieie e 102
Editing..ccooee Adjusting
Enlarged Display (Preview WIiNndOw) ..........ccuveviiiiiiiiiiiiiieeeeeeeee 18
EOS ULIlIEY .eeeeeieeee e 11
EXItING DPP ..ot 29
F
Filter Effect ... 56
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G
General Settings (Preferences) .........cccooiiiiiiiiiiiie e 174
GPS MAFK .t e e e e e 184
Grid LINES....ciiiieeieeieee e, 22
H
HDR (High Dynamic Range) Images.........cccccccvveeiiiiiiiiieee e 110
HDR PQ MOGE ......ccooeeeeeee ettt 165
Highlight Area Warning Indicator ..........ccoooioiiiie 23
Histogram Palette ... 17
[ 10 = SRR 46, 67, 68
|
[CC ProfileS...coee e 185
Image INformation ... 38
Image Marks (Image Frame Information) ...........ccccccvvvivviiiieeieeeeineee. 184
Image processing (Preferences)........ccoccuvveeeeiiiiiiiiiiiieeeeee 175
Image Quality
NOiISE REAUCHION ..o, 69
J
JPEG IMAQE..coiiiiiiiiieeeeeeeeeeeeeee ettt 45,185
L
Lens Aberration Correction ............ooooeiieii i 74
Lens aberration correction mark ...........ccccoooiiiiiiiiiiiis 184
LiNMBar e 57
Loading and Pasting (Applying) RECIPES..........cccvvvvvvvviviiiiierieeireeeee. 100
Luminance Noise Reduction.............ooooiiiiiiiiiiiieeccceee 69
M
Main WINAOW ......oooiiii e 13
Main Window (Multi-layout)..............ueeeiiiiiii e 20
Main Window (Thumbnail Layout) ...........cccccuiiiiiiiiniiiiiiiee e 13
Manual Dust Erasure (Repair FUNCtion) ..........ccccceeviiiiiiieine e 88
MONOCNIOME .. .. 55
Filter EffeCt ..o, 56
Toning effeCt.. ..o 56
Move or CopY FOIErS........oouiiiiiiiieiiee e 40

Move or Copy Images

Play Back
Save Still Photos
Split movie mark
Multi-Function Preview

Multi-layout
Multiple image display mark

Navigator Palette
Noise Reduction

Organize Images
Organizing Images
Delete Images
Move or Copy Folders
Move or Copy Images
Register Folders as Bookmarks

Display Method of Palettes
Rearranging Palettes
Perceptual

Peripheral lllumination Correction
Personal White Balance
Picture Style
Picture Style File

Pinned image setting mark
Preferences
Color Management
General Settings
Image processing
Properties Display Settings

View Settings
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Preview Control Panel ..o 21
Preview Display Area..........ooooiiiiiiioii e 20
Preview WINAOW ........ooooiiiiii e 18
Printing
Printing a Thumbnail List (Contact Sheet Printing) .................... 134
Printing One Sheet of Paper ..............coccooiiiii, 132
Printing with Shooting Information (Detailed Setting Printing).... 133
Printing One Sheet of Paper.............ooovoiiiiii e 132
Printing with Shooting Information (Detailed Setting Printing) .......... 133
Properties Display Settings (Preferences)........ccccccoviiiiiiieiinnnnee. 179
Q
QUICK CheCK WINAOW.......cociiiiiiie it e e 31
R
RaAtNG. ..o - 33, 34
RAtING MACK.......oiiiiiii e 184
RAW Burst Image ToOl ..........coiiiiiiieecee e 122
RAW IMAQE.....ccc o 44, 185
RAW MOVIES ...ttt 153
Changing the Image Displayed for a RAW Movie....................... 154
Editing @ RAW MOVI€ ... 162
Grabbing and Saving a Displayed RAW Movie Image............... 155
Grabbing and Saving any Range from a RAW Movie................. 162
Playing Back RAW MOViI€sS..........ccccoviiiiiiiiiii, 160
Saving any Range of a RAW Movie as Still Photos ................... 161
Saving Several Still Photos from a RAW Movie...........ccoeveeeeeee. 156
Starting Up the RAW Movie TOO! ..........evvveviiviiiiiieeiiieiieeeeeeeeeee, 157
Supported Cameras ...........ooeuuiiiiieiieeeeeere e 154
Re-Adjusting an Image ........coooiiiiiiiie e 97
RECIPE ..o 98, 185
RECIPE FilE ... 98
Re-Editing an Image ... 97
Registering Folders as Bookmarks...........ccooooiiiiiiiiiiiiie 40
Remote Shooting ........cuuiiiiiie e 144
Rename WiNdOW. ... ..o 142
Rendering Intent (Matching Method) ... 186
Repair (Manual Dust Erasure) .........ccooooooooiiiiieeeee 88

RO e 122
Rotate IMages ... 13
S
SaAtUrAtioN ... 46, 67, 68
Save

Batch Convert/Save Images (Batch Process)........ccccccovvvviieeeen. 139

ST 1Y 95

SAVE At r it e e aaaa et a et aaaaaaaas 95
SaAVE AS i —————— 95
SaViNg RECIPES....co e 99
SeCONd WINAOWS ...t 26
SeleCt IMAGES....ceiiieiiiicie e 13, 31, 102
Shadow Area Warning Indicator............cccoviiiiiiiiiiiiie e 23
SharPNESS ..o, 59, 81
Shooting Information Display.............cceeieiiiiiiiiiiiii e 24, 38
Single Image Display .........cceueeiiiiiiiiiiiee e 37
Single Image Display of RAW and JPEG Image...........cccccceeeviiiinnnnn. 37
Soft-Proof Colors FUNCLON .........cuvviiiiiie e 92
Sorting Images

CheCK MarKS ..o 33, 34

RatiNgS ...coeiiieiieee e 33, 34
SRGB ... e 186
Starting UP DPP ., 10
Supported IMagesS ....coooeeeeee e 4
Survey (PreferenCes).......ovvvviiiiiiiiii 180
Synchronization (Preview WIindow) ...........cccuviieiiiiiiiiiiiieeecceee 101
Synchronize IMages ... 101
Synchronize Preview WIiNAOW ... 101
System Requirements ... 3
T
Thumbnail Display (Filter/Sort Function) ............ccceeeviiiiiiiiiiiieee 16
Thumbnail Display (Main WiNdOW) .........cccueeeiiiiiiiiiiiee e 13

Change the DiSplay.........coouiiiiiiiiiieeieee e 14
Thumbnail Display (Multi-layout) .............cooeiiiiii e 20
Thumbnail Display and Enlarged Display (Edit Image Window) ....... 102
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Thumbnail Display Ar€a.......cccoovviiiiiiiiiii e, 20
Thumbnail Layout ... 13
Thumbnails Control Panel............coooiiiiiiiiieeee e 15
TIFF IMAQE .. 45,185
TONE CUIVE ...ttt e e e e e e e eeaaeeeas 185
TonNING €ffECt ... 56
TOOI Palette......eeeeeieeeeeeeee 46
Basic Adjustment Tool Palette ............ccccc 48
Color Adjustment Tool Palette..............uvveeeeeiieviiieiieeeeeeeeeeeeeeeeee, 67
Detailed Adjustment Tool Palette ..., 69
Dust Delete/Copy Stamp Tool Palette..............................l. 86
Lens Correction Tool Palette.............ooccieeiiieiiiiiie e 74
Partial Adjustment tool palette..........cccoeeviiii 82
Settings Tool Palette ............uueiiiiiiiiiiiiiieeeeeeeee e 91
Tone Adjustment Tool Palette ... 62
Trimming/Angle Adjustment Tool Palette ............cccooiiiiieiinis 71
1o T o = PRSI 13
Transfer
Batch Transfer Images to Image Editing Software...................... 141
Transfer an Image to Photoshop...........ccccviieiiiiiiiiiiiie 126
Transfer an Image to Photoshop ..., 126
Trimming (Cropping) FANGE......eueeeeiiieiiieiieeeieeeeeeeeeeeee e 184
Trimming/Angle Adjustment Tool Palette............ccccoeeiiiiis 71
Trimming/Angle Adjustment Window ..o 71
U
Unsaved editing content mark ............coceeiiiiiiiieccicc e, 184
Unsharp Mask.......coooooiiiii e 60
Using Cloud ProCesSing.........ccccccuuuuuuuuiuuniiniiiirisisssssreesrsesssereeeeeeeeee. 128
v
View Settings (Preferences) ... 178
Viewing Images in the Main Window (Thumbnail Layout) .................. 13
W
White BalanCe........couuueiiiiii e e 51
Click White BalanCe .......coouoeeeeeeeee e 52, 63
1070 ] (o]l =10 0] 0 1=T = (0] TP 53
Personal White Balance ... 137

Wide GamuUt RGB........coooiiiiiiiiic e 186
WOTK COlOr SPACE ...ceeeiiiiiiiiiiieiee et 91
Color Management .........coooiuiiiiiiiie e 177

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademarks

Microsoft and Windows are trademarks or registered trademarks of
Microsoft Corporation in the United States and/or other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

All other trademarks are the property of their respective owners.
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